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Avvertenze importanti per la manipolazione e l’uso

• Questa macchina è un dispositivo di precisione.

• Installare la macchina in un luogo con la temperatura e l’umidità relativa specificate. Per ulteriori in-
formazioni, fare riferimento a Specifiche(P. 347).

• Collegare saldamente l’adattatore AC, i cavi USB ed Ethernet.

• Quando si sposta la macchina, sostenere sempre la base con le mani. Se la macchina viene sostenuta in
modi diversi, potrebbe danneggiarsi quando viene spostata.

Luogo di utilizzo/Spazio di utilizzo

Installare la macchina in una posizione piana e stabile.

Non installare mai la macchina in uno dei seguenti luoghi. In caso contrario, si potrebbe verificare una ri-
duzione della qualità o un malfunzionamento.

• Luoghi soggetti a forti oscillazioni di temperatura o umidità

• Luoghi soggetti a scosse o vibrazioni

• Luoghi in cui il pavimento è inclinato, non in piano o instabile

• Luoghi polverosi

• Luoghi esposti alla luce diretta del sole

• Luoghi entro 1 m da una forte illuminazione interna

• Luoghi in prossimità di impianti di aria condizionata o di riscaldamento

• Luoghi esposti ad acqua o aria in movimento

• Luoghi esposti a notevoli disturbi elettrici o magnetici o altre forme di energia elettromagnetica

Importante

DGSHAPE Corporation non si assume alcuna responsabilità per eventuali perdite o danni ai dati derivanti da
malfunzionamenti o danni al computer. (Eseguire sempre il backup dei dati importanti)

Supporto

Le informazioni di supporto rese disponibili attraverso il sito web di DGSHAPE Corporation vengono aggior-
nate regolarmente per fornire un utile riferimento in caso di problemi. Prima di contattarci, si prega di
consultare le informazioni presenti sul sito web insieme a "Metodi di risoluzione dei problemi".

Si noti che gli URL contenuti in questo manuale sono soggetti a modifiche senza preavviso.

IMPORTANTE

 COLLEGAMENTI CORRELATI 

・ https://www.rolanddg.co.jp/
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Unità principale della macchina da taglio

Anteriore

No. Nome Panoramica delle funzioni

Leva di caricamento Utilizzarla quando si carica il materiale.

Rullo di trazione sinistro Sollevare la leva di caricamento e usarla per agganciare il materiale.
Posizionarla sul bordo sinistro del materiale.

Carrello di taglio Installare il porta lama. Questo elemento si sposta a sinistra e a destra
per tagliare il materiale.

Rullo di trazione destro Sollevare la leva di caricamento e usarla per agganciare il materiale.
Posizionarla sul bordo destro del materiale.

Rullo di trasferimento Questo rullo alimenta il materiale verso la parte anteriore o posterio-
re.

Granatura Indicano la posizione dei rulli di trasferimento. Quando si carica il ma-
teriale, assicurarsi di posizionare i rulli di schiacciamento entro l’area
indicata da ciascun modello.

Protezione lama Protegge la punta della lama durante il taglio.

Linea guida È una guida per allineare il materiale durante il caricamento.

Nomi e funzioni dei componenti
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No. Nome Panoramica delle funzioni

Guida del coltello Inserendo una lama, ecc. e spostandola lungo la guida, il materiale può
essere tagliato senza essere scaricato.

Pannello comandi Utilizzato per eseguire varie operazioni.

Nomi e funzioni dei componenti
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Indietro

No. Nome Panoramica delle funzioni

Connettore USB Serve per collegare un cavo USB.

Connettore del cavo di alimenta-
zione

Serve per alimentare la macchina.

Connettore Ethernet Serve per collegare un cavo Ethernet.

Linea guida È una guida per allineare il materiale durante il caricamento.

Nomi e funzioni dei componenti

Informazioni di base 11



Pannello comandi

▲
▲ ▲▲

Componente Nome Dettagli Notazione utilizzata
in questo documento

W:261mm
L:----  [0mm]  

Display Visualizza vari menu di impostazione e altre
informazioni.

—

TEST Tasto TEST Tenendo premuto questo tasto per almeno 1
secondo, si taglia un modello di prova pre-sal-
vato.

[TEST]

ORIGIN Tasto ORIGIN Tenere premuto per almeno 1 secondo per im-
postare la posizione attuale della lama come
origine.

[ORIGIN]

PAUSE Tasto PAUSE Questo interrompe il funzionamento. Premere
nuovamente per riavviare il funzionamento.

[PAUSE]

▲
▲ ▲▲

Tasti cursore Utilizzare questi tasti per spostare il carrello
di taglio o il materiale, oppure per selezionare
o impostare le voci del menu.

[▲] [▼] [◀] [▶]

MENU

Tasto MENU Il messaggio sul display cambia ogni volta che
si preme questo tasto.

• Condizione di taglio attualmente impostata
• Modalità menu
• Visualizzazione della larghezza o del tipo di

materiale

[MENU]

Nomi e funzioni dei componenti
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Componente Nome Dettagli Notazione utilizzata
in questo documento

FORCE Tasto FORCE Mostra il menu di regolazione della forza della
lama.

[FORCE]

ENTER Tasto ENTER Serve a selezionare una voce di menu e a fina-
lizzare un’impostazione.

[ENTER]

PEN FORCE

Cursore PEN FORCE La forza della lama può essere microregolata.
È possibile eseguire questa regolazione anche
durante il taglio.

[PEN FORCE]

Pulsante di accensione Premendo questo tasto si accende l’alimenta-
zione. È illuminata in blu. Tenerlo premuto per
almeno 1 secondo per spegnere la macchina.

—

 COLLEGAMENTI CORRELATI 

・  P. 22 "CONDIZIONI"

Nomi e funzioni dei componenti

Informazioni di base 13



Lampada LED del carrello

Gli stati della macchina sono indicati dai colori delle lampade LED e dai loro schemi di illuminazione.

Stato della macchina Stato del LED

Spegnimento

Off

Accensione

Illuminato in blu

Durante la disattivazione
(quando la leva di caricamento è abbassata)

Ripete l’illuminazione in azzurro e poi in blu attenuato

Durante la configurazione
(quando la leva di caricamento è sollevata)

Illuminato in blu attenuato

Durante il taglio

Illuminato in blu

In pausa

Lampeggiante in blu

Quando si verifica un’anomalia nella macchina

Lampeggiante in rosso

 COLLEGAMENTI CORRELATI 

・  P. 335 Messaggi di errore
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Tipi di materiali

Di seguito sono indicati i due principali tipi di materiali utilizzati con questa macchina.

• Materiale bobinato

Materiale avvolto su un tubolare di carta

• Materiale piatto

Supporti non avvolti su un tubolare di carta, ad esempio in formati standard

È possibile scegliere tra diversi materiali in base alle proprie esigenze. Per informazioni dettagliate su cia-
scun materiale, contattare il fornitore del materiale.

In questo manuale, i materiali bobinati e i materiali piatti potrebbero essere indicati collettivamente come "supporti" o
"materiali".

MEMO

Condizioni per i materiali utilizzabili

Di seguito sono riportate le condizioni dei materiali che possono essere caricati nella macchina.

Dimensioni

Larghezza Da 50 a 700 mm

Lunghezza*1 100 mm o più (materiale piatto)

Spessore del materiale tagliabile*2 0,3 mm o meno (per il carico, fino a 1,0 mm)

Peso Peso massimo del materiale bobinato 5 kg

 

*1 Non c’è limite per il materiale bobinato

*2 Include lo spessore della carta di supporto
 

Materiali non utilizzabili

Su questa macchina non possono essere utilizzati materiali con una delle seguenti caratteristiche. Svolgere
e raddrizzare la forma del materiale prima di caricarlo.

• Fortemente deformati o piegati

• I bordi non sono paralleli

Per la stampa e taglio, non è possibile utilizzare i seguenti materiali oltre a quelli sopra citati.

• Materiale trasparente

• Materiale colorato

Per la stampa e il taglio, utilizzare materiale bianco con carta di supporto che possa essere stampata con una stampan-
te laser o a getto d’inchiostro. Il rilevamento automatico dei crocini di registro potrebbe non essere possibile per alcuni
materiali, come quelli laminati o lucidi.

• Tipi di materiali che possono essere stampati con le stampanti laser
Carta fine
Carta patinata
Carta da disegno

MEMO

Materiale utilizzato
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PET
• Tipi di materiali che possono essere stampati con le stampanti a getto d’inchiostro

Carta fine
Carta patinata

Materiale utilizzato
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Crocini di registro

I crocini di registro vengono utilizzati per l’allineamento durante il taglio del materiale stampato dalla
stampante su questa macchina. Il fatto che la macchina ricordi le posizioni dei crocini di registro, che ven-
gono stampati insieme all’immagine, consente di correggere le posizioni di taglio.

Crocini di registro leggibili

Il sensore della macchina è in grado di leggere solo crocini di registro come il cerchio mostrato di seguito.

• Diametro: 10 mm

• Colore: Nero

A seconda dell’inchiostro utilizzato, la macchina potrebbe non essere in grado di leggere correttamente i crocini di re-
gistro stampati.

MEMO

Quando utilizzare i crocini di registro [3] vs[4]

Normalmente, utilizzare [4]. Dal momento che [3] presenta un numero inferiore di crocini di registro da
leggere rispetto a [4], si risparmia tempo per il taglio. Tuttavia, la modalità Strumento non è disponibile
con [3].

 COLLEGAMENTI CORRELATI 

・  P. 343 Margini e distanza tra i crocini di registro

Crocini di registro/segni degli strumenti
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Segni degli strumenti

I segni degli strumenti vengono utilizzati per l’allineamento manuale quando non è possibile eseguire l’alli-
neamento automatico con i crocini di registro.

Questi ultimi possono essere stampati intorno ai crocini di registro utilizzando CutStudio o i plug-in.

 COLLEGAMENTI CORRELATI 

・  P. 179 Stampa e taglio in modalità Strumento

Crocini di registro/segni degli strumenti
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Accensione

Procedura

1. Premere il pulsante di accensione.

L’alimentazione della macchina è attivata e la spia di alimentazione è accesa.

Spegnimento

Procedura

1. Tenere premuto il pulsante di accensione per almeno un secondo.

L’alimentazione è spenta.

2. Abbassare la leva di caricamento e rimuovere il materiale.

Quando non si utilizza la macchina, tenere la leva di caricamento abbassata anche se la macchina
è accesa.

 COLLEGAMENTI CORRELATI 

・  P. 303 Non è possibile spegnere l’alimentazione

Operazioni con l’alimentazione elettrica
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Procedura

1. Premere più volte [MENU] per visualizzare la seguente schermata.

CONDITION

Quando il materiale è stato caricato, seguire la seguente procedura per visualizzare la schermata.
1. Premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

2. Premere [▼].

MEMO

2. Premere più volte [▲][▼] per visualizzare il menu che si desidera controllare.

Di seguito vengono illustrati i menu che possono essere visualizzati.

Fare clic su [▶] in ciascun menu per controllare le informazioni dettagliate o per modificare le im-
postazioni.

UNSETUP
"RIMUOVI MEDIA"
Viene visualizzato quando il materiale viene caricato. Premendo [ENTER] si di-
sattiva il materiale.

CONDITION
"CONDIZIONI"
Impostare le condizioni di taglio, compresa la forza della lama e la velocità di
taglio. Le impostazioni influiscono sulla qualità del taglio. Modificare le condi-
zioni di taglio in base al materiale utilizzato.

P. 22"CONDIZIONI"

SYSTEM INFO.
"INFO SISTEMA"
Controllare le informazioni sul sistema, tra cui la versione del firmware, l’indi-
rizzo IP e la maschera di sottorete.

P. 24"INFO SISTEMA"

CROPMARK
<SENSOR MODE>

"CROCINO"
Impostare il metodo di allineamento quando si taglia il materiale su cui sono
stampati i crocini di registro o i segni degli strumenti. Normalmente, utilizzare
"SENSOR MODE".

OTHERS
"ALTRO"
È possibile impostare il display o attivare e disattivare altre impostazioni.

P. 25"ALTRO"

REPLOT
<DATA EXISTS>

"RISTAMPA"
I dati ricevuti dal computer possono essere salvati nella memoria della macchina
e possono essere utilizzati ripetutamente per tagliare (recut).

P. 230Tagliare ripetutamente gli stessi dati

MEMORY
<USER1>

"MEMORIA"
Per risparmiare il tempo necessario a impostare le condizioni di taglio per ogni
cambio di materiale, è possibile salvare nella memoria della macchina le condi-
zioni di taglio dei materiali utilizzati più di frequente.

P. 233Salvataggio delle condizioni di taglio utilizzate di
frequente

Controllo del menu del display
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 COLLEGAMENTI CORRELATI 

・  P. 179 Stampa e taglio in modalità Strumento

・  P. 183 Stampa e taglio in modalità manuale

・  P. 199 Ottimizzazione della qualità e dell'efficienza

"CONDIZIONI"

Qui vengono impostate e confermate le condizioni di taglio, tra cui la forza della lama e la velocità di ta-
glio. Le impostazioni influiscono sulla qualità del taglio. Modificare le condizioni di taglio in base al mate-
riale utilizzato.

• "FORZA"

FORCE 50gf

È possibile impostare la forza della lama. Se il disegno si stacca o se anche la carta di supporto
viene tagliata insieme al materiale, modificare l’impostazione di "FORZA". 

P. 204Impostazione della forza della lama

• "VEL."

SPEED 40cm/s

È possibile impostare la velocità di taglio. Se la linea di taglio è distorta o se rimangono aree par-
zialmente non tagliate, modificare l’impostazione di "VEL.". 

P. 206Regolazione della velocità di taglio

• "OFFSET"

OFFSET 0.250mm

È possibile impostare l’offset della punta della lama. Se l’inizio di un taglio si discosta dalla posi-
zione prevista o se gli angoli di una forma non sono puliti, modificare l’impostazione di "OFFSET". 

P. 207Impostazione dell’offset della punta della lama

• "MOV."

UPSPEED 40cm/

È possibile impostare la velocità in modo da sollevare la lama dal materiale e spostarla nella posi-
zione di taglio successiva durante l’operazione di taglio. Quando si taglia un materiale più sottile o
più spesso di quello standard, modificare l’impostazione di "MOV." per evitare problemi quali il sol-
levamento del materiale.

P. 213Impostazione della velocità della lama durante il taglio

• "ROT."

ROTATE 0deg A

Le coordinate di taglio possono essere ruotate e la direzione di taglio del materiale può essere im-
postata.

P. 209Impostare l’orientamento delle coordinate di taglio

• "QUALITA"

Controllo del menu del display
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QUALITY NORMAL

È possibile impostare la qualità del taglio. In casi come l’utilizzo di materiale spesso, modificare
l’impostazione di "QUALITA".

• "ESTENSIONE"

EXTEND 0.0mm

È possibile impostare se estendere o meno l’area di taglio rispetto all’impostazione normale. Per
massimizzare l’uso del materiale, modificare l’impostazione di "ESTENSIONE".

P. 211Estensione dell’area di taglio

• "AREA"

AREA 1.0m

Quando si utilizza materiale bobinato, è possibile impostare la lunghezza del materiale richiesto.
Quando si imposta il materiale bobinato, modificare l’impostazione di "AREA".

P. 403.  Controllare l’alimentazione del materiale

Controllo del menu del display
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"INFO SISTEMA"

Controllare le informazioni sul sistema, tra cui la versione del firmware, l’indirizzo IP e la maschera di sot-
torete.

• "MODELLO"

SYSTEM INFO.
MODEL

È possibile controllare il nome del modello.

• "SERIAL NO."

SYSTEM INFO.
SERIAL No.

È possibile controllare il numero di serie.

• "FIRMWARE"

SYSTEM INFO.
FIRMWARE

È possibile verificare la versione del firmware.

• "INTERFACCIA"

SYSTEM INFO.
INTERFACE

È possibile verificare l’impostazione della connessione con il computer.

Per controllare impostazioni di rete, come l’indirizzo IP, premere due volte [▶], utilizzare [▼] per
selezionare le informazioni da visualizzare, quindi premere [▶].

Controllo del menu del display
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"ALTRO"

È possibile impostare il display o attivare e disattivare altre impostazioni.

• "SMOOTHING"

SMOOTHING ON

È possibile impostare le curve dei dati di taglio inviati alla macchina in modo che siano lisce.

P. 214Taglio liscio di archi e altre curve (lisciatura)

• "UNITA"

UNIT mm

È possibile impostare l’unità di misura del display.

P. 277Modifica dell’unità di misura della lunghezza da visualizzare

• "RESET IMP."

FACTORYDEFAULT

Questa procedura riporta tutte le impostazioni ai relativi valori di fabbrica. Qualsiasi impostazione
effettuata fino a questo punto verrà cancellata. Annotare tutte le informazioni necessarie, come
ad esempio le condizioni di taglio.

P. 280Ripristino delle impostazioni predefinite

• "CONTRASTO"

CONTRAST 5

È possibile regolare la luminosità del display. Modificare l’impostazione per facilitare la visione del
display in base all’ambiente in cui ci si trova.

P. 279Regolazione della luminosità del display

• "ASPIRAZ."

VACUUMFAN AUTO

Attivare la ventola di aspirazione per mantenere il materiale in posizione durante il taglio, in modo
da evitare che il materiale si sollevi o si sposti. Quando si utilizzano materiali sottili e/o non solidi,
si consiglia di ridurre il volume d’aria della ventola di aspirazione.

P. 219Utilizzo di materiale più sottile o più duro del normale

• "PRE-FEED"

PRE-FEED OFF

Il materiale viene alimentato automaticamente prima e durante il taglio per evitare il disallinea-
mento delle posizioni di taglio. Questa impostazione è utile soprattutto quando si tagliano dati di
dimensioni pari o superiori a 1 m.

P. 221Prevenzione del disallineamento del taglio

• "OVER CUT"

Controllo del menu del display
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OVER CUT OFF

Questa funzione taglia gli extra all’inizio e alla fine di una linea di taglio. È efficace quando si desi-
dera produrre angoli particolarmente netti, ad esempio quando si tagliano materiali più spessi.

P. 217Taglio netto degli angoli (Over Cut)

• "SOVRAPPOSIZ."

OVERLAP OFF

Il taglio viene ripetuto più volte nella stessa posizione con gli stessi dati di taglio. Utilizzare questa
impostazione per i materiali che non possono essere tagliati in un solo passaggio, come ad esempio
i materiali spessi.

P. 215Taglio ripetuto nella stessa posizione (sovrapposizione)

• "PERFORA"

PERFORATE OFF

Il taglio perforato può essere utilizzato per tagliare materiale senza carta di supporto o per creare
pieghe sui dati di taglio. L’area di taglio viene separata dopo il taglio per evitare che il materiale si
inceppi.

P. 236Separare l’area di taglio in un secondo momento

• "CROP ADJ."

CROP ADJ.

Se le posizioni di stampa e di taglio non sono allineate, è possibile correggere il problema regolan-
dole.

P. 223Regolazione della posizione di taglio

P. 225Regolazione della posizione di stampa

Controllo del menu del display
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Posizione di carico del materiale

Caricare il materiale in modo che i margini destro e sinistro dai bordi del materiale ai rulli di trazione sia-
no uniformi. Caricare il materiale in modo tale che il rullo di trazione (W) si trovi all’interno dell’intervallo
(Y) della granatura (X).

A seconda della larghezza del materiale da caricare, i margini sinistro e destro potrebbero non essere uniformi, e il
margine sul bordo destro del materiale potrebbe essere più grande di quello sul bordo sinistro.

MEMO

Z Posizione di lavoro del rullo di trazione sinistro

Campo di utilizzo del rullo di trazione sinistro
Quando si carica materiale di larghezza diversa da A a D, spostare il rullo di trazione sinistro.

Campo di lavoro del rullo di trazione destro con il materiale A caricato

Campo di lavoro del rullo di trazione destro con il materiale B caricato

Campo di lavoro del rullo di trazione destro con il materiale C caricato

Campo di lavoro del rullo di trazione destro con il materiale D caricato

A Materiale con una larghezza di circa 150 mm

B Materiale con una larghezza di circa 306 mm

C Materiale con una larghezza di circa 457 mm

D Materiale con una larghezza di circa 610 mm

Quando si caricano materiali diversi da quelli descritti sopra, cambiare la posizione del rullo di trazione
sinistro in modo da adattarlo alla larghezza del materiale.

Impostazione del materiale
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 COLLEGAMENTI CORRELATI 

・  P. 9 Anteriore

Impostazione del materiale
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Configurazione del materiale piatto

Se si utilizza materiale piatto, deve essere più lungo di almeno 70 mm rispetto alla dimensione verticale
dei dati di taglio. È la lunghezza necessaria al rullo di trasferimento per far fuoriuscire il materiale verso
la parte anteriore o posteriore.

Fare riferimento alla figura seguente e assicurarsi che vi siano margini sufficienti nella parte anteriore e
posteriore, a destra e a sinistra del materiale.

50 mm o più

15 mm o più

25 mm o più

Non possono essere utilizzati materiali con una delle seguenti caratteristiche: Svolgere e raddrizzare la forma del mate-
riale prima di caricarlo.

• Il materiale è arricciato verso l’alto.
• Il bordo anteriore del materiale è piegato o sgualcito.

IMPORTANTE

1. Caricamento di materiale piatto

Queste istruzioni descrivono come impostare il materiale A4.

Procedura

1. Abbassare la leva di caricamento.

Non esercitare forza eccessiva per spostare la leva di caricamento.
Questo potrebbe danneggiarla.

IMPORTANTE

Impostazione del materiale
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2. Inserire il materiale dalla parte anteriore della macchina.

3. Impostare il materiale nella posizione mostrata nella figura qui sotto.

La posizione di impostazione è diversa a seconda delle dimensioni del materiale da caricare.

4. Spostare i rulli di trazione verso i bordi del materiale in modo che ognuno sia all’interno della granatura.

Impostare il materiale in modo che i margini destro e sinistro ( ) dai bordi del materiale ai rulli di
trazione siano uniformi.

Quando si utilizza materiale con un grande volume di avanzamento (materiale lungo), impostare i margini sini-
stro e destro a circa 25 mm.

MEMO

Impostazione del materiale
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Il materiale perforato alimentato da pignoni presenta perforazioni lungo ciascun bordo per consentire l’avan-
zamento del materiale. Se i rulli di trazione vengono posizionati sopra le perforazioni, il materiale non può
essere alimentato correttamente. Quando si utilizza questo materiale con la macchina, posizionare i rulli di
trazione lontano dalle perforazioni.

MEMO

5. Allineare il bordo sinistro del materiale in modo che sia approssimativamente parallelo alle linee guida
( ).

Vista da sopra la macchina

6. Alzare la leva di caricamento.

Il materiale è fissato in posizione.

Impostazione del materiale
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Utilizzare il seguente link per visualizzare un video di riferimento per questa procedura.
Caricamento del materiale in piano

MEMO

 COLLEGAMENTI CORRELATI 

・  P. 15 Condizioni per i materiali utilizzabili

・  P. 27 Posizione di carico del materiale

・  P. 342 Area di taglio

Impostazione del materiale
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2. Controllare il materiale caricato

Procedura

1. Accendere la macchina.

2. Premere più volte [▼] per selezionare "FOGLIO".

SELECT SHEET
*PIECE

3. Premere [ENTER].

Il carrello di taglio si sposta nella posizione del rullo di trazione sinistro e il materiale si sposta in
avanti e indietro.

Al termine dell’inizializzazione, sul display vengono visualizzate la larghezza e la lunghezza di ta-
glio.

W:***mm
L:***mm

4. Dopo l’arresto del funzionamento, controllare i seguenti elementi.

• Il bordo sinistro del materiale non è inclinato verso la linea guida

• I rulli di trazione non si trovano fuori dal materiale

Vista da sopra la macchina

Impostazione del materiale
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MEMO
Quando il materiale è inclinato o quando i rulli di trazione sono fuori dal materiale, non è possibile
impostare correttamente il materiale. Eseguire la procedura seguente e riavviare l’impostazione
del materiale dall’inizio.

a. Togliere il materiale e riportare il carrello di taglio in posizione di attesa.

P. 174Rimozione del materiale

b. Tenere premuto il pulsante di accensione per almeno 1 secondo per spegnere la macchina.

5. Premere [MENU].

Assicurarsi che i valori delle voci vengano visualizzati.

Il valore della figura seguente è un esempio di riferimento.

20cm/s
250gf 0.250mm ∠A
20cm/s
250gf 0.250mm ∠A

Velocità del taglio

Forza della lama

Offset della punta della lama

Orientamento delle coordinate di taglio

Se viene caricato del materiale piatto di lunghezza superiore a 1,6 m, la macchina lo riconosce come rotolo.
In questo caso, far avanzare il materiale e verificare che possa essere alimentato normalmente.
Se si avvia il taglio senza aver confermato l’alimentazione del materiale, quest’ultimo potrebbe scivolare du-
rante il taglio o la qualità del taglio potrebbe essere compromessa da un’alimentazione non corretta.

P. 403.  Controllare l’alimentazione del materiale

IMPORTANTE

 COLLEGAMENTI CORRELATI 

・  P. 204 Impostazione della forza della lama

・  P. 207 Impostazione dell’offset della punta della lama

・  P. 209 Impostare l’orientamento delle coordinate di taglio

・  P. 206 Regolazione della velocità di taglio

Impostazione del materiale
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Configurazione del materiale bobinato

Se non si utilizza la base a rulli, tagliare dal rotolo la quantità necessaria per il taglio e caricarla come materiale piat-
to.

P. 29Configurazione del materiale piatto

MEMO

1. Caricamento di materiale bobinato

Caricare il materiale bobinato sulla macchina utilizzando la base a rulli.

Articolo necessario

Base a rulli

Caricare correttamente le bobine.
Diversamente il materiale potrebbe cadere e causare lesioni.

ATTENZIONE

La bobina pesa circa 5 kg.
Per evitare lesioni, maneggiare le bobine con cura.

ATTENZIONE

Non caricare mai materiali che pesino più di 5 kg.
La macchina potrebbe non resistere al peso e ribaltarsi o causare la caduta del materiale.

ATTENZIONE

Procedura

1. Controllare che la leva di caricamento sia abbassata.

Impostazione del materiale
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2. Fissare la base del rullo sulla macchina.

Durante il sollevamento, sostenere l’estremità della macchina.

3. Posizionare il materiale bobinato sulla base a rulli.

Caricare il materiale bobinato ( ) in modo che le porzioni (A) che si estendono oltre i bordi destro
e sinistro della base del rullo ( ) siano uniformi.

Caricare correttamente le bobine.
Diversamente il materiale potrebbe cadere e causare lesioni.

ATTENZIONE

4. Dalla bobina, estrarre un po’ più di materiale rispetto alla quantità da utilizzare e inserirlo dalla parte
posteriore a quella anteriore della macchina.

Impostazione del materiale
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Lasciare un po’ di margine nel materiale estratto. Se si carica il materiale senza creare un po’ di allentamen-
to, il materiale non viene alimentato correttamente.

IMPORTANTE

5. Spostare i rulli di trazione verso i bordi del materiale e all’interno delle granature.

Posizionare i rulli di trazione in modo che ciascuno di essi si trovi a 25 mm o più ( ) dal rispettivo
bordo sinistro o destro del materiale.

Il materiale perforato alimentato da pignoni presenta perforazioni lungo ciascun bordo per consentire l’avan-
zamento del materiale. Se i rulli di trazione vengono posizionati sopra le perforazioni, il materiale non può
essere alimentato correttamente. Quando si utilizza questo materiale con la macchina, posizionare i rulli di
trazione lontano dalle perforazioni.

MEMO

Impostazione del materiale
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6. Allineare il bordo sinistro del materiale in modo che sia approssimativamente parallelo alle linee guida
( ).

Vista da sopra la macchina

7. Alzare la leva di caricamento.

Il materiale è fissato in posizione.

Utilizzare il seguente link per visualizzare un video di riferimento per questa procedura.
Caricamento del materiale in piano

MEMO

 COLLEGAMENTI CORRELATI 

・  P. 15 Condizioni per i materiali utilizzabili

・  P. 27 Posizione di carico del materiale

Impostazione del materiale

38  Funzionamento di base

https://youtu.be/9KlWGLwfuzc


2. Selezionare il tipo di materiale

Selezionare il tipo di materiale da caricare sulla macchina.

Procedura

1. Accendere la macchina.

Viene visualizzata la schermata mostrata nella figura seguente.

SELECT SHEET
ROLL

2. Premere [▲] o [▼] per selezionare "ROTOLO" o "BORDO".

Se si seleziona e si imposta "BORDO", circa 15 mm ( ) dal bordo superiore del materiale sono ri-
servati al margine. Se si seleziona e si imposta
"ROTOLO", non viene riservato alcun margine.

3. Premere [ENTER].

Il carrello di taglio si sposta sul bordo sinistro. Sul display viene visualizzata la larghezza di taglio.

W:261mm
L:----  [0mm]

 COLLEGAMENTI CORRELATI 

・  P. 35 Caricamento di materiale bobinato

Impostazione del materiale
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3. Controllare l’alimentazione del materiale

Prima di tagliare, far avanzare il materiale e verificare che possa essere alimentato normalmente.

Se si avvia il taglio senza aver confermato l’alimentazione del materiale, quest’ultimo potrebbe scivolare
durante il taglio o la qualità del taglio potrebbe essere compromessa da un’alimentazione non corretta.

Procedura

1. Premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

2. Premere [▼] per visualizzare la seguente schermata.

CONDITION

3. Premere [▶], quindi [▲] per visualizzare la schermata mostrata di seguito.

Viene visualizzata la schermata mostrata nella figura seguente.

AREA 1.0m

4. Premere [▶].

5. Premere [▲][▼] per impostare la lunghezza del materiale richiesta per i dati di taglio.

Affinché il rullo di trasferimento possa far avanzare il materiale, è necessario lasciare dei margini
all’inizio e alla fine dell’area di taglio. È buona norma impostare un valore superiore di circa 0,2 m
rispetto alla lunghezza del materiale richiesto.

AREA 1.0m
*-24.9m

6. Premere [ENTER].

La lunghezza impostata del materiale si sposta in avanti, poi viene immediatamente ritirata e ri-
presa.

Se il materiale scivola via dai rulli di trazione, premere [PAUSE] per interrompere il funzionamen-
to.
Abbassare la leva di caricamento, estrarre il materiale ed eseguire nuovamente la configurazione
dall’inizio.

7. Premere [MENU] per tornare alla schermata originale.

 COLLEGAMENTI CORRELATI 

・  P. 15 Materiale utilizzato

・  P. 29 Caricamento di materiale piatto

・  P. 35 Caricamento di materiale bobinato
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Passo 1: Preparare la lama

Non toccare mai la punta della lama.
La mancata osservanza di questa precauzione può provocare lesioni. Anche le prestazioni di taglio della lama verranno
compromesse.

ATTENZIONE

Articoli necessari (inclusi)

Porta lama Lama Perno *1

 

*1 Il perno è inserito nel porta lama.
 

Procedura

1. Se il perno è stato rimosso dal porta lama, inserire il perno nel porta lama.

2. Girare il cappuccio del porta lama in senso orario e stringerlo fino a quando non smette di ruotare.

3. Inserire la lama.

Preparativi per il taglio
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Le condizioni di taglio, come il volume di taglio, la velocità di taglio, la forza della lama, ecc. devono essere
regolate in base al tipo di materiale.
Eseguire prove di taglio con il materiale da utilizzare e regolare le condizioni di taglio.

IMPORTANTE

 COLLEGAMENTI CORRELATI 

・  P. 201 Guida generale alle condizioni di taglio

・  P. 202 Regolazione dell’impostazione del taglio
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Passo 2: Installare il porta lama

Non toccare mai la punta della lama.
La mancata osservanza di questa precauzione può provocare lesioni. Anche le prestazioni di taglio della lama verranno
compromesse.

ATTENZIONE

Procedura

1. Allentare la vite del carrello di taglio.

2. Inserire il porta lama.

Verificare che il porta lama e il carrello di taglio siano innestati.

3. Stringere completamente la vite del carrello di taglio.

Preparativi per il taglio
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Utilizzare il seguente link per visualizzare un video di riferimento per questa procedura.
Preparazione della lama

MEMO
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Passo 3: Eseguire un taglio di prova

Regolare le condizioni di taglio in base al tipo di materiale e alla pulizia del taglio. Per ottenere tagli di
alta qualità, eseguire una prova per verificare la qualità del taglio del materiale prima di eseguire il taglio
vero e proprio.

Procedura

1. Verificare che il cursore PEN FORCE sia in posizione centrale (a "0" sulla scala).

▲
▲ ▲▲

-2 -1 0 +1 +2

2. Premere [▲][▼][◀][▶] per spostare il carrello di taglio.

Spostare il carrello di taglio in modo che la punta della lama sia rivolta verso la posizione iniziale
di taglio.

Per spostare rapidamente il materiale o il carrello di taglio, premere [ENTER] insieme a uno dei tasti [▲][▼]
[◀][▶] mentre viene visualizzata una delle seguenti schermate.

20cm/s
250gf 0.250mm ∠A

W:***mm
L:***mm

MEMO

3. Tenere premuto [TEST] per almeno un secondo.

Il taglio del modello di prova inizierà nella posizione della lama in cui viene premuto [TEST].

4. Una volta completato il taglio, premere [▼] per far avanzare il materiale.
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▲
▲ ▲▲

5. Staccare la forma tagliata con delle pinzette, ecc. per verificare la qualità del taglio.

Le seguenti condizioni sono indice di buona qualità.

• Quando si stacca la parte circolare, si stacca solo la parte circolare

• Quando la parte quadrata viene staccata, sulla carta di supporto rimane una leggera traccia
della lama

Se è presente una delle seguenti condizioni, regolare la forza della lama o la velocità di taglio. Do-
po l’impostazione, eseguire nuovamente la prova di taglio. Ripetere questo processo fino a ottene-
re una buona qualità.

Controllare l’articolo Risultato Impostare l’arti-
colo

Regolazione

Controllare la forma. La forma del taglio è distorta. Velocità del taglio Ridurre

Distaccare il cerchio. Altre forme si staccano insieme Forza della lama Aumentare

Viene tagliata anche la carta di suppor-
to

Ridurre

Rimangono alcune aree non tagliate. Velocità del taglio Ridurre

Distaccare il quadrato. La traccia della lama non è visibile Forza della lama Aumentare

La traccia della lama è troppo profonda Ridurre

Quando si utilizza materiale duro o carta di supporto sottile, la modifica della forza della lama potrebbe non
garantire una buona qualità. Regolare l’estensione della punta della lama e regolare con precisione la quantità
di taglio.

IMPORTANTE

Utilizzare il seguente link per visualizzare un video di riferimento per questa procedura.
Prova di taglio

MEMO
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 COLLEGAMENTI CORRELATI 

・  P. 201 Guida generale alle condizioni di taglio

・  P. 204 Impostazione della forza della lama

・  P. 206 Regolazione della velocità di taglio

・  P. 202 Regolazione del volume di taglio
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Passo 4: Regolazione del punto di inizio dell’esportazione

Prima del taglio, impostare la posizione di avvio dell’esportazione in un punto in cui sia possibile garantire
un’area di taglio adeguata.

Inviare il taglio effettivo in un’area che non si sovrapponga a quella utilizzata per i test di taglio.

Procedura

1. Premere [◀][▲] per spostare il carrello di taglio nella posizione che si desidera impostare come origine.

Spostare il carrello di taglio fino a quando la punta della lama mira alla posizione che si desidera
impostare come origine.

2. Premere [▲] per spostare il materiale all’indietro e assicurarsi che le tracce di taglio si trovino davanti
alla protezione della lama.

La lama si sposta sulla protezione della lama. Quando si imposta l’origine, l’area dietro la prote-
zione della lama viene impostata come area di taglio.

3. Tenere premuto [ORIGIN] per almeno un secondo.

Il display lampeggia e la posizione della punta della lama viene impostata come origine.

Preparativi per il taglio
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Passo 1: Creazione dei dati di taglio

Inserire testo e forme e creare i dati di taglio. Questa sezione spiega come creare dati di taglio contenenti
"SALE" e come aggiungere una "weed line", che faciliti la successiva spellatura.

Procedura

1. Avviare CutStudio.

• Windows 11

a. Fare clic su [Start].

b. Fare clic su [Tutte le app]>[Roland CutStudio]>[CutStudio].

• Windows 10

a. Fare clic su [Start].

b. Fare clic su [Roland CutStudio]>[CutStudio].

• Windows 8.1

a. Fare clic su  in basso a sinistra della finestra [Start] per visualizzare la finestra [Apps].

b. Fare clic su .

CutStudio si avvia.

2. Fare clic su .

3. Fare clic su un punto qualsiasi e digitare "SALE".

Metodo di taglio
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4. Fare clic su  e modificare le dimensioni dei caratteri.

 e  appaiono intorno al testo. Trascinare  o  per modificare le dimensioni del testo.

Per specificare la dimensione del testo in valori, selezionare l’oggetto di destinazione e fare clic su .

MEMO

5. Fare clic su [Object]>[Weed].

Viene visualizzata la finestra [Weed].
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6. Selezionare la casella di controllo [Weed Border] e fare clic su [OK].

Intorno ai caratteri viene aggiunta una linea di rimozione dei rifiuti.

Metodo di taglio
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L’oggetto inserito viene raggruppato con la relativa weed line. Per maggiori dettagli sulle weed li-
ne, vedere la Guida di CutStudio.

Metodo di taglio
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7. Fare clic su un oggetto, quindi su .

L’oggetto si sposta verso l’origine.

L’origine visualizzata su CutStudio indica la posizione iniziale di uscita del materiale caricato.
Posizionando l’oggetto sull’origine, è possibile evitare un’alimentazione eccessiva del materiale.

MEMO

8. Fare clic su .

9. Selezionare la cartella in cui salvare i dati, inserire il nome del file e fare clic su [Save].
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I dati creati vengono salvati.
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Passo 2: Impostazione delle condizioni di taglio

Procedura

1. Verificare che il materiale sia stato caricato e impostato correttamente.

P. 27Impostazione del materiale

2. Fare clic su [File]>[Cutting Setup].

Viene visualizzata la finestra [Cutting Setup].

3. All’indirizzo [Name], in [Printer], selezionare [Roland DG GS2-24].

Il nome del modello è impostato.

4. Fare clic su [Change] sotto [Media Size].
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5. Fare clic su [Get from Machine].

Acquisire l’intervallo di taglio dalla macchina collegata e [Width] e [Length] in [Cutting Area] ver-
ranno aggiornati.

Se viene visualizzato [The machine is not responding.], controllare le impostazioni della macchina e del com-
puter.

P. 302La macchina non funziona

MEMO

6. Fare clic su [OK].
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L’impostazione viene salvata e viene visualizzata la finestra [Cutting Setup].

7. Impostare le condizioni di taglio.

Normalmente, la casella di controllo [Use cutting conditions of machine] è selezionata.

Per modificare la condizione di taglio, deselezionare la casella di controllo [Use cutting conditions
of machine] e inserire i valori.

8. Fare clic su [OK].

L’intervallo e le condizioni di taglio vengono salvati.

L’area visualizzata in bianco in CutStudio è l’intervallo di taglio. I caratteri e le forme al di fuori di quest’area
non verranno tagliati.

MEMO
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Passo 3: Taglio

Inviare i dati di taglio alla macchina e tagliare il materiale.

Se il materiale si stacca o la macchina funziona in modo anomalo, premere [PAUSE] per annullare l’output.
Abbassare la leva di caricamento, estrarre il materiale ed eseguire nuovamente la configurazione dall’inizio.

IMPORTANTE

Non toccare mai il carrello di taglio mentre l’output è in corso.
Il carrello di taglio si muove ad alta velocità. Il contatto con il carrello in movimento può causare lesioni.

AVVERTENZA

Procedura

1. Fare clic su .

Viene visualizzata la finestra [Cut].

2. Fare clic su [OK].

Il taglio inizia.

 COLLEGAMENTI CORRELATI 

・  P. 177 Messa in pausa e annullamento dell'output

・  P. 27 Impostazione del materiale
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Passo 1: Creare i dati stampa e taglia

1. Inserire i dati di stampa

CutStudio può leggere solo i seguenti tipi di file.

• Formato JPEG (i file JPEG salvati in formato CMYK non possono essere letti.)
• Formato PNG
• Formato BMP
• Formati AI ed EPS (solo versione Illustrator 8.0. Se si utilizza una versione superiore, abbassare la versione al mo-

mento del salvataggio.)

MEMO

Procedura

1. Avviare CutStudio.

• Windows 11

a. Fare clic su [Start].

b. Fare clic su [Tutte le app]>[Roland CutStudio]>[CutStudio].

• Windows 10

a. Fare clic su [Start].

b. Fare clic su [Roland CutStudio]>[CutStudio].

• Windows 8.1

a. Fare clic su  in basso a sinistra della finestra [Start] per visualizzare la finestra [Apps].

b. Fare clic su .

CutStudio si avvia.

2. Selezionare [File]>[Print&Cut] su CutStudio.

Sullo schermo vengono visualizzati l’area di stampa e i crocini di registro. L’area di stampa viene
visualizzata con linee tratteggiate. I crocini di registro vengono visualizzati nell’area in cui i margi-
ni specificati in [Printing Setup] sono esclusi dalle dimensioni del materiale specificate in [Set up
the printer].

Metodo di stampa e taglio
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3. Fare clic su  per importare i dati di stampa.

In questo caso, il file Sample.bmp presente nella cartella in cui è installato CutStudio (normalmen-
te si trova nella cartella [Program Files (x86)]>[CutStudio] sull’unità C) viene aperto come dati di
stampa.

4. Selezionare i dati di stampa e fare clic su [Open].

Metodo di stampa e taglio
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5. Posizionare i dati di stampa nell’area all’interno dei crocini di registro.

È possibile modificare la densità dell’immagine importata.

 COLLEGAMENTI CORRELATI 

・  P. 83 Modifica dell’oscurità dell’immagine posizionata

・  P. 332 Impossibile importare i dati di Illustrator

・  P. 333 Impossibile trovare i dati di esempio
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2. Aggiungere linee di taglio ai dati di stampa

Aggiungere linee di taglio ai dati di stampa, che vengono letti da CutStudio, e creare i dati di stampa e
taglio.

Procedura

1. Selezionare , e tracciare le linee di taglio.

In questo caso, viene tracciata una linea di taglio attorno ai dati di stampa, come mostrato di se-
guito ( ).

2. Fare clic su .

3. Selezionare la cartella in cui salvare i dati, inserire il nome del file e fare clic su [Save].

I dati di stampa e taglio creati vengono salvati.
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Passo 2: Impostare le condizioni di stampa

Impostare l’intervallo di stampa per la stampa e taglio e i crocini di registro.

Procedura

1. Fare clic su [File]>[Printing Setup].

2. Fare clic su [Set up the printer].

Metodo di stampa e taglio
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3. Impostare il formato del documento, quindi fare clic su [OK].

4. Selezionare il numero di crocini.

Selezionare [4] o [3] da [Layout Points].

Metodo di stampa e taglio
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[4] Crocini di registro: 4 punti

[3] Crocini di registro: 3 punti

Normalmente, utilizzare [4].
Dal momento che [3] presenta un numero inferiore di crocini di registro da leggere rispetto a [4], si risparmia
tempo per il taglio, ma questo non è disponibile nella modalità Strumento.

MEMO

5. Fare clic su [Fit into shared area for cutting and printing].

La posizione del crocino di registro viene impostata automaticamente.
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Quando si impostano manualmente le posizioni dei crocini, fare riferimento alla tabella seguente e specificare
i margini e la distanza tra i crocini. Quando si utilizza materiale con un grande volume di avanzamento (mate-
riale lungo), si consiglia di impostare i margini sinistro e destro a circa 25 mm.

Margini e distanze tra i crocini di registro su materiali di diverse dimensioni con 4 crocini di regi-
stro (unità: mm)

Impostare l’articolo A4 A3 B4

Y X Y X Y X

[Margins] [Top] 56 59 59 61 58 56

[Bottom] 20 20 20 20 20 20

[Left] 10 30 30 15 15 14

[Right] 10 16 16 14 16 14

[Crop
marks]

[W] 170 230 230 370 205 315

[L] 200 110 320 195 265 160

Margini e distanze tra i crocini di registro su materiali di diverse dimensioni con 3 crocini di regi-
stro (unità: mm)

Impostare l’articolo A4 A3 B4

Y X Y X Y X

[Margins] [Top] 56 60 60 62 59 57

[Bottom] 20 20 20 20 20 20

[Left] 15 30 30 15 15 15

[Right] 15 17 17 15 17 14

[Crop
marks]

[W] 170 240 240 380 215 325

[L] 210 120 330 205 275 170

MEMO

6. Fare clic su [OK].

Dopo aver impostato i valori, verificare che i crocini di registro si trovino all’interno dell’area di
stampa.

Se si utilizza un materiale più grande delle dimensioni elencate nella tabella, impostare i valori facendo riferi-
mento a Margini e distanza tra i crocini di registro(P. 343).

MEMO
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Passo 3: Output dei dati di stampa e taglio

1. Stampare i dati stampa e taglia

Inviare i dati di stampa da CutStudio alla stampante e stampare i dati stampa e taglia.

Procedura

1. Caricare il materiale nella stampante.

Per sapere come caricare il materiale nella stampante, consultare la documentazione della stam-
pante.

Se la stampa espansa/ridotta è abilitata, disabilitarla. Assicurarsi di stampare al 100% della scala.

IMPORTANTE

2. Fare clic su .

Viene visualizzata la finestra [Print].

3. Selezionare la stampante che si desidera utilizzare, quindi fare clic su [OK].

Verranno stampati solo i dati di stampa.
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2. Caricare il materiale stampato

Caricare il materiale stampato da una stampante alla macchina.

Non è possibile utilizzare materiale arricciato: i crocini di registro potrebbero non essere leggibili. Se il materiale si
arriccia durante la stampa, raddrizzarlo prima di caricarlo sulla macchina.

IMPORTANTE

Procedura

1. Controllare l’origine del taglio ( ) sul materiale.

2. Impostare il materiale posizionando l’origine del taglio in basso a sinistra della macchina.

Se il materiale viene caricato in una direzione errata, la macchina non sarà in grado di leggere i crocini di
registro.

IMPORTANTE

3. Posizionare i rulli di trazione.

Osservare i seguenti punti quando si posizionano i rulli di trazione.

• Posizionare i rulli di trazione ( ) all’esterno dei segni degli strumenti ( )

• Assicurarsi che i rulli di trazione ( ) siano regolati all’interno entro i limiti delle granature
( )
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Impostare manualmente le posizioni dei crocini di registro. Tenere presenti i seguenti punti quando si utilizza
materiale in formati diversi da A3, A4 o B4.

• Quando si utilizza un rullo di trazione all’interno della granatura più a sinistra, assicurarsi di lasciare alme-
no 30 mm (W) dall’estremità sinistra della granatura al crocino di registro. Se la distanza libera è inferiore
a 30 mm, non è possibile leggere il crocino di registro.

MEMO

4. Allineare il bordo sinistro del materiale in modo che sia approssimativamente parallelo alle linee guida
( ).

Vista da sopra la macchina

5. Alzare la leva di caricamento.
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Il materiale è fissato in posizione.

6. Accendere la macchina.

7. Selezionare [FOGLIO] come tipo di materiale.

8. Premere [ENTER].

Vengono visualizzate la larghezza e la lunghezza del taglio.

W:***mm
L:***mm

9. Premere [▲][▼] per spostare il materiale e posizionare il crocino di registro ( ) sopra la protezione del-
la lama ( ).

I crocini di registro non possono essere letti nelle situazioni indicate di seguito. Rimuovere il materiale una
volta e poi ricaricarlo.

• I crocini di registro sono separati dalla protezione della lama ( ) da una distanza di 15 mm o più ( )
• I crocini di registro destro e sinistro sono inclinati di 5 gradi o più ( ) rispetto alla direzione di movimento

del carrello di taglio
• I crocini di registro destro e sinistro si discostano di 20 mm o più ( ) nella direzione di alimentazione del

materiale

IMPORTANTE
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10. Premere [◀][▶] per spostare il carrello di taglio in modo che la punta della lama arrivi al centro del cro-
cino di registro in basso a sinistra.
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Passo 4: Configurare l’impostazione per eseguire l’allineamento automatico

Posizionare automaticamente i crocini di registro utilizzando il sensore integrato nella macchina.

Procedura

1. Premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

2. Premere più volte [▼] per visualizzare la seguente schermata.

CROPMARK
<TOOL MODE>

3. Premere [▶].

4. Premere [▲] o [▼] per selezionare "SENSOR MODE".

CROPMARK
 SENSOR MODE

5. Premere [ENTER] per selezionare l’impostazione.

6. Premere [MENU] per tornare alla schermata originale.
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Passo 5: Impostazione delle condizioni di taglio

Procedura

1. Verificare che il materiale sia stato caricato e impostato correttamente.

P. 27Impostazione del materiale

2. Fare clic su [File]>[Cutting Setup].

Viene visualizzata la finestra [Cutting Setup].

3. All’indirizzo [Name], in [Printer], selezionare [Roland DG GS2-24].

Il nome del modello è impostato.

4. Fare clic su [Change] sotto [Media Size].
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5. Fare clic su [Get from Machine].

Acquisire l’intervallo di taglio dalla macchina collegata e [Width] e [Length] in [Cutting Area] ver-
ranno aggiornati.

Se viene visualizzato [The machine is not responding.], controllare le impostazioni della macchina e del com-
puter.

P. 302La macchina non funziona

MEMO

6. Fare clic su [OK].
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L’impostazione viene salvata e viene visualizzata la finestra [Cutting Setup].

7. Impostare le condizioni di taglio.

Normalmente, la casella di controllo [Use cutting conditions of machine] è selezionata.

Per modificare la condizione di taglio, deselezionare la casella di controllo [Use cutting conditions
of machine] e inserire i valori.

8. Fare clic su [OK].

L’intervallo e le condizioni di taglio vengono salvati.

L’area visualizzata in bianco in CutStudio è l’intervallo di taglio. I caratteri e le forme al di fuori di quest’area
non verranno tagliati.

MEMO
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Passo 6: Taglio

Inviare i dati stampa e taglia alla macchina e avviare il taglio.

Non toccare mai il carrello di taglio mentre l’output è in corso.
Il carrello di taglio si muove ad alta velocità. Il contatto con il carrello in movimento può causare lesioni.

AVVERTENZA

Procedura

1. Fare clic su .

Viene visualizzata la finestra [Cut].

2. Fare clic su [OK].

I dati stampa e taglia vengono inviati alla macchina. Quando la macchina riceve i dati stampa e
taglia, legge automaticamente i crocini di registro tramite un sensore e inizia a tagliare.

Se il sensore non riesce a leggere i crocini di registro, viene visualizzata la schermata mostrata di seguito.

Se viene visualizzata la seguente schermata, consultare Non vengono rilevati i crocini di registro(P.
297) per risolvere l’errore.

SET TO
<TOOL MODE>

Se il problema non si risolve, passare alla modalità Strumento, quindi eseguire l’allineamento 

MEMO
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P. 179Stampa e taglio in modalità Strumento

3. Rimuovere il materiale tagliato.

 COLLEGAMENTI CORRELATI 

・  P. 174 Rimozione del materiale
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Questa sezione fornisce utili metodi di utilizzo per la creazione di dati con CutStudio.

Modifica dell’oscurità dell’immagine posizionata

È possibile modificare l’oscurità di un’immagine importata in CutStudio.

Procedura

1. Fare clic su [File]>[Preference].

2. Impostare [General]>[Image Darkness].

• Campo di impostazione: Da 1 a 100%
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3. Fare clic su [OK].

Metodi avanzati di creazione dei dati
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Passaggio ai caratteri verticali

Questa procedura non supporta i font alfabetici.

IMPORTANTE

Procedura

1. Utilizzare  per selezionare i caratteri che si desidera trasformare in testo verticale.

2. Fare clic su .

Il pannello di ancoraggio si apre.

3. Dopo aver selezionato il pannello [Format], selezionare la casella di controllo [Vertical writing font].

Il testo passa dalla scrittura orizzontale a quella verticale.
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Se si desidera modificare l’orientamento dei caratteri, utilizzare [Angle of Rotation] sul pannello [Size and
shape].

MEMO

4. Selezione dei caratteri

Vengono visualizzati i font giapponesi che supportano la scrittura verticale.
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Spostamento di un simbolo salvato su un nuovo computer

Per istruzioni su come salvare i simboli, consultare la Guida di CutStudio.

MEMO

Procedura

1. Copiare la cartella [Symbol] dal percorso sottostante.

• C:\ProgramData\Roland DG Corporation\CutStudio\Symbol

Se la cartella non viene visualizzata, controllare l’impostazione di visualizzazione dei file nascosti.

P. 333Impossibile trovare i dati di esempio

MEMO

2. Copiare la cartella [Symbol] sul nuovo computer.

Copiare la cartella nella stessa posizione sul nuovo computer.
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Questa sezione descrive come creare dati di taglio con Adobe Illustrator e come eseguire il taglio.

Per l’invio dei dati di taglio creati con Adobe Illustrator a CutStudio, è necessario installare il plug-in Cut-
Studio per Adobe Illustrator.

Per informazioni sulle ultime versioni supportate, visitare il sito Web di DGSHAPE Corporation (https://
www.rolanddg.co.jp/).

 COLLEGAMENTI CORRELATI 

・ GS2-24 Installation and Initial Settings Windows Version

Passo 1: Creazione dei dati di taglio

Inserire testo e forme e creare i dati di taglio. Questa sezione spiega come creare dati di taglio con Adobe
Illustrator 2020. La procedura operativa è la stessa per le altre versioni.

Procedura

1. Avviare Adobe Illustrator.

2. Fare clic su [Window]>[Extensions]>[Roland CutStudio].

Viene visualizzata la tavolozza [Roland CutStudio].
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3. Creare un nuovo documento.

Impostare il formato del documento su uno dei formati tagliabili, visualizzati sullo schermo della
macchina dopo l’impostazione del materiale.

4. Inserire testo e forme.

In questo esempio, inseriamo "SALE" e tracciamo una linea che circonda la parola.Questa linea è
chiamata "weed line" e viene utilizzata per rimuovere facilmente i dati di taglio.

Contornando il testo e facendo clic su  nella tavolozza [Roland CutStudio], il testo diventa contornato.

MEMO
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Passo 2: Esportare i dati di taglio a CutStudio

È possibile inviare a CutStudio i dati delle linee di taglio realizzati con Adobe Illustrator.

Procedura

1. Selezionare [Output All Lines] nella tavolozza [Roland CutStudio].

2. Selezionare la casella di controllo [Auto Update] sulla tavolozza.

Viene visualizzata un’anteprima dell’oggetto da produrre.

3. Fare clic su .

CutStudio si avvia e i dati della linea di taglio vengono inviati a CutStudio.

I dati di output vengono sempre allineati all’origine di CutStudio, indipendentemente dalla posizione in Adobe
Illustrator. (Questo non vale per i dati con crocini di registro)

MEMO

Metodo di taglio

92  Creazione di dati di taglio con Adobe Illustrator (Windows)



Metodo di taglio

Creazione di dati di taglio con Adobe Illustrator (Windows) 93



Passo 3: Impostazione delle condizioni di taglio

Procedura

1. Verificare che il materiale sia stato caricato e impostato correttamente.

P. 27Impostazione del materiale

2. Fare clic su [File]>[Cutting Setup].

Viene visualizzata la finestra [Cutting Setup].

3. All’indirizzo [Name], in [Printer], selezionare [Roland DG GS2-24].

Il nome del modello è impostato.

4. Fare clic su [Change] sotto [Media Size].
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5. Fare clic su [Get from Machine].

Acquisire l’intervallo di taglio dalla macchina collegata e [Width] e [Length] in [Cutting Area] ver-
ranno aggiornati.

Se viene visualizzato [The machine is not responding.], controllare le impostazioni della macchina e del com-
puter.

P. 302La macchina non funziona

MEMO

6. Fare clic su [OK].
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L’impostazione viene salvata e viene visualizzata la finestra [Cutting Setup].

7. Impostare le condizioni di taglio.

Normalmente, la casella di controllo [Use cutting conditions of machine] è selezionata.

Per modificare la condizione di taglio, deselezionare la casella di controllo [Use cutting conditions
of machine] e inserire i valori.

8. Fare clic su [OK].

L’intervallo e le condizioni di taglio vengono salvati.

L’area visualizzata in bianco in CutStudio è l’intervallo di taglio. I caratteri e le forme al di fuori di quest’area
non verranno tagliati.

MEMO
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Passo 4: Taglio

Inviare i dati di taglio alla macchina e tagliare il materiale.

Se il materiale si stacca o la macchina funziona in modo anomalo, premere [PAUSE] per annullare l’output.
Abbassare la leva di caricamento, estrarre il materiale ed eseguire nuovamente la configurazione dall’inizio.

IMPORTANTE

Non toccare mai il carrello di taglio mentre l’output è in corso.
Il carrello di taglio si muove ad alta velocità. Il contatto con il carrello in movimento può causare lesioni.

AVVERTENZA

Procedura

1. Fare clic su .

Viene visualizzata la finestra [Cut].

2. Fare clic su [OK].

Il taglio inizia.

 COLLEGAMENTI CORRELATI 

・  P. 27 Impostazione del materiale
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Consultare la Guida di Adobe Illustrator

Procedura

1. Fare clic su [Window]>[Extensions]>[Roland CutStudio].

Viene visualizzata la tavolozza [Roland CutStudio].

2. Nella tavolozza, fare clic su .

3. Fare clic su [Help].
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Passo 1: Impostare le condizioni di stampa

Impostare l’intervallo di stampa per la stampa e taglio e i crocini di registro.

Procedura

1. Avviare Adobe Illustrator e aprire un nuovo documento.

Impostare la tavola da disegno.

2. Fare clic su [Window]>[Extensions]>[Roland CutStudio].

Viene visualizzata la tavolozza [Roland CutStudio].
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3. Nella tavolozza, fare clic su .

I crocini di registro vengono inseriti nella tavola da disegno.

4. Fare clic su  sulla tavolozza, quindi su [Crop-marks].

5. Impostare [Type], [Point].

Per [Type], selezionare "GS2-24".

[Point] indica il numero di crocini di registro.

Quando [Point] è "4" Crocini di registro: 4 punti

Quando [Point] è "3" Crocini di registro: 3 punti

Normalmente, selezionare "4" in [Point]. Quando [Point] è "3", la modalità Strumento non è dispo-
nibile.

6. Impostare il margine e la distanza tra i crocini di registro, quindi fare clic su [OK].

Per i dettagli relativi ai margini e alla distanza tra i crocini di registro, vedere la tabella seguente.
Quando si utilizza materiale con un grande volume di avanzamento (materiale lungo), si consiglia
di impostare i margini sinistro e destro a circa 25 mm.
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Margini e distanze tra i crocini di registro su materiali di diverse dimensioni con 4 crocini di registro
(unità: mm)

A4 A3 B4

Y X Y X Y X

[W] 170 230 230 370 205 315

[L] 200 110 320 195 265 160

[X] 10 30 30 15 15 15

[Y] 20 20 20 20 20 20

Margini e distanze tra i crocini di registro su materiali di diverse dimensioni con 3 crocini di registro
(unità: mm)

A4 A3 B4

Y X Y X Y X

[W] 170 240 240 380 215 325

[L] 210 120 330 205 275 170

[X] 15 30 30 15 15 15

[Y] 20 20 20 20 20 20

Se si utilizza un materiale di dimensioni superiori a quelle sopra elencate, impostare i valori facendo riferi-
mento a Margini e distanza tra i crocini di registro(P. 343).

MEMO

I crocini di registro vengono visualizzati sulla tavola da disegno.
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Passo 2: Creare i dati stampa e taglia

1. Inserire i dati di stampa

Procedura

1. Fare clic su [File]>[Placement] per importare i dati di stampa.

In questo caso, il file Sample.bmp presente nella cartella in cui è installato CutStudio (normalmen-
te si trova nella cartella [Program Files (x86)]>[CutStudio] sull’unità C) viene aperto come dati di
stampa.

2. Selezionare i dati di stampa e fare clic su [Layout Points].

3. Posizionare i dati di stampa nell’area all’interno dei crocini di registro.
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2. Aggiungere linee di taglio ai dati di stampa

Aggiungere le linee di taglio ai dati di stampa posizionati e creare i dati di stampa e taglio.

Procedura

1. Creare un nuovo livello per le linee di taglio e disegnarvi le linee di taglio.

In questo caso, viene tracciata una linea di taglio attorno ai dati di stampa, come mostrato di se-
guito ( ).

2. Fare clic su [File]>[Save].

3. Selezionare la cartella in cui salvare i dati, inserire il nome del file e fare clic su [Save].

I dati di stampa e taglio creati vengono salvati.
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Passo 3: Output dei dati di stampa e taglio

1. Stampare i dati stampa e taglia

Inviare i dati alla stampante e stampare i dati di stampa e taglio.

Procedura

1. Caricare il materiale nella stampante.

Per sapere come caricare il materiale nella stampante, consultare la documentazione della stam-
pante.

Se la stampa espansa/ridotta è abilitata, disabilitarla. Assicurarsi di stampare al 100% della scala.

IMPORTANTE

2. Nascondere il livello contenente le linee di taglio.

3. Fare clic su [File]>[Print].

4. Controllare la configurazione della stampa e fare clic su [Print].

Verranno stampati solo i dati di stampa.
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2. Caricare il materiale stampato

Caricare il materiale stampato da una stampante alla macchina.

Non è possibile utilizzare materiale arricciato: i crocini di registro potrebbero non essere leggibili. Se il materiale si
arriccia durante la stampa, raddrizzarlo prima di caricarlo sulla macchina.

IMPORTANTE

Procedura

1. Controllare l’origine del taglio ( ) sul materiale.

2. Impostare il materiale posizionando l’origine del taglio in basso a sinistra della macchina.

Se il materiale viene caricato in una direzione errata, la macchina non sarà in grado di leggere i crocini di
registro.

IMPORTANTE

3. Posizionare i rulli di trazione.

Osservare i seguenti punti quando si posizionano i rulli di trazione.

• Posizionare i rulli di trazione ( ) all’esterno dei segni degli strumenti ( )

• Assicurarsi che i rulli di trazione ( ) siano regolati all’interno entro i limiti delle granature
( )
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Impostare manualmente le posizioni dei crocini di registro. Tenere presenti i seguenti punti quando si utilizza
materiale in formati diversi da A3, A4 o B4.

• Quando si utilizza un rullo di trazione all’interno della granatura più a sinistra, assicurarsi di lasciare alme-
no 30 mm (W) dall’estremità sinistra della granatura al crocino di registro. Se la distanza libera è inferiore
a 30 mm, non è possibile leggere il crocino di registro.

MEMO

4. Allineare il bordo sinistro del materiale in modo che sia approssimativamente parallelo alle linee guida
( ).

Vista da sopra la macchina

5. Alzare la leva di caricamento.
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Il materiale è fissato in posizione.

6. Accendere la macchina.

7. Selezionare [FOGLIO] come tipo di materiale.

8. Premere [ENTER].

Vengono visualizzate la larghezza e la lunghezza del taglio.

W:***mm
L:***mm

9. Premere [▲][▼] per spostare il materiale e posizionare il crocino di registro ( ) sopra la protezione del-
la lama ( ).

I crocini di registro non possono essere letti nelle situazioni indicate di seguito. Rimuovere il materiale una
volta e poi ricaricarlo.

• I crocini di registro sono separati dalla protezione della lama ( ) da una distanza di 15 mm o più ( )
• I crocini di registro destro e sinistro sono inclinati di 5 gradi o più ( ) rispetto alla direzione di movimento

del carrello di taglio
• I crocini di registro destro e sinistro si discostano di 20 mm o più ( ) nella direzione di alimentazione del

materiale

IMPORTANTE
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10. Premere [◀][▶] per spostare il carrello di taglio in modo che la punta della lama arrivi al centro del cro-
cino di registro in basso a sinistra.
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Passo 4: Configurare l’impostazione per eseguire l’allineamento automatico

Posizionare automaticamente i crocini di registro utilizzando il sensore integrato nella macchina.

Procedura

1. Premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

2. Premere più volte [▼] per visualizzare la seguente schermata.

CROPMARK
<TOOL MODE>

3. Premere [▶].

4. Premere [▲] o [▼] per selezionare "SENSOR MODE".

CROPMARK
 SENSOR MODE

5. Premere [ENTER] per selezionare l’impostazione.

6. Premere [MENU] per tornare alla schermata originale.
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Passo 5: Inviare i dati di stampa e taglio a CutStudio

Procedura

1. Mostrare il livello contenente le linee di taglio disegnate da Adobe Illustrator e selezionarlo.

2. Nella tavolozza [Roland CutStudio], selezionare [Output Current Layer], quindi fare clic su [Update].

Confermare che la linea di taglio da produrre è visualizzata sullo schermata di anteprima.

3. Fare clic su .

CutStudio si avvia e i dati della linea di taglio vengono inviati a CutStudio.
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Passo 6: Impostazione delle condizioni di taglio

Procedura

1. Fare clic su [File]>[Cutting Setup].

Viene visualizzata la finestra [Cutting Setup].

2. All’indirizzo [Name], in [Printer], selezionare [Roland DG GS2-24].

Il nome del modello è impostato.

3. Fare clic su [Change] sotto [Media Size].
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4. Fare clic su [Get from Machine].

Acquisire l’intervallo di taglio dalla macchina collegata e [Width] e [Length] in [Cutting Area] ver-
ranno aggiornati.

Se viene visualizzato [The machine is not responding.], controllare le impostazioni della macchina e del com-
puter.

P. 302La macchina non funziona

MEMO

5. Fare clic su [OK].

Metodo di stampa e taglio

114  Creazione di dati di taglio con Adobe Illustrator (Windows)



L’impostazione viene salvata e viene visualizzata la finestra [Cutting Setup].

6. Impostare le condizioni di taglio.

Normalmente, la casella di controllo [Use cutting conditions of machine] è selezionata.

Per modificare la condizione di taglio, deselezionare la casella di controllo [Use cutting conditions
of machine] e inserire i valori.

7. Fare clic su [OK].

L’intervallo e le condizioni di taglio vengono salvati.

L’area visualizzata in bianco in CutStudio è l’intervallo di taglio. I caratteri e le forme al di fuori di quest’area
non verranno tagliati.

MEMO
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Passo 7: Taglio

Inviare i dati stampa e taglia alla macchina e avviare il taglio.

Non toccare mai il carrello di taglio mentre l’output è in corso.
Il carrello di taglio si muove ad alta velocità. Il contatto con il carrello in movimento può causare lesioni.

AVVERTENZA

Procedura

1. Fare clic su .

Viene visualizzata la finestra [Cut].

2. Fare clic su [OK].

I dati stampa e taglia vengono inviati alla macchina. Quando la macchina riceve i dati stampa e
taglia, legge automaticamente i crocini di registro tramite un sensore e inizia a tagliare.

Se il sensore non riesce a leggere i crocini di registro, viene visualizzata la schermata mostrata di seguito.

Se viene visualizzata la seguente schermata, consultare Non vengono rilevati i crocini di registro(P.
297) per risolvere l’errore.

Se il problema non si risolve, passare alla modalità Strumento, quindi eseguire l’allineamento.

P. 179Stampa e taglio in modalità Strumento

MEMO
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SET TO
<TOOL MODE>

3. Rimuovere il materiale tagliato.

 COLLEGAMENTI CORRELATI 

・  P. 174 Rimozione del materiale
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Questa sezione descrive come creare dati di taglio con Adobe Illustrator e come eseguire il taglio.

Per l’output dei dati di taglio creati con Adobe Illustrator, è necessario installare il plug-in CutStudio per
Adobe Illustrator.

Per informazioni sulle ultime versioni supportate, visitare il sito Web di DGSHAPE Corporation (https://
www.rolanddg.co.jp/).

 COLLEGAMENTI CORRELATI 

・ GS2-24 Installation and Initial Settings For Macintosh Computers

Passo 1: Creazione dei dati di taglio

Inserire testo e forme e creare i dati di taglio. Questa sezione spiega come creare dati di taglio con Adobe
Illustrator 2020. La procedura operativa è la stessa per le altre versioni.

Procedura

1. Avviare Adobe Illustrator.

2. Fare clic su [Window]>[Extensions]>[Roland CutStudio].

Viene visualizzata la tavolozza [Roland CutStudio].
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3. Creare un nuovo documento.

Impostare il formato del documento su uno dei formati tagliabili, visualizzati sullo schermo della
macchina dopo l’impostazione del materiale.

4. Inserire testo e forme.

In questo esempio, inseriamo "SALE" e tracciamo una linea che circonda la parola.Questa linea è
chiamata "weed line" e viene utilizzata per rimuovere facilmente i dati di taglio.

Contornando il testo e facendo clic su  nella tavolozza [Roland CutStudio], il testo diventa contornato.

MEMO
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Passo 2: Impostazione delle condizioni di taglio

Procedura

1. Verificare che il materiale sia stato caricato e impostato correttamente.

P. 27Impostazione del materiale

2. Nel pannello [Roland CutStudio], selezionare [GS2-24] in [Model].

3. Nel pannello, fare clic su [Update Information].

L’intervallo di taglio viene acquisito dalla macchina collegata e il display di [Media] viene aggior-
nato.

Se viene visualizzato [The machine is not responding.], controllare le impostazioni della macchina e del com-
puter.

P. 302La macchina non funziona

MEMO

4. Fare clic su  sulla tavolozza, quindi su [Preferences].

5. Selezionare la casella di controllo [Use Cut Setting].
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6. Fare clic su [OK].

7. Fare clic su  sulla tavolozza, quindi su [Cut Setting].

[Cut Setting] viene visualizzato selezionando [Cut Setting].

8. Impostare le condizioni di taglio.

Normalmente, la casella di controllo [Use Machine Setting] è selezionata.

Per modificare la condizione di taglio, deselezionare la casella di controllo [Use Machine Setting]
e inserire i valori.

9. Fare clic su [OK].
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L’intervallo e le condizioni di taglio vengono salvati.
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Passo 3: Taglio

Inviare i dati di taglio alla macchina e tagliare il materiale.

Se il materiale si stacca o la macchina funziona in modo anomalo, premere [PAUSE] per annullare l’output.
Abbassare la leva di caricamento, estrarre il materiale ed eseguire nuovamente la configurazione dall’inizio.

IMPORTANTE

Non toccare mai il carrello di taglio mentre l’output è in corso.
Il carrello di taglio si muove ad alta velocità. Il contatto con il carrello in movimento può causare lesioni.

AVVERTENZA

Procedura

1. Nella tavolozza [Roland CutStudio], selezionare [Output All Lines], quindi fare clic su [Update].

Confermare che la linea di taglio da produrre è visualizzata sullo schermata di anteprima.

2. Nella tavolozza, fare clic su .

3. Selezionare [Roland GS2-24] e fare clic su [Cut].

Il taglio inizia.

Se il nome del modello non appare, consultare il sito La macchina non funziona.

4. Al termine del taglio, fare clic su [Exit] per chiudere la finestra.
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Passo 1: Impostare le condizioni di stampa

Impostare l’intervallo di stampa per la stampa e taglio e i crocini di registro.

Procedura

1. Avviare Adobe Illustrator e aprire un nuovo documento.

Impostare la tavola da disegno.

2. Fare clic su [Window]>[Extensions]>[Roland CutStudio].

Viene visualizzata la tavolozza [Roland CutStudio].

3. Nella tavolozza, fare clic su .

I crocini di registro vengono inseriti nella tavola da disegno.

4. Fare clic su  sulla tavolozza, quindi su [Crop-marks].
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5. Impostare [Type], [Point].

Per [Type], selezionare "GS2-24".

[Point] indica il numero di crocini di registro.

Quando [Point] è "4" Crocini di registro: 4 punti

Quando [Point] è "3" Crocini di registro: 3 punti

Normalmente, selezionare "4" in [Point]. Quando [Point] è "3", la modalità Strumento non è dispo-
nibile.

6. Impostare il margine e la distanza tra i crocini di registro, quindi fare clic su [OK].

Per i dettagli relativi ai margini e alla distanza tra i crocini di registro, vedere la tabella seguente.
Quando si utilizza materiale con un grande volume di avanzamento (materiale lungo), si consiglia
di impostare i margini sinistro e destro a circa 25 mm.

Margini e distanze tra i crocini di registro su materiali di diverse dimensioni con 4 crocini di registro
(unità: mm)

A4 A3 B4

Y X Y X Y X

[W] 170 230 230 370 205 315

[L] 200 110 320 195 265 160

[X] 10 30 30 15 15 15

[Y] 20 20 20 20 20 20
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Margini e distanze tra i crocini di registro su materiali di diverse dimensioni con 3 crocini di registro
(unità: mm)

A4 A3 B4

Y X Y X Y X

[W] 170 240 240 380 215 325

[L] 210 120 330 205 275 170

[X] 15 30 30 15 15 15

[Y] 20 20 20 20 20 20

Se si utilizza un materiale di dimensioni superiori a quelle sopra elencate, impostare i valori facendo riferi-
mento a Margini e distanza tra i crocini di registro(P. 343).

MEMO

I crocini di registro vengono visualizzati sulla tavola da disegno.
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Passo 2: Creare i dati stampa e taglia

1. Inserire i dati di stampa

Procedura

1. Fare clic su [File]>[Placement] per importare i dati di stampa.

2. Posizionare i dati di stampa nell’area all’interno dei crocini di registro.
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2. Aggiungere linee di taglio ai dati di stampa

Aggiungere le linee di taglio ai dati di stampa posizionati e creare i dati di stampa e taglio.

Procedura

1. Creare un nuovo livello per le linee di taglio e disegnarvi le linee di taglio.

In questo caso, viene tracciata una linea di taglio attorno ai dati di stampa, come mostrato di se-
guito ( ).

2. Fare clic su [File]>[Save].

3. Selezionare la cartella in cui salvare i dati, inserire il nome del file e fare clic su [Save].

I dati di stampa e taglio creati vengono salvati.
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Passo 3: Output dei dati di stampa e taglio

1. Stampare i dati stampa e taglia

Inviare i dati alla stampante e stampare i dati di stampa e taglio.

Procedura

1. Caricare il materiale nella stampante.

Per sapere come caricare il materiale nella stampante, consultare la documentazione della stam-
pante.

Se la stampa espansa/ridotta è abilitata, disabilitarla. Assicurarsi di stampare al 100% della scala.

IMPORTANTE

2. Nascondere il livello contenente le linee di taglio.

3. Fare clic su [File]>[Print].

4. Controllare la configurazione della stampa e fare clic su [Print].

Verranno stampati solo i dati di stampa.
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2. Caricare il materiale stampato

Caricare il materiale stampato da una stampante alla macchina.

Non è possibile utilizzare materiale arricciato: i crocini di registro potrebbero non essere leggibili. Se il materiale si
arriccia durante la stampa, raddrizzarlo prima di caricarlo sulla macchina.

IMPORTANTE

Procedura

1. Controllare l’origine del taglio ( ) sul materiale.

2. Impostare il materiale posizionando l’origine del taglio in basso a sinistra della macchina.

Se il materiale viene caricato in una direzione errata, la macchina non sarà in grado di leggere i crocini di
registro.

IMPORTANTE

3. Posizionare i rulli di trazione.

Osservare i seguenti punti quando si posizionano i rulli di trazione.

• Posizionare i rulli di trazione ( ) all’esterno dei segni degli strumenti ( )

• Assicurarsi che i rulli di trazione ( ) siano regolati all’interno entro i limiti delle granature
( )
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Impostare manualmente le posizioni dei crocini di registro. Tenere presenti i seguenti punti quando si utilizza
materiale in formati diversi da A3, A4 o B4.

• Quando si utilizza un rullo di trazione all’interno della granatura più a sinistra, assicurarsi di lasciare alme-
no 30 mm (W) dall’estremità sinistra della granatura al crocino di registro. Se la distanza libera è inferiore
a 30 mm, non è possibile leggere il crocino di registro.

MEMO

4. Allineare il bordo sinistro del materiale in modo che sia approssimativamente parallelo alle linee guida
( ).

Vista da sopra la macchina

5. Alzare la leva di caricamento.
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Il materiale è fissato in posizione.

6. Accendere la macchina.

7. Selezionare [FOGLIO] come tipo di materiale.

8. Premere [ENTER].

Vengono visualizzate la larghezza e la lunghezza del taglio.

W:***mm
L:***mm

9. Premere [▲][▼] per spostare il materiale e posizionare il crocino di registro ( ) sopra la protezione del-
la lama ( ).

I crocini di registro non possono essere letti nelle situazioni indicate di seguito. Rimuovere il materiale una
volta e poi ricaricarlo.

• I crocini di registro sono separati dalla protezione della lama ( ) da una distanza di 15 mm o più ( )
• I crocini di registro destro e sinistro sono inclinati di 5 gradi o più ( ) rispetto alla direzione di movimento

del carrello di taglio
• I crocini di registro destro e sinistro si discostano di 20 mm o più ( ) nella direzione di alimentazione del

materiale

IMPORTANTE
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10. Premere [◀][▶] per spostare il carrello di taglio in modo che la punta della lama arrivi al centro del cro-
cino di registro in basso a sinistra.
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Passo 4: Configurare l’impostazione per eseguire l’allineamento automatico

Posizionare automaticamente i crocini di registro utilizzando il sensore integrato nella macchina.

Procedura

1. Premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

2. Premere più volte [▼] per visualizzare la seguente schermata.

CROPMARK
<TOOL MODE>

3. Premere [▶].

4. Premere [▲] o [▼] per selezionare "SENSOR MODE".

CROPMARK
 SENSOR MODE

5. Premere [ENTER] per selezionare l’impostazione.

6. Premere [MENU] per tornare alla schermata originale.
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Passo 5: Impostazione delle condizioni di taglio

Procedura

1. Verificare che il materiale sia stato caricato e impostato correttamente.

P. 27Impostazione del materiale

2. Nel pannello [Roland CutStudio], selezionare [GS2-24] in [Model].

3. Nel pannello, fare clic su [Update Information].

L’intervallo di taglio viene acquisito dalla macchina collegata e il display di [Media] viene aggior-
nato.

Se viene visualizzato [The machine is not responding.], controllare le impostazioni della macchina e del com-
puter.

P. 302La macchina non funziona

MEMO

4. Fare clic su  sulla tavolozza, quindi su [Preferences].

5. Selezionare la casella di controllo [Use Cut Setting].
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6. Fare clic su [OK].

7. Fare clic su  sulla tavolozza, quindi su [Cut Setting].

[Cut Setting] viene visualizzato selezionando [Cut Setting].

8. Impostare le condizioni di taglio.

Normalmente, la casella di controllo [Use Machine Setting] è selezionata.

Per modificare la condizione di taglio, deselezionare la casella di controllo [Use Machine Setting]
e inserire i valori.

9. Fare clic su [OK].
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L’intervallo e le condizioni di taglio vengono salvati.
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Passo 6: Taglio

Inviare i dati alla macchina e avviare il taglio del materiale.

Non toccare mai il carrello di taglio mentre l’output è in corso.
Il carrello di taglio si muove ad alta velocità. Il contatto con il carrello in movimento può causare lesioni.

AVVERTENZA

Procedura

1. Mostrare il livello contenente le linee di taglio e selezionarlo.

Confermare che la linea di taglio da produrre è visualizzata sullo schermata di anteprima.

2. Selezionare [Output Current Layer].

Confermare che la linea di taglio da produrre è visualizzata sullo schermata di anteprima.

Per modificare o controllare l’impostazione del taglio, fare riferimento a Passo 2: Impostazione
delle condizioni di taglio.

3. Nella tavolozza, fare clic su .

4. Selezionare [Roland GS2-24] e fare clic su [Cut].
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I dati di taglio vengono inviati alla macchina. Quando la macchina riceve i dati, legge automatica-
mente i crocini di registro tramite un sensore e inizia a tagliare.

Se il nome del modello non appare, consultare il sito La macchina non funziona.

MEMO

Se il sensore non riesce a leggere i crocini di registro, viene visualizzata la schermata mostrata di seguito.

Se viene visualizzata la seguente schermata, consultare Non vengono rilevati i crocini di registro per
risolvere l’errore.

SET TO
<TOOL MODE>

Se il problema non si risolve, passare alla modalità Strumento, quindi eseguire l’allineamento 

P. 179Stampa e taglio in modalità Strumento

MEMO

5. Al termine del taglio, fare clic su [Exit] per chiudere la finestra.

6. Rimuovere il materiale tagliato.

 COLLEGAMENTI CORRELATI 

・  P. 174 Rimozione del materiale
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Questa sezione descrive come creare dati di taglio con CorelDRAW e come eseguire il taglio.

Per inviare a CutStudio i dati di taglio creati con CorelDRAW, è necessario installare il plug-in CutStudio per
CorelDRAW.

Per informazioni sulle ultime versioni supportate, visitare il sito Web di DGSHAPE Corporation (https://
www.rolanddg.co.jp/).

 COLLEGAMENTI CORRELATI 

・ GS2-24 Installation and Initial Settings Windows Version

Passo 1: Creazione dei dati di taglio

Inserire testo e forme e creare i dati di taglio. Questa sezione spiega come creare dati di taglio con Corel-
DRAW 2020. La procedura operativa è la stessa per le altre versioni.

Procedura

1. Avviare CorelDRAW.

2. Nella barra degli strumenti, fare clic su .

Viene visualizzata la tavolozza [Roland CutStudio].

3. Creare un nuovo documento.

Impostare il formato del documento su uno dei formati tagliabili, visualizzati sullo schermo della
macchina dopo l’impostazione del materiale.

4. Inserire testo e forme.

In questo esempio, inseriamo "SALE" e tracciamo una linea che circonda la parola.Questa linea è
chiamata "weed line" e viene utilizzata per rimuovere facilmente i dati di taglio.
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Contornando il testo e facendo clic su  nella tavolozza [Roland CutStudio], il testo diventa contornato.

MEMO
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Passo 2: Esportare i dati di taglio a CutStudio

Inviare i dati di taglio creati in CorelDRAW a CutStudio.

Procedura

1. Selezionare [Output All Lines] nella tavolozza [Roland CutStudio].

2. Selezionare la casella di controllo [Auto Update].

Confermare che la linea di taglio da produrre è visualizzata sullo schermata di anteprima.

3. Fare clic su .

CutStudio si avvia e i dati della linea di taglio vengono inviati a CutStudio.

I dati di output vengono sempre allineati all’origine di CutStudio, indipendentemente dalla posizione in Corel-
DRAW.

MEMO
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I dati creati in CorelDRAW vengono inviati a CutStudio nelle seguenti condizioni.

• Tutta la grafica disegnata viene inviata a CutStudio.
• Le stringhe di caratteri non vengono inviate a CutStudio. Delinearle prima dell’esportazione.
• La larghezza della linea, il riempimento e le frecce vengono ignorati.
• Le linee senza larghezza non vengono inviate.
• Le immagini non vengono inviate.

MEMO
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Passo 3: Impostazione delle condizioni di taglio

Procedura

1. Verificare che il materiale sia stato caricato e impostato correttamente.

P. 27Impostazione del materiale

2. Fare clic su [File]>[Cutting Setup].

Viene visualizzata la finestra [Cutting Setup].

3. All’indirizzo [Name], in [Printer], selezionare [Roland DG GS2-24].

Il nome del modello è impostato.

4. Fare clic su [Change] sotto [Media Size].
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5. Fare clic su [Get from Machine].

Acquisire l’intervallo di taglio dalla macchina collegata e [Width] e [Length] in [Cutting Area] ver-
ranno aggiornati.

Se viene visualizzato [The machine is not responding.], controllare le impostazioni della macchina e del com-
puter.

P. 302La macchina non funziona

MEMO

6. Fare clic su [OK].
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L’impostazione viene salvata e viene visualizzata la finestra [Cutting Setup].

7. Impostare le condizioni di taglio.

Normalmente, la casella di controllo [Use cutting conditions of machine] è selezionata.

Per modificare la condizione di taglio, deselezionare la casella di controllo [Use cutting conditions
of machine] e inserire i valori.

8. Fare clic su [OK].

L’intervallo e le condizioni di taglio vengono salvati.

L’area visualizzata in bianco in CutStudio è l’intervallo di taglio. I caratteri e le forme al di fuori di quest’area
non verranno tagliati.

MEMO
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Passo 4: Taglio

Inviare i dati di taglio alla macchina e tagliare il materiale.

Se il materiale si stacca o la macchina funziona in modo anomalo, premere [PAUSE] per annullare l’output.
Abbassare la leva di caricamento, estrarre il materiale ed eseguire nuovamente la configurazione dall’inizio.

IMPORTANTE

Non toccare mai il carrello di taglio mentre l’output è in corso.
Il carrello di taglio si muove ad alta velocità. Il contatto con il carrello in movimento può causare lesioni.

AVVERTENZA

Procedura

1. Fare clic su .

Viene visualizzata la finestra [Cut].

2. Fare clic su [OK].

Il taglio inizia.

 COLLEGAMENTI CORRELATI 

・  P. 27 Impostazione del materiale
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Controllo della Guida di CorelDRAW

Procedura

1. Nella barra degli strumenti, fare clic su .

Viene visualizzata la tavolozza [Roland CutStudio].

2. Nella tavolozza, fare clic su .

3. Fare clic su [Help].
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Passo 1: Impostare le condizioni di stampa

Impostare l’intervallo di stampa per la stampa e taglio e i crocini di registro.

Procedura

1. Avviare CorelDRAW e aprire un nuovo documento.

Impostare il formato del documento.

2. Nella barra degli strumenti, fare clic su .

Viene visualizzata la tavolozza [Roland CutStudio].

3. Nella tavolozza, fare clic su .

I crocini di registro vengono inseriti nel documento.
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4. Fare clic su  sulla tavolozza, quindi su [Crop-marks].

5. Impostare [Type], [Point].

Per [Type], selezionare "GS2-24".

[Point] indica il numero di crocini di registro.

Quando [Point] è "4" Crocini di registro: 4 punti

Quando [Point] è "3" Crocini di registro: 3 punti
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Normalmente, selezionare "4" in [Point]. Quando [Point] è "3", la modalità Strumento non è dispo-
nibile.

6. Impostare il margine e la distanza tra i crocini di registro, quindi fare clic su [OK].

Per i dettagli relativi ai margini e alla distanza tra i crocini di registro, vedere la tabella seguente.
Quando si utilizza materiale con un grande volume di avanzamento (materiale lungo), si consiglia
di impostare i margini sinistro e destro a circa 25 mm.

Margini e distanze tra i crocini di registro su materiali di diverse dimensioni con 4 crocini di registro
(unità: mm)

A4 A3 B4

Y X Y X Y X

[W] 170 230 230 370 205 315

[L] 200 110 320 195 265 160

[X] 10 30 30 15 15 15

[Y] 20 20 20 20 20 20

Margini e distanze tra i crocini di registro su materiali di diverse dimensioni con 3 crocini di registro
(unità: mm)

A4 A3 B4

Y X Y X Y X

[W] 170 240 240 380 215 325

[L] 210 120 330 205 275 170

[X] 15 30 30 15 15 15

[Y] 20 20 20 20 20 20

Se si utilizza un materiale di dimensioni superiori a quelle sopra elencate, impostare i valori facendo riferi-
mento a Margini e distanza tra i crocini di registro(P. 343).

MEMO

I crocini di registro vengono visualizzati sulla tavola da disegno.
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Passo 2: Creare i dati stampa e taglia

1. Inserire i dati di stampa

Procedura

1. Fare clic su [File]>[Import] per importare i dati di stampa.

In questo caso, il file Sample.bmp presente nella cartella in cui è installato CutStudio (normalmen-
te si trova nella cartella [Program Files (x86)]>[CutStudio] sull’unità C) viene aperto come dati di
stampa.

2. Selezionare i dati di stampa e fare clic su [Import].

3. Posizionare i dati di stampa nell’area all’interno dei crocini di registro.
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2. Aggiungere linee di taglio ai dati di stampa

Aggiungere le linee di taglio ai dati di stampa posizionati e creare i dati di stampa e taglio.

Procedura

1. Creare un nuovo livello per le linee di taglio e disegnarvi le linee di taglio.

In questo caso, viene tracciata una linea di taglio attorno ai dati di stampa, come mostrato di se-
guito ( ).

2. Fare clic su [File]>[Save].

3. Selezionare la cartella in cui salvare i dati, inserire il nome del file e fare clic su [Save].

I dati di stampa e taglio creati vengono salvati.
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Passo 3: Output dei dati di stampa e taglio

1. Stampare i dati stampa e taglia

Inviare i dati alla stampante e stampare i dati di stampa e taglio.

Procedura

1. Caricare il materiale nella stampante.

Per sapere come caricare il materiale nella stampante, consultare la documentazione della stam-
pante.

Se la stampa espansa/ridotta è abilitata, disabilitarla. Assicurarsi di stampare al 100% della scala.

IMPORTANTE

2. Nascondere il livello contenente le linee di taglio.

3. Fare clic su [File]>[Print].

4. Controllare la configurazione della stampa e fare clic su [Print].

Verranno stampati solo i dati di stampa.
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2. Caricare il materiale stampato

Caricare il materiale stampato da una stampante alla macchina.

Non è possibile utilizzare materiale arricciato: i crocini di registro potrebbero non essere leggibili. Se il materiale si
arriccia durante la stampa, raddrizzarlo prima di caricarlo sulla macchina.

IMPORTANTE

Procedura

1. Controllare l’origine del taglio ( ) sul materiale.

2. Impostare il materiale posizionando l’origine del taglio in basso a sinistra della macchina.

Se il materiale viene caricato in una direzione errata, la macchina non sarà in grado di leggere i crocini di
registro.

IMPORTANTE

3. Posizionare i rulli di trazione.

Osservare i seguenti punti quando si posizionano i rulli di trazione.

• Posizionare i rulli di trazione ( ) all’esterno dei segni degli strumenti ( )

• Assicurarsi che i rulli di trazione ( ) siano regolati all’interno entro i limiti delle granature
( )
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Impostare manualmente le posizioni dei crocini di registro. Tenere presenti i seguenti punti quando si utilizza
materiale in formati diversi da A3, A4 o B4.

• Quando si utilizza un rullo di trazione all’interno della granatura più a sinistra, assicurarsi di lasciare alme-
no 30 mm (W) dall’estremità sinistra della granatura al crocino di registro. Se la distanza libera è inferiore
a 30 mm, non è possibile leggere il crocino di registro.

MEMO

4. Allineare il bordo sinistro del materiale in modo che sia approssimativamente parallelo alle linee guida
( ).

Vista da sopra la macchina

5. Alzare la leva di caricamento.
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Il materiale è fissato in posizione.

6. Accendere la macchina.

7. Selezionare [FOGLIO] come tipo di materiale.

8. Premere [ENTER].

Vengono visualizzate la larghezza e la lunghezza del taglio.

W:***mm
L:***mm

9. Premere [▲][▼] per spostare il materiale e posizionare il crocino di registro ( ) sopra la protezione del-
la lama ( ).

I crocini di registro non possono essere letti nelle situazioni indicate di seguito. Rimuovere il materiale una
volta e poi ricaricarlo.

• I crocini di registro sono separati dalla protezione della lama ( ) da una distanza di 15 mm o più ( )
• I crocini di registro destro e sinistro sono inclinati di 5 gradi o più ( ) rispetto alla direzione di movimento

del carrello di taglio
• I crocini di registro destro e sinistro si discostano di 20 mm o più ( ) nella direzione di alimentazione del

materiale

IMPORTANTE
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10. Premere [◀][▶] per spostare il carrello di taglio in modo che la punta della lama arrivi al centro del cro-
cino di registro in basso a sinistra.
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Passo 4: Configurare l’impostazione per eseguire l’allineamento automatico

Posizionare automaticamente i crocini di registro utilizzando il sensore integrato nella macchina.

Procedura

1. Premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

2. Premere più volte [▼] per visualizzare la seguente schermata.

CROPMARK
<TOOL MODE>

3. Premere [▶].

4. Premere [▲] o [▼] per selezionare "SENSOR MODE".

CROPMARK
 SENSOR MODE

5. Premere [ENTER] per selezionare l’impostazione.

6. Premere [MENU] per tornare alla schermata originale.
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Passo 5: Inviare i dati di stampa e taglio a CutStudio

Procedura

1. Mostrare il livello contenente le linee di taglio in CorelDRAW e selezionarlo.

2. Nella tavolozza [Roland CutStudio], selezionare [Output Current Layer], quindi fare clic su [Update].

Confermare che la linea di taglio da produrre è visualizzata sullo schermata di anteprima.

3. Fare clic su .

CutStudio si avvia e i dati della linea di taglio vengono inviati a CutStudio.
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Passo 6: Impostazione delle condizioni di taglio

Procedura

1. Fare clic su [File]>[Cutting Setup].

Viene visualizzata la finestra [Cutting Setup].

2. All’indirizzo [Name], in [Printer], selezionare [Roland DG GS2-24].

Il nome del modello è impostato.

3. Fare clic su [Change] sotto [Media Size].
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4. Fare clic su [Get from Machine].

Acquisire l’intervallo di taglio dalla macchina collegata e [Width] e [Length] in [Cutting Area] ver-
ranno aggiornati.

Se viene visualizzato [The machine is not responding.], controllare le impostazioni della macchina e del com-
puter.

P. 302La macchina non funziona

MEMO

5. Fare clic su [OK].
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L’impostazione viene salvata e viene visualizzata la finestra [Cutting Setup].

6. Impostare le condizioni di taglio.

Normalmente, la casella di controllo [Use cutting conditions of machine] è selezionata.

Per modificare la condizione di taglio, deselezionare la casella di controllo [Use cutting conditions
of machine] e inserire i valori.

7. Fare clic su [OK].

L’intervallo e le condizioni di taglio vengono salvati.

L’area visualizzata in bianco in CutStudio è l’intervallo di taglio. I caratteri e le forme al di fuori di quest’area
non verranno tagliati.

MEMO
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Passo 7: Taglio

Inviare i dati stampa e taglia alla macchina e avviare il taglio.

Non toccare mai il carrello di taglio mentre l’output è in corso.
Il carrello di taglio si muove ad alta velocità. Il contatto con il carrello in movimento può causare lesioni.

AVVERTENZA

Procedura

1. In CutStudio, fare clic su .

Viene visualizzata la finestra [Cut].

2. Fare clic su [OK].

I dati stampa e taglia vengono inviati alla macchina. Quando la macchina riceve i dati stampa e
taglia, legge automaticamente i crocini di registro tramite un sensore e inizia a tagliare.

Se il sensore non riesce a leggere i crocini di registro, viene visualizzata la schermata mostrata di seguito.

Se viene visualizzata la seguente schermata, consultare Non vengono rilevati i crocini di registro(P.
297) per risolvere l’errore.

Se il problema non si risolve, passare alla modalità Strumento, quindi eseguire l’allineamento 

P. 179Stampa e taglio in modalità Strumento

MEMO
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SET TO
<TOOL MODE>

3. Rimuovere il materiale tagliato.

 COLLEGAMENTI CORRELATI 

・  P. 174 Rimozione del materiale
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Procedure dopo l’output
Scarico/taglio del materiale ........................................................................ 174

Rimozione del materiale ...................................................................... 174
Taglio del materiale ........................................................................... 176

Messa in pausa e annullamento dell'output ...................................................... 177
Mettere in pausa l’output..................................................................... 177
Annullamento dell’output .................................................................... 177
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Dopo l’output, scaricare o tagliare il materiale dalla macchina.

Rimozione del materiale

Al termine del taglio, rimuovere il materiale.

Procedura

1. Premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

2. Premere [ENTER].

Il carrello di taglio ritorna alla posizione iniziale.

3. Abbassare la leva di caricamento.

Non esercitare forza eccessiva per spostare la leva di caricamento.
Questo potrebbe danneggiarla.

IMPORTANTE

4. Rimuovere il materiale.

Scarico/taglio del materiale
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Scarico/taglio del materiale

Procedure dopo l’output 175



Taglio del materiale

Dopo l’uscita, tagliare il materiale come richiesto.

Procedura

1. Premere più volte [MENU] per visualizzare la seguente schermata.

W:***mm
L:***mm

2. Premere [▲][▼] per alimentare il materiale finché la linea di taglio non supera la posizione della guida
del coltello ( ).

3. Tagliare il materiale con una lama, ecc. lungo la guida del coltello sulla superficie anteriore della macchi-
na.
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176  Procedure dopo l’output



Mettere in pausa l’output

Un processo di taglio in corso può essere messo in pausa e l’output del taglio in pausa può essere ripreso.

Questa operazione può compromettere la qualità del taglio. Se possibile, evitate di fare pause.

MEMO

Procedura

1. Premere [PAUSE] prima di terminare la stampa.

L’output del taglio si interrompe.

2. Premere di nuovo [PAUSE].

L’operazione di stampa riprende.

Annullamento dell’output

Eseguire la seguente operazione per terminare l’output del taglio mentre è in corso il processo di taglio.

Questa operazione annulla i dati di uscita e non consente di riprendere l’output tagliato.

MEMO

Procedura

1. Premere [PAUSE] prima di terminare la stampa.

L’output del taglio si interrompe.

2. Tenere premuto [ENTER] per almeno un secondo.

I dati di uscita vengono annullati. Avviare nuovamente l’output di taglio.
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La modalità Strumento può essere utilizzata nelle seguenti situazioni.

• Quando non è possibile eseguire l’allineamento in modalità sensore

• Quando si esegue stampa e taglia senza selezionare il tipo di materiale

Non è possibile utilizzare la modalità Strumento quando si utilizzano solo 3 crocini.

MEMO

Articoli necessari

Strumento di allineamento
Materiale su cui sono stati stampati i segni degli strumenti

( )

Passo 1: Impostare il metodo di allineamento (modalità Strumento)

Procedura

1. Premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

2. Premere più volte [▼] per visualizzare la seguente schermata.

CROPMARK
<SENSOR MODE>

3. Premere [▶].

CROPMARK
 SENSOR MODE

4. Premere [▲] o [▼] per selezionare "TOOL MODE".

CROPMARK
 TOOL MODE

5. Premere [ENTER].

CROPMARK
<TOOL MODE>

6. Premere [MENU] per tornare alla schermata originale.
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Passo 2: Taglio dopo l’allineamento automatico

Non toccare mai il carrello di taglio mentre l’output è in corso.
Il carrello di taglio si muove ad alta velocità. Il contatto con il carrello in movimento può causare lesioni.

AVVERTENZA

Procedura

1. Se [File]>[Print&Cut] di CutStudio è deselezionato, selezionarlo.

2. Inviare i dati di taglio.

Viene visualizzata la schermata mostrata di seguito.

REPLACE TO TOOL
(QUIT   MENU)

3. Rimuovere il porta lama e installare lo strumento di allineamento.

Lo strumento di allineamento può essere installato allo stesso modo del porta lama.

4. Premere [ENTER].

Viene visualizzata la schermata mostrata di seguito.

Stampa e taglio in modalità Strumento
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MARK1 SET
(RETURN MENU)

5. Premere [▲][▼][◀][▶], e allineare la punta dello strumento di allineamento con il segno dello strumen-
to 1.

Tenere lo strumento di allineamento delicatamente dall’alto con il dito e verificare che la punta
dello strumento si sovrapponga al segno.

6. Premere [ENTER].

Lo strumento si sposta in una posizione vicina al crocino di registro in basso a destra e viene visua-
lizzata la schermata riportata di seguito.

MARK2 SET
(RETURN MENU)

7. Premere [▲][▼][◀][▶], e allineare la punta dello strumento di allineamento con il segno dello strumen-
to 2.

Per eseguire nuovamente l’allineamento, premere [MENU] durante l’impostazione per tornare alla schermata
precedente ed eseguire nuovamente la procedura.

MEMO

8. Premere [ENTER].

Lo strumento si sposta in una posizione vicina al crocino di registro in alto a sinistra e viene visua-
lizzata la schermata riportata di seguito.

MARK3 SET
(RETURN MENU)

9. Allineare allo stesso modo i segni degli strumenti 3 e 4.
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Segno dello strumento 3 Segno dello strumento 4

10. Dopo aver allineato il segno dello strumento 4, premere [ENTER].

Viene visualizzata la schermata mostrata di seguito.

REPLACE TO BLADE
(RETURN MENU)

11. Rimuovere lo strumento di allineamento e installare il porta lama.

12. Premere [ENTER].

13. Premere [ENTER] quando viene visualizzata la seguente schermata.

Il taglio inizia.

COMPLETE ENTER
QUIT    MENU

14. Rimuovere il materiale tagliato.

 COLLEGAMENTI CORRELATI 

・  P. 43 Installare il porta lama

・  P. 174 Rimozione del materiale
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Utilizzando la modalità manuale, è possibile eseguire stampa e taglio senza CutStudio, Adobe Illustrator o
CorelDRAW.

Verificare preventivamente il materiale compatibile e la stampante da utilizzare.

Stampante da utilizzare

Stampante laser o a getto d’inchiostro con una risoluzione di 720 dpi o superiore

 COLLEGAMENTI CORRELATI 

・  P. 15 Condizioni per i materiali utilizzabili

Passo 1: Creare manualmente i dati dei segni degli strumenti

Creare i dati dei segni degli strumenti utilizzando un software diverso da CutStudio, Adobe Illustrator o
CorelDRAW.

Quando si utilizza un software applicativo per aggiungere i segni degli strumenti a un’illustrazione, impo-
stare la posizione tenendo conto del margine necessario per il taglio.
Questa sezione descrive come creare manualmente i dati dei segni degli strumenti utilizzando i dati di
esempio.

Dati di esempio:

Sample.bmp che si trova nella cartella di installazione di CutStudio (normalmente situata nella cartella
[Program Files (x86)]>[CutStudio] nell’unità C)

Procedura

1. Disegnare i segni degli strumenti.

Non esiste un disegno particolare da utilizzare per i segni degli strumenti, ma l’utilizzo di forme
con angoli, come mostrato nella figura seguente, facilita l’allineamento.

Il punto di origine del taglio si trova in basso a sinistra. Il segno dello strumento di origine deve
essere distinguibile dagli altri.

2. Impostare i margini.

Quando si utilizza materiale con una grande quantità di alimentazione (materiale lungo), si consi-
glia di impostare i seguenti margini: Circa 25 mm ( ) rispettivamente a sinistra e a destra, circa
20 mm ( ) in alto nella direzione di alimentazione del materiale e circa 50 mm ( ) nella parte
posteriore nella direzione di alimentazione.
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3. Prendere nota della distanza tra i segni degli strumenti (larghezza W, lunghezza L).

4. Prendere nota dei valori di offset.

Controllare l’origine (dove X e Y sono pari a 0) del software e annotare la distanza tra questo pun-
to di origine ( ) e il segno dello strumento in basso a sinistra (W, L).

5. Posizionare l’illustrazione all’interno dell’area di taglio definita dai segni dello strumento.

Stampa e taglio in modalità manuale
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 COLLEGAMENTI CORRELATI 

・  P. 343 Margini e distanza tra i crocini di registro
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Passo 2: Output dei dati di stampa e taglio

1. Stampare i dati stampa e taglia

Procedura

1. Caricare il materiale in fogli nella stampante.

Per sapere come caricare il materiale nella stampante, consultare la documentazione della stam-
pante.

Se la stampa espansa/ridotta è abilitata, disabilitarla. Assicurarsi di stampare al 100% della scala.

IMPORTANTE

2. Stampare i dati stampa e taglia.

Stampa e taglio in modalità manuale
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2. Caricare il materiale stampato

Caricare il materiale stampato da una stampante alla macchina.

Il materiale a volte si arriccia quando viene stampato dalla stampante. Appiattire il materiale arricciato prima di cari-
carlo sulla macchina.

IMPORTANTE

Procedura

1. Controllare l’origine ( ) per il taglio del materiale.

2. Impostare l’origine del taglio sull’angolo inferiore sinistro del materiale, quindi caricare il materiale nella
macchina.

Se il materiale viene caricato nella direzione sbagliata, i valori indicati nelle procedure 3 e 4 del passaggio 1
non sono validi e non sarà possibile eseguire correttamente il taglio.

IMPORTANTE

3. Posizionare i rulli di trazione.

Osservare i seguenti punti quando si posizionano i rulli di trazione.

• Posizionare i rulli di trazione ( ) all’esterno dei segni degli strumenti ( ).

• Assicurarsi che il rullo di trazione ( ) sia impostato nell’intervallo della granatura ( ).
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4. Allineare il bordo sinistro del materiale in modo che sia approssimativamente parallelo alle linee guida
( ).

Vista da sopra la macchina

5. Sollevare la leva di caricamento per fissare il materiale in posizione.

6. Accendere la macchina.

7. Selezionare [FOGLIO] come tipo di materiale.

8. Premere [ENTER].

Vengono visualizzate la larghezza e la lunghezza del taglio.

W:***mm
L:***mm
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9. Premere [▲][▼] per spostare il materiale e posizionare il segno dello strumento ( ) sopra la protezione
della lama ( ).

Se si verifica una delle seguenti situazioni, rimuovere il materiale una volta e poi ricaricarlo.

• I segni dello strumento sono separati dalla protezione della lama di almeno 15 mm
• I segni dello strumento destro e sinistro sono inclinati di 5 gradi o più rispetto alla direzione di movimento

del carrello di taglio.
• È deviato di 20 mm o più nella direzione di avanzamento del materiale

IMPORTANTE

10. Premere [◀][▶] per spostare il carrello di taglio in modo che la punta della lama arrivi sul segno dello
strumento in basso a sinistra.
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Passo 3: Impostazione del metodo di allineamento (modalità manuale)

1. Selezionare la modalità manuale

Impostare il metodo di allineamento dei crocini di registro su modalità manuale.

Procedura

1. Premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

2. Premere più volte [▼] per visualizzare la seguente schermata.

CROPMARK
<SENSOR MODE>

3. Premere [▶].

CROPMARK
 SENSOR MODE

4. Premere [▲][▼], quindi selezionare "MANUALE".

CROPMARK
 MANUAL

5. Premere [ENTER].

CROPMARK
<MANUAL>

6. Premere [▶].
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2. Inserire la distanza tra i segni dello strumento

Immettere la distanza, la larghezza (W) e la lunghezza (L) annotate durante la creazione manuale dei se-
gni.

Procedura

1. Premere [▶] tre volte per aprire la schermata mostrata di seguito.

WIDTH 160
*160mm

2. Premere [▲][▼] e inserire la distanza orizzontale ("LARGH") tra i segni dello strumento.

WIDTH 160
*180mm

3. Premere [ENTER] per selezionare l’impostazione.

WIDTH 180

4. Premere [▼], quindi [▶] per visualizzare la schermata mostrata di seguito.

LENGTH 210
*210mm

5. Premere [▲][▼] e inserire la distanza verticale ("LUNG.") tra i segni dello strumento.

LENGTH 210
*230mm

6. Premere [ENTER] per selezionare l’impostazione.

LENGTH 230
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 COLLEGAMENTI CORRELATI 

・  P. 183 Creare manualmente i dati dei segni degli strumenti
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3. Immettere i valori di offset

Immettere la distanza del valore di offset, la larghezza (W) e la lunghezza (L) annotate durante la creazio-
ne manuale dei segni.

Procedura

1. Premere [▼], quindi [▶] per visualizzare la schermata mostrata di seguito.

OFFSET W 0.5
*0.5mm

2. Inserire il valore di offset della larghezza (W) con [▲][▼].

OFFSET W 0.5
*0.0mm

3. Premere [ENTER] per selezionare l’impostazione.

OFFSET W 0.0

4. Premere [▼], quindi [▶] per visualizzare la schermata mostrata di seguito.

OFFSET L 0.5
*0.5mm

5. Inserire il valore di offset della lunghezza (L) con [▲][▼].

OFFSET L 0.5
*0.0mm

6. Premere [ENTER] per selezionare l’impostazione.

OFFSET L 0.0
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 COLLEGAMENTI CORRELATI 

・  P. 183 Creare manualmente i dati dei segni degli strumenti
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Passo 4: Taglio (modalità manuale)

Non toccare mai il carrello di taglio mentre l’output è in corso.
Il carrello di taglio si muove ad alta velocità. Il contatto con il carrello in movimento può causare lesioni.

AVVERTENZA

Procedura

1. Premere [◀], quindi [▼] per visualizzare la schermata mostrata di seguito.

Per 3 segni di utensile, selezionare "START 3 PUNTI".

MANUAL
4-POINT START

2. Premere [ENTER].

Viene visualizzata la schermata mostrata di seguito.

REPLACE TO TOOL
(QUIT   MENU)

3. Rimuovere il porta lama e installare lo strumento di allineamento.

Lo strumento di allineamento può essere installato allo stesso modo del porta lama.

4. Premere [ENTER].

Viene visualizzata la schermata mostrata di seguito.

MARK1 SET
(RETURN MENU)

5. Premere [▲][▼][◀][▶], e allineare la punta dello strumento di allineamento con il segno dello strumen-
to 1.

Tenere lo strumento di allineamento delicatamente dall’alto con il dito e verificare che la punta
dello strumento si sovrapponga al segno.
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6. Premere [ENTER].

Lo strumento si sposta in una posizione vicina al segno in basso a destra e viene visualizzata la
schermata mostrata di seguito.

MARK2 SET
(RETURN MENU)

7. Premere [▲][▼][◀][▶], e allineare la punta dello strumento di allineamento con il segno dello strumen-
to 2.

Per eseguire nuovamente l’allineamento, premere [MENU] durante l’impostazione per tornare alla schermata
precedente ed eseguire nuovamente la procedura.

MEMO

8. Premere [ENTER].

Lo strumento si sposta in una posizione vicina al segno in alto a sinistra e viene visualizzata la
schermata mostrata di seguito.

MARK3 SET
(RETURN MENU)

9. Allineare allo stesso modo i segni degli strumenti 3 e 4.
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10. Dopo aver allineato il segno dello strumento 4, premere [ENTER].

Viene visualizzata la schermata mostrata di seguito.

REPLACE TO BLADE
(RETURN MENU)

11. Rimuovere lo strumento di allineamento e installare il porta lama.

12. Premere [ENTER].

13. Premere [ENTER] quando viene visualizzata la seguente schermata.

COMPLETE ENTER
QUIT    MENU

14. Quando viene visualizzata la schermata riportata di seguito, inviare i dati di taglio dal computer.

OUTPUT DATA

Quando la macchina riceve i dati, inizierà a tagliare.

15. Rimuovere il materiale tagliato.

 COLLEGAMENTI CORRELATI 

・  P. 174 Rimozione del materiale

・  P. 43 Installare il porta lama
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Guida generale alle condizioni di taglio

Le tre condizioni di taglio sono la forza della lama, la velocità di taglio e l’offset della punta della lama.

Di seguito viene fornita una guida generale delle condizioni di taglio e la durata della lama per diverse
combinazioni di materiali e lame.

Si noti che il taglio ottimale non si ottiene necessariamente solo rispettando le condizioni di seguito ripor-
tate. Prima di tagliare, eseguire una prova di taglio con una lama adatta al materiale del foglio.

Alcune lame sono adatte a determinati materiali in fogli. Il taglio di materiali non idonei può causare la rottura della
lama.

IMPORTANTE

Lama Materiale Forza della lama
(gf)

Velocità di taglio
(cm/sec)*1

Offset della pun-
ta della lama

(mm)

Vita utile (m) *2

ZEC-U5032 Vinile generale Da 30 a 100 20 o meno 0,25 4,000

ZEC-U5025
Vinile generale Da 40 a 100 20 o meno

0,25
4,000

Vinile fluorescente Da 120 a 200 10 o meno 2,500

 

*1 Maggiore è la velocità di taglio, peggiore è la qualità dell’immagine. Regolare la velocità in base alla qualità dell’immagine
desiderata.

*2 La vita utile è un’indicazione generale nel caso in cui sia stato tagliato lo stesso tipo di materiale.
 

Se rimangono aree non tagliate anche quando la forza della lama viene aumentata ad un valore di 50 - 60 gf superiore a
quelli indicati in questa tabella, sostituire la lama.

MEMO
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・  P. 45 Eseguire un taglio di prova

・  P. 202 Regolazione dell’impostazione del taglio

・  P. 287 Sostituzione della lama
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Eseguire una prova di taglio prima di regolare l’impostazione del taglio. Regolare la condizione di taglio
dopo aver controllato il risultato della prova di taglio. È possibile modificare la forza della lama, la veloci-
tà di taglio e l’offset della punta della lama dalla finestra [Print Setting] del driver di stampa (o da Cut-
Studio/VersaWorks).

 COLLEGAMENTI CORRELATI 

・  P. 45 Eseguire un taglio di prova

Regolazione del volume di taglio

Quando si desidera eseguire una regolazione precisa del volume di taglio, ad esempio quando si tagliano
materiali con carta di supporto sottile, è possibile ottenere buoni risultati regolando l’estensione della la-
ma. Ruotare la porzione di tappo del supporto lama per regolare l’estensione.

L’estensione della lama ( ) è di 0 mm ( ) al minimo e 2,5 mm ( ) al massimo. È possibile effettuare una
regolazione di 0,5 mm ruotando il cappuccio di un giro completo.

Impostare l’estensione della lama ( ) ad un valore che corrisponda alla somma dello spessore della por-
zione del materiale ( ) e della metà ( ) dello spessore della carta di supporto ( ).

Se si tagliano linee perforate in materiali senza carta di supporto, impostare la quantità di estensione della lama ( ) in
modo che quando la taglierina perfora il materiale ( ), la lama si estenda leggermente. Spingendo la lama troppo lon-
tano si danneggiano la lama e la protezione della lama e se ne accelera il deterioramento. Prestare attenzione.

MEMO
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Impostazione della forza della lama

Se il disegno si stacca o se anche la carta di supporto viene tagliata insieme al materiale, modificare la
forza della lama.

Procedura

1. Verificare che il cursore PEN FORCE [PEN FORCE] sia in posizione centrale (a "0" sulla scala).

▲
▲ ▲▲

-2 -1 0 +1 +2

2. Premere [FORCE].

Viene visualizzata la forza attuale della lama.

FORCE 50gf
* 50gf

3. Premere [▲] o [▼] per selezionare un valore.

4. Premere [ENTER] per selezionare l’impostazione.

• Impostazione predefinita di fabbrica: 50 gf
• Campo di impostazione: Da 30 a 500 gf (modificabile in passi di 10 gf)

MEMO
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・  P. 201 Guida generale alle condizioni di taglio

Microregolazione della forza della lama

Dopo aver impostato la forza della lama tramite il menu "FORZA", è possibile regolare ulteriormente la for-
za della lama utilizzando il cursore PEN FORCE. "FORZA"Utilizzare questa operazione quando si desidera
aumentare o diminuire leggermente la forza della lama rispetto all’impostazione effettuata tramite il me-
nu.

Procedura

1. Regolare la forza della lama con il cursore PEN FORCE.

Regolazione dell’impostazione del taglio
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▲
▲ ▲▲

-2 -1 0 +1 +2

• Campo di regolazione: ±Circa 30 gf

Questo valore è solo indicativo. L’accuratezza di questo valore non è garantita.

MEMO

Regolazione dell’impostazione del taglio

Ottimizzazione della qualità di taglio 205



Regolazione della velocità di taglio

Regolare la velocità di taglio.

Procedura

1. Premere più volte [MENU] per visualizzare la seguente schermata.

CONDITION

Quando il materiale è stato caricato, seguire la seguente procedura per visualizzare la schermata.
1. Premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

2. Premere [▼].

MEMO

2. Premere [▶].

3. Premere [▲][▼] per visualizzare la seguente schermata.

SPEED 40cm/s

4. Premere [▶].

5. Premere [▲] o [▼] per selezionare un valore.

SPEED 40cm/s
  10cm/s

6. Premere [ENTER] per selezionare l’impostazione.

7. Premere [MENU] per tornare alla schermata originale.

• Impostazione predefinita di fabbrica: 20 cm/s
• Campo di impostazione: Da 1 a 85 cm/s (passi da 1 cm/s)

MEMO
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Impostazione dell’offset della punta della lama

Questa impostazione consente di impostare l’offset della punta della lama. Immettere il valore di offset
elencato per la lama. Quando si utilizza la lama in dotazione, il taglio può essere eseguito utilizzando le
impostazioni predefinite.

Se l’inizio di un taglio si discosta dalla posizione prevista o se gli angoli di una forma non sono puliti, regolare l’offset.

MEMO

Procedura

1. Premere più volte [MENU] per visualizzare la seguente schermata.

CONDITION

Quando il materiale è stato caricato, seguire la seguente procedura per visualizzare la schermata.
1. Premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

2. Premere [▼].

MEMO

2. Premere [▶].

3. Premere [▲][▼] per visualizzare la seguente schermata.

OFFSET 0.250mm

4. Premere [▶].

5. Premere [▲] o [▼] per selezionare un valore.

OFFSET 0.250mm
  0.500mm

6. Premere [ENTER] per selezionare l’impostazione.

7. Premere [MENU] per tornare alla schermata originale.

• Impostazione predefinita di fabbrica: 0,250 mm
• Campo di impostazione: Da 0,000 a 1,000 mm (passi da 0,025 mm)

MEMO
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Impostare l’orientamento delle coordinate di taglio

Ruotare le coordinate di taglio e decidere in quale direzione tagliare il materiale.

Procedura

1. Premere più volte [MENU] per visualizzare la seguente schermata.

CONDITION

Quando il materiale è stato caricato, seguire la seguente procedura per visualizzare la schermata.
1. Premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

2. Premere [▼].

MEMO

2. Premere [▶].

3. Premere [▲][▼] per visualizzare la seguente schermata.

ROTATE 0deg A

4. Premere [▶].

5. Premere [▲] o [▼] per selezionare un’impostazione.

ROTATE 0deg A
*0deg A

"0deg" Le frecce nelle figure seguenti indicano le direzioni positive
degli assi X e Y rispettivamente.

• Punto di origine: In basso a sinistra
• Asse delle coordinate:

Direzione verticale: Asse Y
Direzione orizzontale: Asse X
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"90deg" Le frecce nelle figure seguenti indicano le direzioni positive
degli assi X e Y rispettivamente.

• Punto di origine: In basso a destra
• Asse delle coordinate:

Direzione verticale: Asse X
Direzione orizzontale: Asse Y

6. Premere [ENTER] per selezionare l’impostazione.

• Impostazione predefinita di fabbrica: "0deg"

MEMO

È inoltre possibile confermare il valore di impostazione premendo più volte MENU per visualizzare
la seguente schermata.

• Quando è impostato su "0deg"

20cm/s
250gf 0.250mm ∠A

• Quando è impostato su "90deg"

20cm/s
250gf 0.250mm ∠ A

7. Premere [MENU] per tornare alla schermata originale.
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Estensione dell’area di taglio

L’estensione dell’area di taglio consente di sfruttare al massimo il materiale.

A seconda del disegno da tagliare, i rulli di trazione possono passare sopra la parte superiore della linea di taglio.

MEMO

Procedura

1. Premere più volte [MENU] per visualizzare la seguente schermata.

CONDITION

Quando il materiale è stato caricato, seguire la seguente procedura per visualizzare la schermata.
1. Premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

2. Premere [▼].

MEMO

2. Premere [▶].

3. Premere [▲][▼] per visualizzare la seguente schermata.

EXTEND 0.0mm

4. Premere [▶].

5. Premere [▲] o [▼] per selezionare un valore.

EXTEND 0.0mm
  10.0mm

• Il valore impostato viene applicato a entrambe le estremità dell’area di taglio.
• Se "ESTENSIONE" viene impostato dopo aver caricato il materiale, il valore "W" visualizzato sul pannello co-

mandi differirà dalla larghezza di taglio effettiva.

IMPORTANTE
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Ottimizzazione della qualità di taglio 211



Esempio: Quando si imposta da 0 mm a 10,0 mm

200 mm

220 mm

10 mm

6. Premere [ENTER] per selezionare l’impostazione.

7. Premere [MENU] per tornare alla schermata originale.

• Impostazione predefinita di fabbrica: 0,0 mm
• Campo di impostazione: Da 0,0 a 10,0 mm

MEMO
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・  P. 39 Selezionare il tipo di materiale

Regolazione dell’impostazione del taglio

212  Ottimizzazione della qualità di taglio



Impostazione della velocità della lama durante il taglio

Questa impostazione consente di impostare la velocità di spostamento della lama alla posizione di taglio
successiva con la lama sollevata dal materiale durante l’operazione di taglio. Quando si taglia un materiale
più sottile o più spesso di quello standard, potrebbe essere meglio diminuire la velocità per evitare proble-
mi come il sollevamento del materiale.

Procedura

1. Premere più volte [MENU] per visualizzare la seguente schermata.

CONDITION

Quando il materiale è stato caricato, seguire la seguente procedura per visualizzare la schermata.
1. Premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

2. Premere [▼].

MEMO

2. Premere [▶].

3. Premere [▲][▼] per visualizzare la seguente schermata.

UPSPEED 40cm/

4. Premere [▶].

5. Premere [▲] o [▼] per selezionare un valore.

UPSPEED 40cm/
  AUTO

Quando "AUTO" è impostato, si muove alla velocità impostata in "VEL.". Aumentando "MOV." si ridu-
ce il tempo di taglio.

6. Premere [ENTER] per selezionare l’impostazione.

7. Premere [MENU] per tornare alla schermata originale.

• Impostazione predefinita di fabbrica: "AUTO"
• Campo di impostazione: Da 10 a 85 cm/s (passi da 5 cm/s), "AUTO"

MEMO
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Taglio liscio di archi e altre curve (lisciatura)

È possibile impostare le curve dei dati di taglio inviati alla macchina in modo che siano lisce. Normalmente
si imposta la leva di regolazione dell’altezza su "ON". Se i tagli angolari sono troppo rotondi quando si ta-
gliano testi piccoli o forme intricate, impostare questo parametro su "OFF". Si consiglia di impostare anche
questo su "OFF" quando è necessario aumentare la produttività a prescindere dalla qualità.

Procedura

1. Premere più volte [MENU] per visualizzare la seguente schermata.

CONDITION

Quando il materiale è stato caricato, premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

MEMO

2. Premere più volte [▼] per visualizzare la seguente schermata.

OTHERS

3. Premere [▶].

4. Premere [▲][▼] per visualizzare la seguente schermata.

SMOOTHING ON

5. Premere [▶].

6. Premere [▲] o [▼] per selezionare "ON" o "OFF".

SMOOTHING ON
*ON

7. Premere [ENTER] per selezionare l’impostazione.

8. Premere [MENU] per tornare alla schermata originale.

• Impostazione predefinita di fabbrica: "ON"

MEMO
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Taglio ripetuto nella stessa posizione (sovrapposizione)

Il taglio viene ripetuto più volte nella stessa posizione con gli stessi dati di taglio. Utilizzare questa impo-
stazione per i materiali che non possono essere tagliati in un solo passaggio, come ad esempio i materiali
spessi.

Procedura

1. Premere più volte [MENU] per visualizzare la seguente schermata.

CONDITION

Quando il materiale è stato caricato, premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

MEMO

2. Premere più volte [▼] per visualizzare la seguente schermata.

OTHERS

3. Premere [▶].

4. Premere [▲][▼] per visualizzare la seguente schermata.

OVERLAP OFF

5. Premere [▶].

6. Premere [▲] o [▼] per selezionare un valore.

OVERLAP OFF
*OFF

Oltre al taglio normale, viene eseguito un numero di tagli pari al valore impostato.

MEMO

7. Premere [ENTER] per selezionare l’impostazione.

8. Premere [MENU] per tornare alla schermata originale.

• Impostazione predefinita di fabbrica: "OFF"
• Campo di impostazione: "OFF", da 1 a 10

MEMO
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・  P. 81 Taglio
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Taglio netto degli angoli (Over Cut)

Questa funzione taglia gli extra all’inizio e alla fine di una linea di taglio. È efficace quando si desidera
produrre angoli particolarmente netti, ad esempio quando si tagliano materiali più spessi. Quando si ta-
gliano caratteri piccoli o forme complesse, questa funzione viene normalmente impostata su "OFF" per evi-
tare di tagliare parti necessarie del materiale.

"ON" "OFF"

Procedura

1. Premere più volte [MENU] per visualizzare la seguente schermata.

CONDITION

Quando il materiale è stato caricato, premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

MEMO

2. Premere più volte [▼] per visualizzare la seguente schermata.

OTHERS

3. Premere [▶].

4. Premere [▲][▼] per visualizzare la seguente schermata.

OVER CUT OFF

5. Premere [▶].

6. Premere [▲] o [▼] per selezionare "ON" o "OFF".
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OVER CUT OFF
*OFF

7. Premere [ENTER] per selezionare l’impostazione.

8. Premere [MENU] per tornare alla schermata originale.

• Impostazione predefinita di fabbrica: "OFF"

MEMO
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Utilizzo di materiale più sottile o più duro del normale

Attivare la ventola di aspirazione per mantenere il materiale in posizione durante il taglio, in modo da evi-
tare che il materiale si sollevi o si sposti. Normalmente, utilizzare "AUTO" così com’è. Tuttavia, il volume
d’aria della ventola di aspirazione deve essere ridotto quando si utilizzano materiali sottili e/o non solidi.

Procedura

1. Premere più volte [MENU] per visualizzare la seguente schermata.

CONDITION

Quando il materiale è stato caricato, premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

MEMO

2. Premere più volte [▼] per visualizzare la seguente schermata.

OTHERS

3. Premere [▶].

4. Premere [▲][▼] per visualizzare la seguente schermata.

VACUUMFAN AUTO

5. Premere [▶].

6. Premere [▲] o [▼] per selezionare un valore.

Utilizzare un volume d’aria più basso quando si utilizza un materiale sottile.

VACUUMFAN AUTO
*AUTO

7. Premere [ENTER] per selezionare l’impostazione.

8. Premere [MENU] per tornare alla schermata originale.

• Impostazione predefinita di fabbrica: "AUTO"

MEMO
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• Campo di impostazione: Da 1 a 5, "AUTO"
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Prevenzione del disallineamento del taglio

Il materiale viene alimentato automaticamente prima e durante il taglio per evitare il disallineamento del-
le posizioni di taglio. Se questa opzione è impostata su "ON", il materiale viene fatto avanzare automatica-
mente per 1 m ogni volta che il computer invia i dati di taglio (a seconda dei dati, il materiale può essere
fatto avanzare di 1 m o più), quindi inizia il taglio.

Se il materiale è già stato alimentato con la funzione "AREA", il materiale non verrà alimentato automaticamente per la
quantità già alimentata, anche se "PRE-FEED" è impostato su "ON".

MEMO

Procedura

1. Premere più volte [MENU] per visualizzare la seguente schermata.

CONDITION

Quando il materiale è stato caricato, premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

MEMO

2. Premere più volte [▼] per visualizzare la seguente schermata.

OTHERS

3. Premere [▶].

4. Premere [▲][▼] per visualizzare la seguente schermata.

PRE-FEED OFF

5. Premere [▶].

6. Premere [▲] o [▼] per selezionare "ON" o "OFF".

PRE-FEED OFF
*OFF

7. Premere [ENTER] per selezionare l’impostazione.

8. Quando si seleziona "ON", impostare la velocità di alimentazione del materiale.

(1) Premere [▶] due volte per visualizzare la schermata mostrata di seguito.

Evitare e correggere il taglio disallineato
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SPEED 40cm/s

(2) Premere [▶].

(3) Premere [▲] o [▼] per selezionare un valore.

(4) Premere [ENTER] per selezionare l’impostazione.

9. Premere [MENU] per tornare alla schermata originale.

• Impostazione predefinita di fabbrica: "OFF"
• Campo di impostazione: "ON" (da 1 a 10 cm/s), "OFF"

MEMO
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Regolazione della posizione di taglio

Se la posizione di stampa e la posizione di taglio sono sfalsate come mostrato nella figura seguente, è pos-
sibile correggere il problema regolandole. Questo esempio mostra la procedura di regolazione della posi-
zione di taglio.

: Linea di taglio prevista

: Linea di taglio effettiva

Procedura

1. Verificare che il materiale sia stato caricato.

2. Controllare i valori di correzione in base allo stato del taglio.

"CROP-L" indica la direzione di avanzamento del materiale, mentre "CROP-W" indica la direzione di
movimento del carrello di taglio.

Esempio: Per spostare la linea di taglio di 0,5 mm verso destra ( ) e di 0,7 mm verso l’alto ( )

+

+
-

-

• CROP-W: Impostato a +0,500

• CROP-L: Impostato a +0,700

3. Premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

4. Premere [▼] per visualizzare la seguente schermata.

Evitare e correggere il taglio disallineato
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OTHERS

5. Premere [▶].

6. Premere [▲][▼] per visualizzare la seguente schermata.

CROP ADJ.

7. Impostare i valori di correzione per CROP-L e CROP-W.

(1) Premere [▶] due volte per visualizzare la schermata mostrata di seguito.

CROP-L 0.000
*0.000mm

(2) Premere [▲][▼] per impostare il valore di correzione per CROP-L.

(3) Premere [ENTER] per selezionare l’impostazione.

(4) Premere "▼", quindi "▶" per visualizzare la schermata mostrata di seguito.

CROP-W 0.000
*0.000mm

(5) Premere [▲][▼] per impostare il valore di correzione per CROP-W.

(6) Premere [ENTER] per selezionare l’impostazione.

8. Premere [MENU] per tornare alla schermata originale.

9. Eseguire nuovamente il taglio.

Se il disallineamento della linea di taglio viene corretto, la regolazione è completa. Se è necessa-
ria un’ulteriore regolazione, ripetere la procedura.

MEMO
• Impostazione predefinita di fabbrica:

"CROP-L": (direzione di avanzamento del materiale) 0,000

"CROP-W": (Direzione di movimento del carrello di taglio) 0,000

• Campo di impostazione: Da -25,000 mm a +25,000 mm

Evitare e correggere il taglio disallineato
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Regolazione della posizione di stampa

Se la posizione di stampa e la posizione di taglio sono sfalsate come mostrato nella figura seguente, è pos-
sibile correggere il problema regolandole. Questo esempio mostra la procedura di regolazione della posi-
zione di stampa.

: Linea di taglio prevista

: Linea di taglio effettiva

Procedura

1. In CutStudio, fare clic su [File]>[Printing Setup].

Evitare e correggere il taglio disallineato
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2. Selezionare [Fine adjustment] e fare clic su [Adjust].

Viene visualizzata la finestra [Crop Mark Adjustment].

3. Allineare la posizione rispetto a una linea o a un punto ( ) vicino all’origine ( ).

Regolare i valori [BaseX] e [BaseY] per eliminare il disallineamento, quindi fare clic su [OK].

• Quando la posizione di taglio devia a sinistra o a destra rispetto alla posizione di stampa

Modificare il valore [BaseX]. Se la posizione di taglio è spostata a destra della posizione di
stampa, aumentare il valore; se è spostata a sinistra della posizione di stampa, diminuire il va-
lore. Nel caso illustrato nella figura precedente, aumentare [BaseX].

• Quando la posizione di taglio devia al di sopra o al di sotto della posizione di stampa

Modificare il valore [BaseY]. Se la posizione di taglio è spostata sopra la posizione di stampa,
aumentare il valore; se è spostata sotto la posizione di stampa, diminuire il valore. Nel caso
illustrato nella figura precedente, aumentare [BaseY].

Se le posizioni di stampa e di taglio sono disallineate in un punto distante dall’origine ( ), co-
me mostrato nella figura seguente, anche dopo aver regolato le posizioni con [BaseX] e [Ba-
seY], il materiale espanso, contratto o distorto potrebbe generare una distanza tra i crocini di
registro stampati diversa da quella impostata ([W], [L]). Procedere al passaggio 4.

4. Impostare [W] e [L] sulla finestra [Crop Mark Adjustment] e correggere le differenze.

Tuttavia, i valori sono solo di riferimento. I valori ottimali devono essere trovati modificando i va-
lori e tagliando effettivamente il materiale più volte.

Evitare e correggere il taglio disallineato
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Prima dell’impostazione, verificare che [BaseX] e [BaseY] siano stati regolati rispetto a una linea o a un punto
vicino all’origine ( ). Se l’allineamento avviene rispetto a un punto lontano, il risultato della regolazione del
passaggio 3 si discosta quando si impostano [W] e [L].

IMPORTANTE

• Le linee di taglio deviano verso l’esterno rispetto alla posizione di stampa

Questo può essere dovuto al fatto che la distanza tra i crocini di registro stampati è maggiore
di quella impostata. In questo caso, [W] e [L] devono essere maggiori delle impostazioni per
regolare il posizionamento.

• Le linee di taglio deviano verso l’interno rispetto alla posizione di stampa

Questo può essere dovuto al fatto che la distanza tra i crocini di registro stampati è minore di
quella impostata. In questo caso, [W] e [L] devono essere minori rispetto alle impostazioni per
regolare il posizionamento.

: Punto di origine

I valori immessi nella finestra [Crop Mark Adjustment] sono validi solo quando si seleziona [Adjust] nella
finestra di dialogo [Printing Setup]. Tutti i valori immessi vengono cancellati se si deseleziona [Fine ad-
justment] o se si modificano le impostazioni di [W] e [L] in [CROPMARK].

IMPORTANTE

Se il sensore non riesce a leggere i crocini di registro, viene visualizzata la schermata mostrata di seguito.

Se viene visualizzata la seguente schermata, consultare Non vengono rilevati i crocini di registro(P.
297) per risolvere l’errore.

MEMO
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SET TO
<TOOL MODE>

Se il problema non si risolve, passare alla modalità Strumento, quindi eseguire l’allineamento 

P. 179Stampa e taglio in modalità Strumento

Evitare e correggere il taglio disallineato
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"RISTAMPA"

I dati ricevuti dal computer possono essere salvati nella memoria della macchina e possono essere utilizza-
ti ripetutamente per tagliare (recut). Per eseguire il ritaglio, utilizzare "RISTAMPA" nel menu di visualizza-
zione.

• Vengono salvati tutti i dati ricevuti dal momento in cui la macchina viene messa in condizione di confi-
gurazione al momento in cui la condizione di configurazione viene annullata.

• I dati non vengono cancellati nemmeno quando la condizione di configurazione viene annullata.

• Se la condizione di configurazione viene annullata e la macchina viene reimpostata in condizione di
configurazione, i dati salvati vengono sovrascritti con i nuovi dati inviati dal computer.

• Tutti i dati vengono cancellati quando si spegne l’alimentazione.

• Se i dati memorizzati nella memoria della macchina superano i 2 MB, non è possibile eseguire il ritaglio
finché i dati non vengono cancellati. Se si esegue "RISTAMPA" in questa condizione, viene visualizzato
"DATA OVERFLOW". Se non sono presenti dati nella memoria della macchina, quando si seleziona "RI-
STAMPA" dal menu, viene visualizzato "DATI ASSENTI".

Passo 1: Preparazione dei dati per il ritaglio

Cancellare tutti i dati rimasti nella memoria della macchina, quindi inviare nuovi dati in modo da memo-
rizzare solo quelli necessari.

Procedura

1. Verificare che il materiale sia stato caricato.

2. Premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

3. Premere più volte [▼] per visualizzare la seguente schermata.

REPLOT
<DATA EXISTS>

Se viene visualizzato "DATI ASSENTI", passare al passaggio 6.

4. Premere [▶].

REPLOT
*START

5. Premere [▼] per selezionare "CANCELLA".

REPLOT
*CLEAR

6. Premere [ENTER].

I dati vengono cancellati.

Tagliare ripetutamente gli stessi dati
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REPLOT
<NO DATA>

7. Inviare i dati dal computer.

Tagliare ripetutamente gli stessi dati
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Passo 2: Recut

Procedura

1. Premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

2. Premere più volte [▼] per visualizzare la seguente schermata.

REPLOT
<DATA EXISTS>

3. Premere [▶].

REPLOT
*START

4. Premere [ENTER].

Il display torna a quello mostrato sotto e viene eseguito il taglio che è stata salvato in memoria.

20cm/s
250gf 0.250mm ∠A

Tagliare ripetutamente gli stessi dati
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Salvataggio delle condizioni di taglio

Per risparmiare il tempo necessario a impostare le condizioni di taglio per ogni cambio di materiale, è pos-
sibile salvare in memoria le condizioni di taglio dei materiali utilizzati più di frequente. La volta successiva
che si utilizza lo stesso materiale, è possibile modificare le impostazioni con quelle adatte al materiale
semplicemente caricando la memoria salvata.

Nelle memorie da USER 1 a USER 8 è possibile salvare otto serie di impostazioni. La sovrascrittura di una
memoria cancella tutte le vecchie condizioni di taglio in essa contenute.

Procedura

1. Premere più volte [MENU] per visualizzare la seguente schermata.

CONDITION

Quando il materiale è stato caricato, premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

MEMO

2. Premere più volte [▼] per visualizzare la seguente schermata.

MEMORY
<USER1>

3. Premere [▶], [▼], quindi [▶].

SAVE USER1
50-20-0.250

Il display mostra i valori dei menu "FORZA", "VEL." e "OFFSET" da sinistra a destra.

4. Premere [▲][▼] per selezionare il numero di memoria in cui si desidera salvare le condizioni di taglio.

5. Premere [ENTER].

Viene visualizzata la schermata mostrata di seguito.

SAVE USER2

6. Premere [MENU] per tornare alla schermata originale.

Salvataggio delle condizioni di taglio utilizzate di
frequente
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Sebbene non vengano visualizzate sul display, vengono salvate anche l’UPSPEED (la velocità con cui la lama si
muove quando non taglia) e la qualità del taglio.

MEMO

Salvataggio delle condizioni di taglio utilizzate di frequente

234  Ottimizzazione dell’efficienza del lavoro



Caricamento delle condizioni di taglio

Selezionare una memoria salvata e applicarla al pannello comandi.

È possibile selezionare una memoria da USER 1 a USER 8. Si noti che il caricamento delle condizioni di ta-
glio dalla memoria cancella le condizioni di taglio non salvate.

Procedura

1. Premere più volte [MENU] per visualizzare la seguente schermata.

CONDITION

Quando il materiale è stato caricato, premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

MEMO

2. Premere più volte [▼] per visualizzare la seguente schermata.

MEMORY
<USER1>

3. Premere [▶] due volte.

LOAD *USER1
50-20-0.250

4. Premere [▲][▼] per selezionare il numero di memoria che si desidera caricare.

5. Premere [ENTER] per eseguire l’operazione.

6. Premere [MENU] per tornare alla schermata originale.

Salvataggio delle condizioni di taglio utilizzate di frequente
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Il taglio perforato può essere utilizzato per tagliare materiale senza carta di supporto o per creare pieghe
sui dati di taglio.

L’area di taglio viene separata dopo il taglio per evitare che il materiale si inceppi.

 COLLEGAMENTI CORRELATI 

・  P. 27 Impostazione del materiale

・  P. 41 Preparativi per il taglio

・  P. 57 Impostazione delle condizioni di taglio

・  P. 67 Impostare le condizioni di stampa

Creazione di dati di taglio perforati con CutStudio

1. Creare dati di taglio perforati

Caricare preventivamente il materiale sulla macchina e preparare l’output di taglio.
P. 27Impostazione del materiale
P. 41Preparativi per il taglio

Procedura

1. Avviare CutStudio.

• Windows 11

a. Fare clic su [Start].

b. Fare clic su [Tutte le app]>[Roland CutStudio]>[CutStudio].

• Windows 10

Dal menu [Start], fare clic su [ Roland CutStudio]>[CutStudio].

• Windows 8.1

Nella parte inferiore sinistra della schermata [Start], fare clic su  per visualizzare la scher-
mata [App]. Fare clic su .

CutStudio si avvia.

2. Creare una forma.

Separare l’area di taglio in un secondo momento
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In questo esempio, viene creato il progetto mostrato nella figura seguente.

3. Fare clic su .

Viene impostato il taglio perforato e l’oggetto viene visualizzato in rosso.

Fare clic su [File]>[Preference] per visualizzare la finestra [Preference]. Consente di impostare il colore e la
visualizzazione delle linee perforate.

MEMO

Per annullare l’impostazione della linea perforata, utilizzare  per selezionare la forma per la quale si desi-

dera annullare il taglio perforato, quindi fare clic su . Una volta annullata l’impostazione della linea perfo-
rata, il colore della linea di taglio torna ad essere nero.

MEMO
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2. Impostazione delle condizioni di taglio perforato

Procedura

1. Fare clic su [File]>[Cutting Setup].

Viene visualizzata la finestra [Cutting Setup].

2. All’indirizzo [Name], in [Printer], selezionare [Roland DG GS2-24].

Il nome del modello è impostato.

3. Fare clic su [Change] sotto [Media Size].

Separare l’area di taglio in un secondo momento
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4. Fare clic su [Get from Machine].

Acquisire l’area tagliabile dalla macchina collegata e aggiornare [Width] e [Length] in [Cutting
Area].

Se viene visualizzato [The machine is not responding.], controllare le impostazioni della macchina e del com-
puter.

P. 302La macchina non funziona

MEMO

5. Fare clic su [OK].

Separare l’area di taglio in un secondo momento
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L’impostazione viene salvata e viene visualizzata la finestra [Cutting Setup].

6. Impostare le condizioni di taglio.

Normalmente, la casella di controllo [Use cutting conditions of machine] è selezionata.

Per modificare la condizione di taglio, deselezionare la casella di controllo [Use cutting conditions
of machine] e inserire i valori.

7. Deselezionare la casella di controllo [Use perforated cutting conditions of machine].

In questo modo è possibile inserire valori in [Perforated Cutting].

Separare l’area di taglio in un secondo momento
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8. Impostare [Perforation length], [Perforation Force], [Half-cut length], e [Half-cut Force] in [Perforated
Cutting].

• : Lunghezza perforazione

Lunghezza del pezzo ritagliato dal materiale

• : Lunghezza di metà taglio

Lunghezza del pezzo non ritagliato dal materiale con la forza soppressa della lama

Regolare la forza di perforazione o la forza dimezzata in base al tipo di materiale.

[Perforation length] ＞ [Half-cut
length]

[Perforation length] ＝ [Half-cut
length]

[Perforation length] ＜ [Half-cut
length]

Lunghezza perforazione: 20 mm Lunghezza perforazione: 20 mm Lunghezza perforazione: 1 mm

Lunghezza di metà taglio: 1 mm Lunghezza di metà taglio: 20 mm Lunghezza di metà taglio: 20 mm

9. Fare clic su [OK].

L’intervallo e le condizioni di taglio vengono salvati.

L’area visualizzata in bianco in CutStudio è l’intervallo di taglio. I caratteri e le forme al di fuori di quest’area
non verranno tagliati.

MEMO

 COLLEGAMENTI CORRELATI 

・  P. 201 Guida generale alle condizioni di taglio

・  P. 204 Impostazione della forza della lama

Separare l’area di taglio in un secondo momento
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・  P. 262 Impostazione delle condizioni di taglio perforato sulla macchina

Separare l’area di taglio in un secondo momento
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3. Taglio di linee perforate

Procedura

1. Verificare che il materiale sia stato caricato.

2. Fare clic su .

Viene visualizzata la finestra [Cut].

3. Selezionare il tipo di linee di taglio che si desidera produrre.

[All] Produce linee di taglio e linee di taglio perforate

[Cutlines only] Produce solo linee di taglio

[Perforated Cut Lines only] Produce solo linee di taglio perforate

4. Fare clic su [OK].

Il taglio inizia.

5. Controllare il risultato del taglio.

Regolare le condizioni di taglio a seconda della necessità.

 COLLEGAMENTI CORRELATI 

・  P. 238 Impostazione delle condizioni di taglio perforato

・  P. 202 Regolazione dell’impostazione del taglio

Separare l’area di taglio in un secondo momento
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Creazione di dati di taglio perforati con Adobe Illustrator

1. Creare dati di taglio perforati

Caricare preventivamente il materiale sulla macchina e preparare l’output di taglio.
P. 27Impostazione del materiale
P. 41Preparativi per il taglio

Questa sezione mostra un esempio di creazione di dati di taglio perforati utilizzando Adobe Illustrator
2020. La procedura operativa è la stessa per le altre versioni.

Procedura

1. Creare un nuovo documento e disegnare una nuova forma o aprire un file esistente.

In questo esempio, viene creato il progetto mostrato nella figura seguente.

2. Fare clic su [Window]>[Extensions]>[Roland CutStudio].

Viene visualizzata la tavolozza [Roland CutStudio].

Separare l’area di taglio in un secondo momento
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3. Selezionare un oggetto a cui applicare il taglio perforato.

4. Fare clic su .

Separare l’area di taglio in un secondo momento
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5. Selezionare [Output Perforated Cut Lines Only].

6. Nella tavolozza, fare clic su [Update].

Verificare che la linea di taglio che si desidera produrre venga visualizzata nella schermata di ante-
prima.

7. Fare clic su .

CutStudio si avvia e i dati di taglio vengono inviati a CutStudio. I dati di taglio in uscita sono sem-
pre allineati all’origine di CutStudio, indipendentemente dalla posizione in Adobe Illustrator (ad
eccezione dei dati dei crocini di registro).

Separare l’area di taglio in un secondo momento
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2. Impostazione delle condizioni di taglio perforato

Procedura

1. Fare clic su [File]>[Cutting Setup].

Viene visualizzata la finestra [Cutting Setup].

2. All’indirizzo [Name], in [Printer], selezionare [Roland DG GS2-24].

Il nome del modello è impostato.

3. Fare clic su [Change] sotto [Media Size].

Separare l’area di taglio in un secondo momento
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4. Fare clic su [Get from Machine].

Acquisire l’area tagliabile dalla macchina collegata e aggiornare [Width] e [Length] in [Cutting
Area].

Se viene visualizzato [The machine is not responding.], controllare le impostazioni della macchina e del com-
puter.

P. 302La macchina non funziona

MEMO

5. Fare clic su [OK].

Separare l’area di taglio in un secondo momento
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L’impostazione viene salvata e viene visualizzata la finestra [Cutting Setup].

6. Impostare le condizioni di taglio.

Normalmente, la casella di controllo [Use cutting conditions of machine] è selezionata.

Per modificare la condizione di taglio, deselezionare la casella di controllo [Use cutting conditions
of machine] e inserire i valori.

7. Deselezionare la casella di controllo [Use perforated cutting conditions of machine].

In questo modo è possibile inserire valori in [Perforated Cutting].

Separare l’area di taglio in un secondo momento

Ottimizzazione dell’efficienza del lavoro 249



8. Impostare [Perforation length], [Perforation Force], [Half-cut length], e [Half-cut Force] in [Perforated
Cutting].

• : Lunghezza perforazione

Lunghezza del pezzo ritagliato dal materiale

• : Lunghezza di metà taglio

Lunghezza del pezzo non ritagliato dal materiale con la forza soppressa della lama

Regolare la forza di perforazione o la forza dimezzata in base al tipo di materiale.

[Perforation length] ＞ [Half-cut
length]

[Perforation length] ＝ [Half-cut
length]

[Perforation length] ＜ [Half-cut
length]

Lunghezza perforazione: 20 mm Lunghezza perforazione: 20 mm Lunghezza perforazione: 1 mm

Lunghezza di metà taglio: 1 mm Lunghezza di metà taglio: 20 mm Lunghezza di metà taglio: 20 mm

9. Fare clic su [OK].

L’intervallo e le condizioni di taglio vengono salvati.

L’area visualizzata in bianco in CutStudio è l’intervallo di taglio. I caratteri e le forme al di fuori di quest’area
non verranno tagliati.

MEMO

 COLLEGAMENTI CORRELATI 

・  P. 201 Guida generale alle condizioni di taglio

・  P. 204 Impostazione della forza della lama

Separare l’area di taglio in un secondo momento
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・  P. 262 Impostazione delle condizioni di taglio perforato sulla macchina

Separare l’area di taglio in un secondo momento
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3. Taglio di linee perforate

Procedura

1. Verificare che il materiale sia stato caricato.

2. Fare clic su .

Viene visualizzata la finestra [Cut].

3. Selezionare il tipo di linee di taglio che si desidera produrre.

[All] Produce linee di taglio e linee di taglio perforate

[Cutlines only] Produce solo linee di taglio

[Perforated Cut Lines only] Produce solo linee di taglio perforate

4. Fare clic su [OK].

Il taglio inizia.

5. Controllare il risultato del taglio.

Regolare le condizioni di taglio a seconda della necessità.

 COLLEGAMENTI CORRELATI 

・  P. 238 Impostazione delle condizioni di taglio perforato

・  P. 202 Regolazione dell’impostazione del taglio

Separare l’area di taglio in un secondo momento
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Creazione di dati di taglio perforati con CorelDRAW

1. Creare dati di taglio perforati

Caricare preventivamente il materiale sulla macchina e preparare l’output di taglio.
P. 27Impostazione del materiale
P. 41Preparativi per il taglio

Questa sezione spiega come creare i dati di taglio per il taglio perforato con CorelDRAW 2020. La procedu-
ra operativa è la stessa per le altre versioni.

Procedura

1. Creare un nuovo documento e disegnare una nuova forma o aprire un file esistente.

In questo esempio, viene creato il progetto mostrato nella figura seguente.

2. Nella barra degli strumenti, fare clic su .

Viene visualizzata la tavolozza [Roland CutStudio].

Separare l’area di taglio in un secondo momento
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3. Selezionare un oggetto a cui applicare il taglio perforato.

4. Fare clic su .

5. Selezionare [Output Perforated Cut Lines Only].

6. Fare clic su [Update].

Verificare che la linea di taglio che si desidera produrre venga visualizzata nella schermata di ante-
prima.

7. Fare clic su .

Separare l’area di taglio in un secondo momento
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CutStudio si avvia e i dati di taglio vengono inviati a CutStudio. I dati di taglio in uscita sono sem-
pre allineati all’origine di CutStudio, indipendentemente dalla posizione in CorelDRAW (ad eccezio-
ne dei dati dei crocini di registro).

Separare l’area di taglio in un secondo momento
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2. Impostazione delle condizioni di taglio perforato

Procedura

1. Fare clic su [File]>[Cutting Setup].

Viene visualizzata la finestra [Cutting Setup].

2. All’indirizzo [Name], in [Printer], selezionare [Roland DG GS2-24].

Il nome del modello è impostato.

3. Fare clic su [Change] sotto [Media Size].

Separare l’area di taglio in un secondo momento
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4. Fare clic su [Get from Machine].

Acquisire l’area tagliabile dalla macchina collegata e aggiornare [Width] e [Length] in [Cutting
Area].

Se viene visualizzato [The machine is not responding.], controllare le impostazioni della macchina e del com-
puter.

P. 302La macchina non funziona

MEMO

5. Fare clic su [OK].

Separare l’area di taglio in un secondo momento
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L’impostazione viene salvata e viene visualizzata la finestra [Cutting Setup].

6. Impostare le condizioni di taglio.

Normalmente, la casella di controllo [Use cutting conditions of machine] è selezionata.

Per modificare la condizione di taglio, deselezionare la casella di controllo [Use cutting conditions
of machine] e inserire i valori.

7. Deselezionare la casella di controllo [Use perforated cutting conditions of machine].

In questo modo è possibile inserire valori in [Perforated Cutting].

Separare l’area di taglio in un secondo momento
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8. Impostare [Perforation length], [Perforation Force], [Half-cut length], e [Half-cut Force] in [Perforated
Cutting].

• : Lunghezza perforazione

Lunghezza del pezzo ritagliato dal materiale

• : Lunghezza di metà taglio

Lunghezza del pezzo non ritagliato dal materiale con la forza soppressa della lama

Regolare la forza di perforazione o la forza dimezzata in base al tipo di materiale.

[Perforation length] ＞ [Half-cut
length]

[Perforation length] ＝ [Half-cut
length]

[Perforation length] ＜ [Half-cut
length]

Lunghezza perforazione: 20 mm Lunghezza perforazione: 20 mm Lunghezza perforazione: 1 mm

Lunghezza di metà taglio: 1 mm Lunghezza di metà taglio: 20 mm Lunghezza di metà taglio: 20 mm

9. Fare clic su [OK].

L’intervallo e le condizioni di taglio vengono salvati.

L’area visualizzata in bianco in CutStudio è l’intervallo di taglio. I caratteri e le forme al di fuori di quest’area
non verranno tagliati.

MEMO

 COLLEGAMENTI CORRELATI 

・  P. 201 Guida generale alle condizioni di taglio

・  P. 204 Impostazione della forza della lama

Separare l’area di taglio in un secondo momento
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・  P. 262 Impostazione delle condizioni di taglio perforato sulla macchina

Separare l’area di taglio in un secondo momento
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3. Taglio di linee perforate

Procedura

1. Verificare che il materiale sia stato caricato.

2. Fare clic su .

Viene visualizzata la finestra [Cut].

3. Selezionare il tipo di linee di taglio che si desidera produrre.

[All] Produce linee di taglio e linee di taglio perforate

[Cutlines only] Produce solo linee di taglio

[Perforated Cut Lines only] Produce solo linee di taglio perforate

4. Fare clic su [OK].

Il taglio inizia.

5. Controllare il risultato del taglio.

Regolare le condizioni di taglio a seconda della necessità.

 COLLEGAMENTI CORRELATI 

・  P. 238 Impostazione delle condizioni di taglio perforato

・  P. 202 Regolazione dell’impostazione del taglio

Separare l’area di taglio in un secondo momento
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Impostazione delle condizioni di taglio perforato sulla macchina

Impostare le condizioni di taglio perforato sul pannello comandi della macchina. In questo esempio, vengo-
no impostati "MEZZA LUNGH.", "MEZZA FORZA" e "LUNGH. TAGLIO".

• : "LUNGH. TAGLIO"

Lunghezza del pezzo ritagliato dal materiale

• : "MEZZA LUNGH."

Lunghezza del pezzo non ritagliato dal materiale con la forza soppressa della lama

Regolare "MEZZA FORZA" in base al tipo di materiale.

"LUNGH. TAGLIO" ＞ "MEZZA LUNGH." "LUNGH. TAGLIO" ＝ "MEZZA LUNGH." "LUNGH. TAGLIO" ＜ "MEZZA LUNGH."

Lunghezza di taglio: 20 mm Lunghezza di taglio: 20 mm Lunghezza di taglio: 1 mm

Lunghezza di metà taglio: 1 mm Lunghezza di metà taglio: 20 mm Lunghezza di metà taglio: 20 mm

Procedura

1. Premere più volte [MENU] per visualizzare la seguente schermata.

CONDITION

Quando il materiale è stato caricato, premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

MEMO

2. Premere più volte [▼] per visualizzare la seguente schermata.

OTHERS

3. Premere [▶].

Separare l’area di taglio in un secondo momento
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4. Premere [▲][▼] per visualizzare la seguente schermata.

PERFORATE OFF

5. Premere [▶].

6. Premere [▲] o [▼] per selezionare "ON".

7. Premere [ENTER] per selezionare l’impostazione.

8. Premere [▶] due volte per visualizzare la schermata mostrata di seguito.

Impostare la lunghezza mezzo-taglio.

HALF LEN.  0.5

(1) Premere [▶].

(2) Premere [▲] o [▼] per selezionare un valore.

HALF LEN.  0.5
* 0.5mm

(3) Premere [ENTER] per selezionare l’impostazione.

9. Premere [▼] per visualizzare la seguente schermata.

Impostare la forza mezzo-taglio.

HALF FORCE  5

(1) Premere [▶].

(2) Premere [▲] o [▼] per selezionare un valore.

HALF FORCE  5
* 5gf

(3) Premere [ENTER] per selezionare l’impostazione.

10. Premere [▼] per visualizzare la seguente schermata.

Impostare la lunghezza di taglio.

CUT LEN. 15.5

(1) Premere [▶].

(2) Premere [▲] o [▼] per selezionare un valore.

CUT LEN. 15.5
  15.5mm

(3) Premere [ENTER] per selezionare l’impostazione.

11. Premere [MENU] per tornare alla schermata originale.

 COLLEGAMENTI CORRELATI 

・  P. 201 Guida generale alle condizioni di taglio

Separare l’area di taglio in un secondo momento
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Panoramica della stampa a sezioni

Quando i dati sono più grandi dell’intervallo di taglio, vengono divisi in più parti di materiale da produrre.

La stampa a sezioni non è disponibile per i dati di stampa e taglio.

IMPORTANTE

Funzione di margine interno

Per evitare spazi vuoti quando si collegano diversi pezzi di materiale, il bordo di ogni pezzo della stampa a
sezioni può avere un’area di taglio aggiuntiva. La parte in più che viene tagliata è chiamata margine inter-
no ( ). È possibile impostare liberamente il margine interno.

• Senza margine interno: Spazio tra i bordi quando i pezzi sono collegati

• Con margine interno: Nessuno spazio tra i bordi quando i pezzi sono collegati

Dividere i dati di taglio ed esportarli su più pezzi
di materiale
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Passo 1: Decidere quanti pezzi suddividere (pannelli)

Per l’output dei dati di taglio divisi (a sezioni), è utile immaginare in anticipo le dimensioni completate.

Questa sezione spiega il caso del taglio di dati di grandi dimensioni, come mostrato di seguito.

550 mm

1.000 mm

1.000 mm

Procedura

1. Determinare la dimensione di output dei dati.

1.000 mm

1.000 mm

2. Controllare le dimensioni del materiale e decidere quanti pezzi utilizzare.

In questo esempio, i dati vengono emessi dividendoli in 2 parti (verticali) x 2 (orizzontali). Assicu-
rarsi che la dimensione del materiale combinato sia maggiore della dimensione dei dati in uscita.

550 mm

550 mm

Dividere i dati di taglio ed esportarli su più pezzi di materiale
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Passo 2: Impostare le condizioni di stampa a sezioni

Impostare l’abilitazione o la disabilitazione della stampa a sezioni e dei margini interni.

Caricare preventivamente il materiale sulla macchina e preparare l’output di taglio.
P. 27Impostazione del materiale
P. 41Preparativi per il taglio

Procedura

1. Avviare CutStudio.

2. Fare clic su [File]>[Tiling].

Viene visualizzata la finestra [Tiling].

3. Fare clic su [Change Size].

Dividere i dati di taglio ed esportarli su più pezzi di materiale
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4. Fare clic su [Get from Machine].

L’intervallo di taglio viene acquisito dalla macchina collegata e i valori vengono inseriti automati-
camente.

5. Dopo l’inserimento automatico dei valori, fare clic su [OK].

La dimensione del segmento viene aggiornata.

Dividere i dati di taglio ed esportarli su più pezzi di materiale
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6. Selezionare la casella di controllo [Tiled Output], quindi inserire il numero di pannelli.

7. Impostare i margini interni.

Se si inserisce [Inner Margin], [Overall Size] viene aggiornato automaticamente. Assicurarsi che
[Overall Size] sia più grande della dimensione di output.

8. Fare clic su [OK].

Dividere i dati di taglio ed esportarli su più pezzi di materiale
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Il documento viene visualizzato. I bordi dei segmenti vengono visualizzati anche se non è stato im-
postato un margine interno.

 COLLEGAMENTI CORRELATI 

・  P. 264 Panoramica della stampa a sezioni

・  P. 265 Decidere quanti pezzi suddividere (pannelli)

Dividere i dati di taglio ed esportarli su più pezzi di materiale
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Passo 3: Creazione dei dati di taglio

Creare i dati di taglio e controllare l’ordine dell’output e le condizioni di taglio nell’anteprima.

Procedura

1. Inserire il testo e/o le forme desiderate.

In questo esempio, vengono inseriti i dati mostrati nella figura seguente.

2. Fare clic su [File]>[Cutting Preview].

Dividere i dati di taglio ed esportarli su più pezzi di materiale
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Facendo clic su [Next Page], vengono visualizzate le anteprime nell’ordine di taglio.

Dividere i dati di taglio ed esportarli su più pezzi di materiale
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Ordine di taglio

3. Controllare i dati di taglio e chiudere l’anteprima.

Dividere i dati di taglio ed esportarli su più pezzi di materiale
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Passo 4: Taglio

Avviare il taglio pannellizzato.

Procedura

1. Verificare che il materiale sia stato caricato.

2. Fare clic su .

Viene visualizzata la finestra [DivCut Page].

3. Fare clic su [OK].

Viene visualizzata la finestra [Cut].

4. Fare clic su [OK].

Dividere i dati di taglio ed esportarli su più pezzi di materiale
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Il taglio inizia.

Al termine del taglio, viene visualizzata una schermata con un messaggio.

Quando si utilizza un materiale piatto, caricare un nuovo materiale piatto.

MEMO

5. Fare clic su [OK].

Dividere i dati di taglio ed esportarli su più pezzi di materiale
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6. Ripetere i passaggi 4 e 5.

Produce il numero di pannelli impostato.

7. Combinare il materiale in uscita.

Allineare i margini per completare la procedura.

Dividere i dati di taglio ed esportarli su più pezzi di materiale
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Ottimizzazione della gestio-
ne delle operazioni

Gestione delle impostazioni di base della macchina............................................ 277
Modifica della lingua del display............................................................. 277
Modifica dell’unità di misura della lunghezza da visualizzare .......................... 277
Regolazione della luminosità del display ................................................... 279
Ripristino delle impostazioni predefinite................................................... 280
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Modifica della lingua del display

Procedura

1. Quando la macchina è accesa, tenere premuto il pulsante di accensione per almeno 1 secondo per spe-
gnerla.

2. Tenere premuto [MENU] e premere il pulsante di accensione.

Viene visualizzata la schermata mostrata di seguito.

LANG. ENGLISH
*ENGLISH

3. Premere [▼] per selezionare la lingua da visualizzare sul display.

LANG  ENGLISH
にほんこﾞ

4. Premere [ENTER] per selezionare l’impostazione.

Modifica dell’unità di misura della lunghezza da visualizzare

Modificare l’unità di misura utilizzata per la visualizzazione.

Procedura

1. Premere più volte [MENU] per visualizzare la seguente schermata.

CONDITION

Quando il materiale è stato caricato, premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

MEMO

2. Premere più volte [▼] per visualizzare la seguente schermata.

OTHERS

3. Premere [▶], [▼], quindi [▶].

Gestione delle impostazioni di base della mac-
china
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UNIT mm
*mm

4. Selezionare l’unità con [▲][▼].

È possibile selezionare millimetri o pollici.

5. Premere [ENTER] per selezionare l’impostazione.

6. Premere [MENU] per tornare alla schermata originale.

Gestione delle impostazioni di base della macchina
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Regolazione della luminosità del display

Procedura

1. Premere più volte [MENU] per visualizzare la seguente schermata.

CONDITION

Quando il materiale è stato caricato, premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

MEMO

2. Premere più volte [▼] per visualizzare la seguente schermata.

OTHERS

3. Premere [▶].

4. Premere più volte [▼] per visualizzare la seguente schermata.

CONTRAST 5

5. Premere [▶].

6. Premere [▲][▼] per selezionare la luminosità dello schermo.

CONTRAST 5
*5

• Campo di impostazione: Da 1 a 5

7. Premere [ENTER] per selezionare l’impostazione.

8. Premere [MENU] per tornare alla schermata originale.

Gestione delle impostazioni di base della macchina
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Ripristino delle impostazioni predefinite

Questa procedura riporta tutte le impostazioni ai relativi valori di fabbrica.

Questa operazione ripristina tutte le impostazioni predefinite, cancellando tutte le modifiche apportate fino a quel mo-
mento. Annotare tutte le informazioni necessarie, come ad esempio le condizioni di taglio.
Tuttavia, l’impostazione della lingua rimane invariata.

MEMO

Procedura

1. Premere più volte [MENU] per visualizzare la seguente schermata.

CONDITION

Quando il materiale è stato caricato, premere più volte [MENU] per visualizzare la seguente schermata.

UNSETUP

MEMO

2. Premere più volte [▼] per visualizzare la seguente schermata.

OTHERS

3. Premere [▶].

4. Premere più volte [▼] per visualizzare la seguente schermata.

FACTORYDEFAULT
*PRESET

5. Premere [▶] per visualizzare la seguente schermata.

FACTORYDEFAULT
*PRESET

6. Premere [ENTER] per eseguire l’operazione.

Viene nuovamente visualizzata la schermata mostrata di seguito.

SELECT SHEET
ROLL

Gestione delle impostazioni di base della macchina
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Manutenzione
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La pulizia è importante per garantire un taglio pulito. Pulire periodicamente la macchina.

Assicurarsi di eseguire le operazioni come specificato nelle precedenti istruzioni e di non toccare
mai un’area non specificata nelle istruzioni.
Un movimento improvviso della macchina può causare lesioni o ustioni.

AVVERTENZA

Non utilizzare mai solventi come benzina, alcool o diluenti per eseguire la pulizia.
Questo può provocare un incendio.

AVVERTENZA

Pulizia della macchina

Pulire eventuali impurità con un panno inumidito con acqua e ben strizzato.

Prima di procedere alla pulizia, spegnere l’alimentazione.

IMPORTANTE

Prima della pulizia, abbassare la leva di caricamento.

IMPORTANTE

Pulizia
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Rullo di schiacciamento Tenere il rullo con la mano in modo che non giri e pulire la parte in gomma del rul-
lo di trazione da impurità e residui di materiale. Quindi, pulire con un panno
asciutto.

Display Pulire con un panno asciutto.

Rullo di trasferimento Dopo aver sollevato tutti i rulli di trazione, ruotare il rullo di trasferimento utiliz-
zando una spazzola. Utilizzare *1 per rimuovere la polvere dalla superficie.

 

*1 Non utilizzare spazzole metalliche.
 

Pulizia
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Pulizia del cappuccio del porta lama

Quando un porta lama viene utilizzato a lungo, il cuscinetto che sostiene la lama si deteriora, rendendone
più difficile la rotazione. Se si continua a utilizzare il porta lama in questo modo, la macchina non taglierà
in modo pulito perché la punta della lama non girerà in modo fluido.

Se si verifica una delle seguenti condizioni, pulire il cappuccio del porta lama.

• Gli angoli e le curve non sono puliti

• Le linee di taglio sono perforate

Non toccare mai la punta della lama.
La mancata osservanza di questa precauzione può provocare lesioni. Anche le prestazioni di taglio della lama verranno
compromesse.

ATTENZIONE

Allentare il cappuccio per rimuoverlo e rimuovere eventuali accumuli di materiale o polvere all’interno
dello stesso.

Se la pulizia non migliora le condizioni, sostituire il porta lama con uno nuovo.

MEMO

Pulizia
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 COLLEGAMENTI CORRELATI 

・  P. 287 Sostituzione della lama

Pulizia

286  Pulizia e consumabili



Per acquistare i consumabili, visitare il sito web di DGSHAPE Corporation o contattare il rivenditore auto-
rizzato DGSHAPE Corporation.

 COLLEGAMENTI CORRELATI 

・ https://www.rolanddg.co.jp/

Lama

Lama

Nei seguenti casi, la lama ha raggiunto la fine della sua vita utile. Sostituirla con una nuova.

• La punta della lama è rotta.

• Rimangono aree non tagliate anche se la forza della lama è stata aumentata a 50-60 gf.

• I tagli non sono più puliti come prima

• Il materiale inizia ad arricciarsi dalla carta di supporto quando si tagliano aree dettagliate o angoli

La punta di una lama utilizzata a lungo o per tagliare materiali duri può consumarsi. Una lama consumata
non taglia più in modo pulito, quindi sostituirla con una nuova.

 COLLEGAMENTI CORRELATI 

・  P. 287 Sostituzione della lama

Sostituzione della lama

Se la lama si smussa, sostituirla con la lama di ricambio in dotazione.

Assicurarsi di eseguire le operazioni come specificato nelle precedenti istruzioni e di non toccare
mai un’area non specificata nelle istruzioni.
Un movimento improvviso della macchina può causare lesioni o ustioni.

AVVERTENZA

Non toccare mai la punta della lama.
La mancata osservanza di questa precauzione può provocare lesioni. Anche le prestazioni di taglio della lama verranno
compromesse.

ATTENZIONE

Procedura

1. Rimuovere il materiale caricato nella macchina.

Consumabili
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2. Staccare il materiale della lama.

3. Sostituzione della lama.

(1) Premere il perno per spingere fuori la vecchia lama.

(2) Inserire una nuova lama.

4. Installare il sostegno della lama nel carrello di taglio.

5. Assicurarsi che la vite sia serrata.

 COLLEGAMENTI CORRELATI 

・  P. 174 Rimozione del materiale

・  P. 202 Regolazione del volume di taglio

Consumabili
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Porta lama

Porta lama

Se il taglio viene eseguito con la punta della lama regolata, la calotta del porta lama e il materiale sfrega-
no l’uno contro l’altro, consumando gradualmente la punta della calotta.Una forte usura impedisce la cor-
retta regolazione della punta della lama, ostacolando un taglio pulito. In questo caso, sostituire il porta
lama con uno nuovo.

 COLLEGAMENTI CORRELATI 

・  P. 285 Pulizia del cappuccio del porta lama

Protezione lama

Protezione lama

Se il taglio viene eseguito con la quantità di estensione della lama o con la forza della lama non regolate
in modo appropriato, la punta della lama potrebbe perforare la carta di supporto del materiale e graffiare
la protezione della lama. Se l’operazione di taglio viene eseguita con la protezione della lama graffiata, i
tagli effettuati potrebbero non risultare puliti.

Nei casi seguenti, sostituire la protezione della lama.

• La superficie della protezione della lama è deformata a causa di graffi o danni simili.

• Si è deteriorata al punto da rompersi e cadere

 COLLEGAMENTI CORRELATI 

・ https://www.rolanddg.co.jp/
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 COLLEGAMENTI CORRELATI 

・  P. 223 Regolazione della posizione di taglio

・  P. 225 Regolazione della posizione di stampa

Viene utilizzato un materiale spesso?

Se si utilizza un materiale spesso, impostare "QUALITA" su "PESANTE".

 COLLEGAMENTI CORRELATI 

・  P. 206 Regolazione della velocità di taglio

La macchina è impostata in modo da far avanzare una certa quantità di mate-
riale prima del taglio?

Quando si utilizza materiale bobinato o materiale piatto di lunghezza superiore a 1,6 m, se si esegue il
taglio senza che la lunghezza del materiale richiesta per i dati di taglio venga fatta avanzare, il materiale
potrebbe scivolare o il funzionamento potrebbe arrestarsi a causa di un errore del motore.

Impostare la macchina in modo che la quantità necessaria di materiale venga fatta avanzare prima del ta-
glio.

 COLLEGAMENTI CORRELATI 

・  P. 40 Controllare l’alimentazione del materiale

La stampa e il taglio sono disallineati
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La lama e il porta lama sono installati in modo sicuro?

Assicurarsi che le viti siano ben serrate in modo da non allentarsi durante il taglio.

 COLLEGAMENTI CORRELATI 

・  P. 287 Sostituzione della lama

La punta della lama è rotta?

In tal caso, sostituire la lama con una nuova.

 COLLEGAMENTI CORRELATI 

・  P. 287 Sostituzione della lama

Ci sono accumuli di polvere o materiale adesivo sulla punta della lama?

Rimuovere e pulire la lama.

 COLLEGAMENTI CORRELATI 

・  P. 287 Sostituzione della lama

C’è un accumulo di pezzi di materiale o di polvere all’interno del supporto
della lama?

Togliere la punta del porta lama e rimuovere eventuali pezzi di materiale o polvere all’interno.

 COLLEGAMENTI CORRELATI 

・  P. 285 Pulizia del cappuccio del porta lama

Viene utilizzato un materiale spesso?

Se si utilizza un materiale spesso, impostare "QUALITA" su "PESANTE".

 COLLEGAMENTI CORRELATI 

・  P. 206 Regolazione della velocità di taglio

La forza della lama e la velocità di taglio sono adeguate?

Eseguire prove di taglio e regolare le impostazioni fino a quando il taglio può essere eseguito in modo ade-
guato.

 COLLEGAMENTI CORRELATI 

Rimangono aree non tagliate o i bordi non sono
tagliati in modo netto
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・  P. 204 Impostazione della forza della lama

・  P. 213 Impostazione della velocità della lama durante il taglio

・  P. 45 Eseguire un taglio di prova

L’offset della punta della lama è adeguato?

Se l’offset della punta della lama non è corretto, gli angoli potrebbero risultare curvi o convessi.

Impostare un valore appropriato per l’offset della punta della lama.

 COLLEGAMENTI CORRELATI 

・  P. 207 Impostazione dell’offset della punta della lama

La macchina è impostata in modo da far avanzare una certa quantità di mate-
riale prima del taglio?

Quando si utilizza materiale bobinato o materiale piatto di lunghezza superiore a 1,6 m, se si esegue il
taglio senza che la lunghezza del materiale richiesta per i dati di taglio venga fatta avanzare, il materiale
potrebbe scivolare o il funzionamento potrebbe arrestarsi a causa di un errore del motore.

Impostare la macchina in modo che la quantità necessaria di materiale venga fatta avanzare prima del ta-
glio.

 COLLEGAMENTI CORRELATI 

・  P. 40 Controllare l’alimentazione del materiale

"SMOOTHING" è stato impostato su "OFF"?

Per tagliare le curve in modo netto, impostare "SMOOTHING" su "ON".

 COLLEGAMENTI CORRELATI 

・  P. 214 Taglio liscio di archi e altre curve (lisciatura)

La protezione della lama è danneggiata o deformata?

Se la protezione della lama è danneggiata, il materiale potrebbe non essere tagliato correttamente anche
se le impostazioni della macchina e l’installazione della lama e del porta lama sono tutte corrette. In tal
caso, contattare il rivenditore Roland DG Corporation autorizzato.

 COLLEGAMENTI CORRELATI 

・  P. 289 Protezione lama

Rimangono aree non tagliate o i bordi non sono tagliati in modo netto
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La regolazione della punta della lama e la forza della lama sono adeguate al
materiale da tagliare?

Eseguire una prova di taglio e regolare adeguatamente la punta e la forza della lama.

 COLLEGAMENTI CORRELATI 

・  P. 201 Guida generale alle condizioni di taglio

・  P. 45 Eseguire un taglio di prova

・  P. 202 Regolazione del volume di taglio

La macchina taglia la carta di trasporto
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[Overlap Cutting] è impostato a [0] in CutStudio?

Se nella schermata [Cut], [Overlap Cutting] è impostato un numero diverso da [0], tale numero viene ag-
giunto al numero di tagli. Impostare [Overlap Cutting] a [0], oppure impostare [SOVRAPPOSIZ.] su [OFF]
sulla macchina.

 COLLEGAMENTI CORRELATI 

・  P. 81 Taglio

L’impostazione [OVERLAP] della macchina è un numero da 1 a 10?

Configurare l’impostazione "SOVRAPPOSIZ." della macchina su "OFF".

 COLLEGAMENTI CORRELATI 

・  P. 215 Taglio ripetuto nella stessa posizione (sovrapposizione)

Ci sono linee che si sovrappongono?

È possibile che siano stati copiati gli stessi dati, con conseguente sovrapposizione di linee. Controllare i
dati.

La macchina taglia due volte la stessa area
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Quando la macchina non riesce a leggere i crocini di registro, viene visualizzato il seguente messaggio di
errore e il funzionamento viene messo in pausa.

• "SET TO <TOOL MODE>"

• "LUNGHEZZA NG"

• "LARGHEZZA"

• "TROPPO RUOTATO"

In questo caso, premere un tasto qualsiasi del pannello comandi. Rimuovere il materiale, controllare i se-
guenti elementi e ricaricare il materiale.

Il materiale è caricato correttamente?

Assicurarsi che il materiale sia caricato e impostato correttamente.

 COLLEGAMENTI CORRELATI 

・  P. 27 Impostazione del materiale

Si sta utilizzando un materiale non bianco o lucido?

I crocini di registro non possono essere rilevati se sul materiale sono presenti decorazioni o colori. I crocini
di registro non possono essere rilevati neanche su materiale lucido, anche se bianco.

Preparare un materiale bianco, opaco (minimamente lucido) e ripetere il processo dalla fase di stampa.

 COLLEGAMENTI CORRELATI 

・  P. 15 Condizioni per i materiali utilizzabili

Si sta utilizzando un materiale trasparente?

I crocini di registro non possono essere rilevati su materiale trasparente. Cambiare il materiale utilizzato.

 COLLEGAMENTI CORRELATI 

・  P. 15 Condizioni per i materiali utilizzabili

Il materiale presenta pieghe o grinze?

I crocini di registro potrebbero non essere leggibili se il materiale presenta pieghe o grinze.

Eliminare le pieghe o le grinze e caricare nuovamente il materiale. Se i crocini di registro non vengono
ancora letti, preparare un nuovo materiale senza pieghe o grinze e ripetere l’operazione di stampa dei da-
ti.

I crocini di registro sono sfocati o sono di un colore diverso dal nero?

Impostare il colore dei crocini di registro sul nero, specificare una densità di stampa del 100% sulla stam-
pante e stampare nuovamente i dati.

Non vengono rilevati i crocini di registro
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 COLLEGAMENTI CORRELATI 

・  P. 17 Crocini di registro

Le dimensioni e la forma dei crocini di registro sono corrette?

La macchina è in grado di rilevare solo i crocini di registro con la forma prescritta.

Eseguire i crocini di registro come cerchi perfetti di 10 mm di diametro.

 COLLEGAMENTI CORRELATI 

・  P. 17 Crocini di registro

I crocini di registro sono nella posizione corretta?

Posizionare i crocini di registro nelle posizioni corrette.

 COLLEGAMENTI CORRELATI 

・  P. 343 Margini e distanza tra i crocini di registro

Il menu "ROT." è impostato a "90deg"?

Quando si utilizzano i crocini di registro, assicurarsi di impostare il menu "ROT." a "0deg". I crocini di regi-
stro non possono essere letti se l’impostazione è "90deg".

 COLLEGAMENTI CORRELATI 

・  P. 209 Impostare l’orientamento delle coordinate di taglio

La macchina è esposta alla luce diretta del sole o a una forte illuminazione in-
terna?

Se il sensore del carrello di taglio è esposto alla luce diretta del sole o all’illuminazione interna, i crocini
di registro potrebbero non essere rilevati.

Spostare la macchina in una posizione non esposta alla luce diretta del sole o all’illuminazione interna.

Se il problema non si risolve nemmeno dopo aver eseguito i passaggi descritti, eseguire l’allineamento con
"TOOL MODE".

 COLLEGAMENTI CORRELATI 

・  P. 179 Stampa e taglio in modalità Strumento

Il materiale è caricato e sistemato in modo corretto e sicuro? La stampa è stor-
ta?

I crocini non possono essere rilevati nei seguenti casi: Assicurarsi che il materiale sia caricato o stampato
con i crocini di registro dritti.

• I crocini di registro destro e sinistro sono inclinati di 5 gradi o più rispetto alla direzione di movimento
del carrello di taglio.

Non vengono rilevati i crocini di registro
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• I crocini di registro sono sfalsati di 20 mm nella direzione di avanzamento del materiale.

 COLLEGAMENTI CORRELATI 

・  P. 72 Caricare il materiale stampato

Le distanze tra i crocini di registro specificate dal software corrispondono a
quelle specificate sulla macchina? (modalità manuale)

Sulla macchina, impostare correttamente la distanza specificata dal software.

 COLLEGAMENTI CORRELATI 

・  P. 191 Impostazione del metodo di allineamento (modalità manuale)

La stampa viene ampliata o ridotta?

Se il formato viene espanso o ridotto durante la stampa, i crocini di registro non possono essere letti du-
rante il taglio.

Stampare i dati specificando un ingrandimento del 100%.

Non vengono rilevati i crocini di registro
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La leva di caricamento è abbassata?

Se lo è, significa che il materiale non è fissato in posizione. Controllare che i rulli di trazione si trovino
all’interno dei bordi del materiale e sollevare la leva di caricamento.

Il materiale è stato caricato parallelamente alle linee guida?

Utilizzare un materiale con i bordi destro e sinistro paralleli e allineare il bordo sinistro del materiale in
modo che sia parallelo alle linee guida.

 COLLEGAMENTI CORRELATI 

・  P. 27 Posizione di carico del materiale

Il materiale entra in contatto con ostacoli durante il taglio?

Assicurarsi che i bordi destro e sinistro del materiale non entrino in contatto con le superfici interne della
macchina durante il taglio. Questo contatto non solo danneggia il materiale, ma ostacola anche il normale
avanzamento del materiale e lo fa scivolare fuori posizione.

Il taglio è stato eseguito senza controllare l’avanzamento del materiale? (ma-
teriale in rotoli)

Se si inizia a tagliare senza controllare l’avanzamento del materiale, è possibile che non si ottengano risul-
tati di taglio corretti. Nel peggiore dei casi, potrebbero prodursi errori, malfunzionamenti o danni al mate-
riale.

 COLLEGAMENTI CORRELATI 

・  P. 40 Controllare l’alimentazione del materiale

I rulli di trazione vengono utilizzati per fissare entrambi i bordi del materiale?

Se i rulli di trazione non sono posizionati all’interno del raggio d’azione dei rulli di trasferimento, il mate-
riale non viene fissato, impedendo che venga alimentato correttamente.

Ricaricare il materiale.

 COLLEGAMENTI CORRELATI 

・  P. 27 Posizione di carico del materiale

Il materiale scivola dai rulli di pressione durante
il taglio
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I cavi sono collegati correttamente?

Verificare che il cavo di alimentazione, il cavo USB e il cavo Ethernet siano collegati correttamente.

Quando si collegano contemporaneamente un cavo USB e un cavo Ethernet, a volte la macchina non fun-
ziona. Collegare solo uno di questi cavi.

L’alimentazione è spenta?

Accendere la macchina.

 COLLEGAMENTI CORRELATI 

・  P. 20 Accensione

Il materiale è stato predisposto?

Mentre viene visualizzata la schermata mostrata di seguito, il taglio non è disponibile anche se i dati ven-
gono inviati.

Selezionare il materiale caricato e premere [ENTER] per completare l’impostazione.

SELECT SHEET
ROLL

 COLLEGAMENTI CORRELATI 

・  P. 27 Impostazione del materiale

Le impostazioni dell’applicazione software non sono corrette?

Selezionare il driver appropriato per la macchina. Per la procedura di selezione, consultare il manuale del
software applicativo.

La macchina non funziona
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Il pulsante di accensione è rimasto premuto per almeno 1 secondo?

Tenere premuto il pulsante di accensione per almeno 1 secondo per spegnere la macchina. Se l’alimenta-
zione non si spegne, scollegare l’adattatore AC dalla macchina.

Non è possibile spegnere l’alimentazione
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Il materiale alimentato è più lungo di 1,6 m?

Se il materiale piatto di lunghezza pari o superiore a 1,6 m viene impostato utilizzando "FOGLIO", la mac-
china lo riconosce come rotolo.

 COLLEGAMENTI CORRELATI 

・  P. 15 Tipi di materiali

Impossibile impostare il materiale di taglio con
"FOGLIO"
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Collegamento tramite cavo USB

È possibile collegare fino a cinque unità GS2-24 a un singolo computer. Quando si collegano più unità
GS2-24 tramite connessione USB, è necessario modificare il numero USB di ciascuna macchina in modo da
distinguere le destinazioni di uscita. L’impostazione predefinita della macchina è "A". Quando si collegano
due o più macchine, la seconda macchina e tutte le macchine successive devono essere configurate con
un’impostazione diversa da "A", in modo che la macchina possa distinguere la destinazione di uscita dei
dati.

Eseguire i procedure da 1 a 3 per impostare una connessione. La stessa procedura può essere utilizzata per
collegare una terza unità o una successiva.

Passo 1: Modifica del numero USB della macchina

Non collegare ancora la macchina al computer tramite il cavo USB. Queto potrebbe interferire con la corretta applica-
zione delle impostazioni.

IMPORTANTE

Procedura

1. Spegnere la macchina.

2. Premere contemporaneamente [TEST] e il pulsante di accensione.

Viene visualizzata la schermata mostrata di seguito.

USB NUMBER [A]
*A

3. Premere [▲] e [▼] per selezionare un’impostazione diversa da "A".

È possibile selezionare un valore compreso tra "B" ed "E". In questo esempio, è stato selezionato
"B".

4. Premere [ENTER].

5. Spegnere e riaccendere l’alimentazione.

Viene visualizzata la schermata mostrata di seguito. Verificare che venga visualizzata la lettera im-
postata alla procedura 3.

Roland GS2-24
[B]  Main:V***

Collegamento di più macchine a un computer
(Windows)
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Passo 2: Modifica delle impostazioni della stampante del computer

Procedura

1. Collegare la macchina al computer utilizzando il cavo USB.

Il driver è installato.

2. Apri [Devices And Printers].

• Windows 11

a. Fare clic su [Start]>[Tutte le app]>[Strumento Windows].

b. Fare doppio clic su [Contorol Panel].

c. Fare clic su [Dispositivi e stampanti].

• Windows 10

a. Fare clic [Start]>[Sistema Windows]>[Contorol Panel].

b. Fare clic su [Dispositivi e stampanti].

• Windows 8.1

a. Puntare sull’angolo inferiore destro dello schermo per visualizzare i simboli, quindi fare
clic su [Impostazioni].

b. Fare clic su [Contorol Panel].

c. Fare clic su [Hardware e suoni]>[Dispositivi e stampanti].

Viene creato [Roland DG GS2-24 (1)] (o [Roland DG GS2-24 (1 Copia)]).

3. Fare clic con il tasto destro su [Roland DG GS2-24 (1)] (o [Roland DG GS2-24 (1 Copia)], e selezionare
[Printer Properties].

4. Cambiare [Roland DG GS2-24 (1)] (o [Roland DG GS2-24 (1 Copia)]) con [Roland DG GS2-24 (B)].

5. Fare clic su [OK].

Collegamento di più macchine a un computer (Windows)
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Passo 3: Controllare che sia stata installata la seconda GS2-24

Procedura

1. Avviare CutStudio.

2. Fare clic su [File]>[Cutting Setup].

3. Fare clic sul [Printer Name].

Se viene indicato [Roland DG GS2-24 (B)], significa che la seconda macchina è collegata corretta-
mente.

Collegamento di più macchine a un computer (Windows)
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Collegamento tramite Ethernet

È possibile collegare fino a cinque unità GS2-24 a un singolo computer. Quando si collegano più macchine a
un computer tramite Ethernet, installare un driver quando si aggiunge ciascuna macchina.

Eseguire i procedure da 1 a 3 per impostare una connessione. La stessa procedura può essere utilizzata per
collegare una terza unità o una successiva.

Passo 1: Installazione del driver della macchina da aggiungere

Procedura

1. Collegare la macchina da aggiungere alla stessa LAN del computer mediante un cavo Ethernet.

2. Installare il driver sul computer.

Consultare "Installare il software con l’indirizzo IP impostato automaticamente" nel manuale "In-
stallazione e impostazioni iniziali Versione di Windows" (https://downloadcenter.rolanddg.com/
GS2-24) e installare il driver sul computer.

Collegamento di più macchine a un computer (Windows)
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Passo 2: Modifica delle impostazioni della stampante del computer

Procedura

1. Apri [Devices And Printers].

• Windows 11

a. Fare clic su [Start]>[Tutte le app]>[Strumento Windows].

b. Fare doppio clic su [Contorol Panel].

c. Fare clic su [Dispositivi e stampanti].

• Windows 10

a. Fare clic [Start]>[Sistema Windows]>[Contorol Panel].

b. Fare clic su [Dispositivi e stampanti].

• Windows 8.1

a. Puntare sull’angolo inferiore destro dello schermo per visualizzare i simboli, quindi fare
clic su [Impostazioni].

b. Fare clic su [Contorol Panel].

c. Fare clic su [Hardware e suoni]>[Dispositivi e stampanti].

Viene creato [Roland DG GS2-24 (1)] (o [Roland DG GS2-24 (1 Copia)]).

2. Fare clic con il tasto destro su [Roland DG GS2-24 (1)] (o [Roland DG GS2-24 (1 Copia)], e selezionare
[Printer Properties].

3. Cambiare [Roland DG GS2-24 (1)] (o [Roland DG GS2-24 (1 Copia)]) con [Roland DG GS2-24 (B)].

4. Fare clic su [OK].

Collegamento di più macchine a un computer (Windows)
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Passo 3: Controllare che sia stata installata la seconda GS2-24

Procedura

1. Avviare CutStudio.

2. Fare clic su [File]>[Cutting Setup].

3. Fare clic sul [Printer Name].

Se viene indicato [Roland DG GS2-24 (B)], significa che la seconda macchina è collegata corretta-
mente.

Collegamento di più macchine a un computer (Windows)
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Non è possibile collegare più macchine a un computer tramite USB.
Per collegare più macchine, passare da USB a Ethernet per la connessione tra il computer e ciascuna macchina.

MEMO

Collegamento tramite Ethernet (impostazione manuale dell’indirizzo IP)

Con un computer Macintosh, utilizzare un plug-in di Adobe Illustrator per l’invio alla macchina. Quando si
collegano più macchine a un computer, stabilire connessioni Ethernet tra il computer e ciascuna macchina.

Passo 1: Collegare i cavi LAN

Procedura

1. Avviare il computer.

2. Premere il pulsante di accensione per avviare la macchina da collegare.

3. Collegare la macchina e il computer con un cavo LAN.

Collegamento di più macchine a un computer
(Mac)
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Passo 2: Impostazione dell’indirizzo IP della macchina da collegare

Procedura

1. Determinare l’indirizzo IP della macchina.

Verificare l’indirizzo IP del computer per determinare l’indirizzo IP della macchina.

Se l’indirizzo IP del computer è 192.168.0.xxx

• Indirizzo IP della macchina: 192. 168. 0. yyy

Inserire un numero qualsiasi da 1 a 254 per [yyy]. Assicurarsi che siano diversi dai numeri di
altre apparecchiature di rete.

2. Se la macchina è spenta, premere il pulsante di accensione per avviare la macchina.

3. Premere [MENU] due volte per visualizzare la schermata mostrata di seguito.

CONDITION

4. Premere [▼] una volta per visualizzare la schermata mostrata di seguito.

SYSTEM INFO.

5. Premere [▶] una volta per visualizzare la schermata mostrata di seguito.

SYSTEM INFO.
MODEL

6. Premere [▼] tre volte per aprire la schermata mostrata di seguito.

SYSTEM INFO.
INTERFACE

7. Premere [▶] due volte per visualizzare la schermata mostrata di seguito.

NETWORK
DHCP ON

Collegamento di più macchine a un computer (Mac)
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8. Premere [▶], poi [▼] per impostare DHCP su OFF.

DHCP ON
 OFF

9. Premere [ENTER].

10. Premere [▼] una volta per visualizzare la schermata mostrata di seguito.

NETWORK
IP ADDRESS

11. Premere [▶] due volte.

a. Premere [▲] o [▼] per inserire l’indirizzo IP della macchina determinato alla procedura 1.

Premere [◀] o [▶] per spostare il cursore.

b. Premere [ENTER].

12. Premere [MENU] per tornare alla schermata originale.

13. Ripetere i procedure da 1 a 12 per impostare l’indirizzo IP della seconda macchina.

Collegamento di più macchine a un computer (Mac)
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Passo 3: Configurazione delle impostazioni di output del plug-in di Adobe Illu-
strator

Procedura

1. Avviare Adobe Illustrator.

2. Fare clic su [Window]>[Extensions]>[Roland CutStudio].

Viene visualizzata la tavolozza [Roland CutStudio].

3. Selezionare [GS2-24] dall’elenco [Model].

Collegamento di più macchine a un computer (Mac)
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4. Fare clic su , quindi selezionare [Connection].

5. Selezionare [IP], quindi inserire l’indirizzo IP determinato alla procedura 1 di [Passo 2: Impostazione del-
l’indirizzo IP della macchina da collegare].

Esempio:

Se l’indirizzo IP della macchina è [192.168.000.061], inserire [192.168.0.61].

6. Fare clic su [Verifica].

Se la connessione con la macchina viene stabilita correttamente, viene visualizzato [Success!].

Se viene visualizzato [Failed.], verificare se l’indirizzo IP è stato inserito correttamente.

7. Fare clic su [OK].

8. Ripetere i procedure da 4 a 7 per impostare il collegamento della seconda macchina.

È possibile cambiare la macchina che emetterà i dati inserendo l’indirizzo IP della macchina che emette verso
il plug-in Adobe Illustrator.

MEMO

Collegamento di più macchine a un computer (Mac)
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Connessione via Ethernet (impostazione automatica dell’indirizzo IP)

Con un computer Macintosh, utilizzare un plug-in di Adobe Illustrator per l’invio alla macchina. Quando si
collegano più macchine a un computer, stabilire connessioni Ethernet tra il computer e ciascuna macchina.

Passo 1: Collegare i cavi LAN

Procedura

1. Avviare il computer.

2. Premere il pulsante di accensione per avviare la macchina da collegare.

3. Collegare la macchina e il computer con un cavo LAN.

Collegamento di più macchine a un computer (Mac)
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Passo 2: Controllo delle impostazioni della macchina da collegare

Procedura

1. Se la macchina è spenta, premere il pulsante di accensione per avviare la macchina.

2. Premere [MENU] due volte per visualizzare la schermata mostrata di seguito.

CONDITION

3. Premere [▼] una volta per visualizzare la schermata mostrata di seguito.

SYSTEM INFO.

4. Premere [▶] una volta per visualizzare la schermata mostrata di seguito.

SYSTEM INFO.
MODEL

5. Premere [▼] tre volte per aprire la schermata mostrata di seguito.

SYSTEM INFO.
INTERFACE

6. Premere [▶] due volte per visualizzare la schermata mostrata di seguito.

NETWORK
DHCP ON

Se il DHCP è impostato su OFF, premere [▶], quindi [▼] per impostare il DHCP su ON, dopodiché
premere [ENTER].

7. Premere [▼] una volta per visualizzare la schermata mostrata di seguito.

NETWORK
IP ADDRESS

Collegamento di più macchine a un computer (Mac)
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8. Premere [▶] una volta.

9. Prendere nota dell’indirizzo IP visualizzato.

10. Premere [MENU] per tornare alla schermata originale.

11. Ripetere i procedure da 1 a 10 per controllare le impostazioni della seconda macchina.

Collegamento di più macchine a un computer (Mac)
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Passo 3: Configurazione delle impostazioni di output del plug-in di Adobe Illu-
strator

Procedura

1. Avviare Adobe Illustrator.

2. Fare clic su [Window]>[Extensions]>[Roland CutStudio].

Viene visualizzata la tavolozza [Roland CutStudio].

3. Selezionare [GS2-24] dall’elenco [Model].

Collegamento di più macchine a un computer (Mac)
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4. Fare clic su , quindi selezionare [Connection].

5. Selezionare [IP], quindi inserire l’indirizzo IP annotato alla procedura 9 di [Passo 2: Controllo delle impo-
stazioni della macchina da collegare].

Esempio:

Se l’indirizzo IP della macchina è [192.168.000.061], inserire [192.168.0.61].

6. Fare clic su [Verifica].

Se la connessione con la macchina viene stabilita correttamente, viene visualizzato [Success!].

Se viene visualizzato [Failed.], verificare se l’indirizzo IP è stato inserito correttamente.

7. Fare clic su [OK].

8. Ripetere i procedure da 4 a 7 per impostare il collegamento della seconda macchina.

È possibile cambiare la destinazione di emissione selezionando l’indirizzo IP della macchina su cui eseguire
l’output con l’opzione [Connection] nel plug-in di Adobe Illustrator.

MEMO

Collegamento di più macchine a un computer (Mac)
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Se l’installazione è stata annullata o se il collegamento del cavo USB non avvia la procedura guidata, se-
guire la procedura indicata di seguito per installare il driver.

Reinstallare il driver (Windows 8.1)

Procedura

1. Collegare la macchina al computer con il cavo USB e accenderla.

2. Se appare il messaggio [Trovato nuovo hardware], fare clic su [Chiudi] per chiuderlo.

Scollegare il cavo USB da tutte le stampanti tranne che dalla macchina.

3. Puntare sull’angolo inferiore destro dello schermo per visualizzare i simboli, quindi fare clic su [Pannello
di controllo]>[Hardware e suoni].

4. Fare clic su [Pannello di controllo], quindi su [Stampanti e scanner].

5. Fare clic su [Gestione dispositivi]. Quando si apre la finestra [Controllo dell’account utente], fare clic su
[Sì] (o [Consenti]).

Viene visualizzata la [Gestione dispositivi].

6. Dal menu [Visualizza], fare clic su [Mostra dispositivi nascosti].

7. Cercare nell’elenco la voce [Stampanti] o [Altri dispositivi], quindi farvi doppio clic.

Il nome della macchina o del [Dispositivo sconosciuto] appare sotto la voce selezionata. Fare clic
sul nome per selezionarlo.

8. Dal menu [Azione], fare clic su [Disinstalla].

9. Nella finestra [Conferma disinstallazione dispositivo], fare clic su [OK].

10. Chiudere [Gestione dispositivi].

11. Scollegare il cavo USB dal computer e riavviare Windows.

12. Disinstallare il driver seguendo la procedura indicata di seguito.

P. 325Disinstallazione del driver (Windows 8.1)

13. Avviare l’installazione dall’inizio secondo la procedura descritta di seguito.

GS2-24 Installation and Initial Settings Windows Version
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Reinstallare il driver (Windows 10)

Procedura

1. Collegare la macchina al computer con il cavo USB e accenderla.

2. Se appare il messaggio [Trovato nuovo hardware], fare clic su [Chiudi] per chiuderlo.

Scollegare il cavo USB da tutte le stampanti tranne che dalla macchina.

3. Fare clic con il tasto destro del mouse sul pulsante [Avvia], quindi fare clic su [Gestione dispositivi].

4. Dal menu [Visualizza], fare clic su [Mostra dispositivi nascosti].

5. Cercare nell’elenco la voce [Stampanti] o [Altri dispositivi], quindi farvi doppio clic.

Il nome della macchina o del [Dispositivo sconosciuto] appare sotto la voce selezionata. Fare clic
sul nome per selezionarlo.

6. Dal menu [Azione], fare clic su [Disinstalla dispositivo].

7. Nella finestra [Conferma disinstallazione dispositivo], fare clic su [OK].

8. Chiudere [Gestione dispositivi].

9. Scollegare il cavo USB dal computer e riavviare Windows.

10. Disinstallare il driver seguendo la procedura indicata di seguito.

P. 326Disinstallazione del driver (Windows 10)

11. Avviare l’installazione dall’inizio secondo la procedura descritta di seguito.

GS2-24 Installation and Initial Settings Windows Version

Impossibile installare il driver
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Reinstallare il driver (Windows 11)

Procedura

1. Collegare la macchina al computer con il cavo USB e accenderla.

2. Se appare il messaggio [Trovato nuovo hardware], fare clic su [Chiudi] per chiuderlo.

Scollegare il cavo USB da tutte le stampanti tranne che dalla macchina.

3. Fare clic con il tasto destro del mouse sul pulsante [Avvia], quindi fare clic su [Gestione dispositivi].

4. Dal menu [Visualizza], fare clic su [Mostra dispositivi nascosti].

5. Cercare nell’elenco la voce [Stampanti] o [Altri dispositivi], quindi farvi doppio clic.

Il nome della macchina o del [Dispositivo sconosciuto] appare sotto la voce selezionata. Fare clic
sul nome per selezionarlo.

6. Dal menu [Azione], fare clic su [Disinstalla dispositivo].

7. Nella finestra [Conferma disinstallazione dispositivo], fare clic su [OK].

8. Chiudere [Gestione dispositivi].

9. Scollegare il cavo USB dal computer e riavviare Windows.

10. Disinstallare il driver seguendo la procedura indicata di seguito.

P. 326Disinstallazione del driver (Windows 10)

11. Avviare l’installazione dall’inizio secondo la procedura descritta di seguito.

GS2-24 Installation and Initial Settings Windows Version

Impossibile installare il driver
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Per disinstallare il driver, seguire la procedura indicata di seguito.

Disinstallazione del driver (Windows 8.1)

Procedura

1. Spegnere la macchina e scollegare il cavo tra il computer e la macchina.

2. Avviare Windows.

3. Fare clic su [Desktop].

4. Puntare sull’angolo inferiore destro dello schermo per visualizzare i simboli, quindi fare clic su [Imposta-
zioni].

5. Fare clic su [Pannello di controllo]>[Disinstalla un programma].

6. Fare clic con il tasto destro sul driver della macchina da rimuovere, quindi fare clic su [Disinstalla].

Quando si apre la finestra [Controllo dell’account utente], fare clic su [Sì] (o [Consenti]).

7. Se viene visualizzato un messaggio di conferma dell’eliminazione, fare clic su [Sì].

8. Fare clic su [Avvia]>[Desktop].

9. Aprire Explorer e aprire la cartella specificata come posizione di installazione del driver al momento del
download.

10. Fare doppio clic su [SETUP64.EXE] (versione a 64 bit) o [SETUP.EXE] (versione a 32 bit).

Quando si apre la finestra [Controllo dell’account utente], fare clic su [Sì] (o [Consenti]).

Si avvia il programma di configurazione del driver.

11. Selezionare [Disinstalla], quindi fare clic su [Avvia].

12. Se viene visualizzata una finestra che richiede di riavviare il computer, fare clic su [Sì].

13. Dopo il riavvio del computer, aprire nuovamente il Pannello di controllo e fare clic su [Visualizza disposi-
tivi e stampanti].

14. Se è visibile l’icona del computer da eliminare, farvi clic con il tasto destro e quindi su [Rimuovi disposi-
tivo].

Disinstallazione del driver
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Disinstallazione del driver (Windows 10)

Procedura

1. Spegnere la macchina e scollegare il cavo tra il computer e la macchina.

2. Accedere a Windows come amministratore del computer.

3. Fare clic su [Avvia]>[Sistema Windows]>[Pannello di controllo]>[Disinstalla un programma].

4. Fare doppio clic sul driver della macchina da rimuovere, quindi fare clic su [Sì].

Quando si apre la finestra [Controllo dell’account utente], fare clic su [Sì] (o [Consenti]).

5. Se viene visualizzato un messaggio di conferma dell’eliminazione, fare clic su [Sì].

6. Fare clic con il tasto destro del mouse sul pulsante [Avvia], quindi fare clic su [Explorer].

7. Aprire Explorer e aprire la cartella specificata come posizione di installazione del driver al momento del
download.

8. Fare doppio clic su [SETUP64.EXE] (versione a 64 bit) o [SETUP.EXE] (versione a 32 bit).

Quando si apre la finestra [Controllo dell’account utente], fare clic su [Sì] (o [Consenti]).

Si avvia il programma di configurazione del driver.

9. Selezionare [Disinstalla], quindi fare clic su [Avvia].

10. Se viene visualizzata una finestra che richiede di riavviare il computer, fare clic su [Sì].

La disinstallazione sarà completata dopo il riavvio del computer.

Disinstallazione del driver
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Disinstallazione del driver (Windows 11)

Procedura

1. Spegnere la macchina e scollegare il cavo tra il computer e la macchina.

2. Accedere a Windows come amministratore del computer.

3. Fare clic su [Avvia]>[Tutte le app]>[Strumento Windows].

4. Fare doppio clic su [Pannello di controllo].

5. Fare clic su [Disinstalla un programma].

6. Fare doppio clic sul driver della macchina da rimuovere, quindi fare clic su [Sì].

Quando si apre la finestra [Controllo dell’account utente], fare clic su [Sì] (o [Consenti]).

7. Se viene visualizzato un messaggio di conferma dell’eliminazione, fare clic su [Sì].

8. Fare clic con il tasto destro del mouse sul pulsante [Avvia], quindi fare clic su [Explorer].

9. Aprire Explorer e aprire la cartella specificata come posizione di installazione del driver al momento del
download.

10. Fare doppio clic su [SETUP64.EXE].

Quando si apre la finestra [Controllo dell’account utente], fare clic su [Sì] (o [Consenti]).

Si avvia il programma di configurazione del driver.

11. Selezionare [Disinstalla], quindi fare clic su [Avvia].

12. Se viene visualizzata una finestra che richiede di riavviare il computer, fare clic su [Sì].

La disinstallazione sarà completata dopo il riavvio del computer.

Disinstallazione del driver
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Se il driver non è stato installato correttamente, il computer lo indicherà come [Non specificato]. In que-
sti casi, eseguire la seguente procedura per reinstallare il driver.

Il driver non può essere installato correttamente (Windows 8.1)

Procedura

1. Accedere a Windows come amministratore del computer.

2. Nella schermata [Avvia], fare clic su [Desktop].

3. Spostare il puntatore del mouse nell’angolo inferiore destro della finestra del desktop, quindi spostarlo
leggermente verso l’alto.

La barra dei simboli viene visualizzata sul lato destro dello schermo.

4. Fare clic su [Impostazioni].

Sul lato destro dello schermo viene visualizzata l’icona [Impostazioni].

5. Fare clic su [Contorol Panel].

6. Fare clic su [Devices And Printers].

7. Fare clic con il tasto destro sul driver della macchina in uso, classificato sotto la voce [Non specificato],
quindi fare clic su [Proprietà].

Se la macchina e il computer non sono collegati, in [Non specificato] non viene visualizzato nessun
driver. Se non viene visualizzato nessun driver, accendere la macchina e collegarla al computer.

8. Fare clic sulla scheda [Hardware], quindi fare doppio clic sul nome del modello utilizzato.

9. Fare clic su [Modifica impostazioni] nella scheda [Generale] per nascondere il pulsante [Modifica imposta-
zioni].

Se all’inizio non viene visualizzata la dicitura [Modifica impostazioni], proseguire con il passaggio
successivo.

10. Fare clic su [Driver], quindi su [Elimina].

11. Nella finestra [Conferma disinstallazione dispositivo], fare clic su [OK].

A questo punto, il driver del modello utilizzato sarà ancora visualizzato come [Non specificato].

12. Disinstallare il driver.

P. 325Disinstallazione del driver (Windows 8.1)

13. Reinstallare il driver.

GS2-24 Installation and Initial Settings Windows Version

Dopo l’installazione il driver viene visualizzato
come [Non specificato]
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Il driver non può essere installato correttamente (Windows 10)

Procedura

1. Accedere a Windows come amministratore del computer.

2. Fare clic su [Start]>[Windows System]>[Contorol Panel].

3. Fare clic su [Devices And Printers].

4. Fare clic con il tasto destro sul driver della macchina in uso, classificato sotto la voce [Non specificato],
quindi fare clic su [Proprietà].

Se la macchina e il computer non sono collegati, in [Non specificato] non viene visualizzato nessun
driver. Se non viene visualizzato nessun driver, accendere la macchina e collegarla al computer.

5. Fare clic sulla scheda [Hardware], quindi fare doppio clic sul nome del modello utilizzato.

6. Fare clic su [Modifica impostazioni] nella scheda [Generale] per nascondere il pulsante [Modifica imposta-
zioni].

Se all’inizio non viene visualizzata la dicitura [Modifica impostazioni], proseguire con il passaggio
successivo.

7. Fare clic sulla scheda [Driver] e fare clic su [Disinstalla dispositivo].

8. Nella finestra [Conferma disinstallazione dispositivo], fare clic su [OK].

A questo punto, il driver del modello utilizzato sarà ancora visualizzato come [Non specificato].

9. Disinstallare il driver.

P. 326Disinstallazione del driver (Windows 10)

10. Reinstallare il driver.

GS2-24 Installation and Initial Settings Windows Version

Dopo l’installazione il driver viene visualizzato come [Non specificato]
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Il driver non può essere installato correttamente (Windows 11)

Procedura

1. Accedere a Windows come amministratore del computer.

2. Fare clic su [Start]>[Tutte le app]>[Strumento Windows].

3. Fare doppio clic su [Contorol Panel].

4. Fare clic su [Devices And Printers].

5. Fare clic con il tasto destro sul driver della macchina in uso, classificato sotto la voce [Non specificato],
quindi fare clic su [Proprietà].

Se la macchina e il computer non sono collegati, in [Non specificato] non viene visualizzato nessun
driver. Se non viene visualizzato nessun driver, accendere la macchina e collegarla al computer.

6. Fare clic sulla scheda [Hardware], quindi fare doppio clic sul nome del modello utilizzato.

7. Fare clic su [Modifica impostazioni] nella scheda [Generale] per nascondere il pulsante [Modifica imposta-
zioni].

Se all’inizio non viene visualizzata la dicitura [Modifica impostazioni], proseguire con il passaggio
successivo.

8. Fare clic sulla scheda [Driver] e fare clic su [Disinstalla dispositivo].

9. Nella finestra [Conferma disinstallazione dispositivo], fare clic su [OK].

A questo punto, il driver del modello utilizzato sarà ancora visualizzato come [Non specificato].

10. Disinstallare il driver.

P. 327Disinstallazione del driver (Windows 11)

11. Reinstallare il driver.

GS2-24 Installation and Initial Settings Windows Version

Dopo l’installazione il driver viene visualizzato come [Non specificato]
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Problemi con i dati
Impossibile importare i dati di Illustrator ........................................................ 332

I dati sono salvati in formato AI 8.0 o EPS 8.0?............................................ 332
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I dati sono salvati in formato AI 8.0 o EPS 8.0?

Quando si importano dati creati in Illustrator in CutStudio, è possibile importare solo file Al 8.0 o EPS 8.0.
Se si utilizza una versione superiore, salvare i file come versione inferiore prima di importarli.

 COLLEGAMENTI CORRELATI 

・  P. 62 Inserire i dati di stampa

Impossibile importare i dati di Illustrator
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Il computer non è impostato per mostrare le cartelle nascoste?

Posizione della cartella dei dati del campione

File [Sample.bmp] che si trova nella cartella di installazione di CutStudio (normalmente situata nella
cartella [Program Files (x86)]>[CutStudio] nell’unità C)

In alcuni casi, i dati del campione potrebbero non essere visualizzati a seconda delle impostazioni del com-
puter. In questo caso, eseguire la seguente impostazione e ricontrollare la posizione di archiviazione dei
dati.

Procedura

1. Aprire [Explorer.]

Fare clic sulla cartella nell’angolo inferiore sinistro del desktop.

2. Fare clic sulla scheda [Visualizza].

3. Selezionare [Elementi nascosti].

Impossibile trovare i dati di esempio
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Messaggi sul pannello di con-
trollo

Messaggi di errore .................................................................................... 335
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"OUT OF RANGE"................................................................................ 335
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Questa sezione descrive i messaggi di errore che possono apparire sul display della macchina e come inter-
venire per risolvere il problema. Se l'azione qui descritta non risolve il problema o se viene visualizzato un
messaggio di errore non descritto in questa sezione, contattare il proprio rivenditore autorizzato Roland
DG Corporation.

"WRONG COMMAND"

Sono stati inviati dati che la macchina non è in grado di interpretare.

Premere un tasto qualsiasi per cancellare il messaggio di errore. Esaminare i dati inviati dal computer e
inviare i dati corretti.

"WRONG NO.S"

Il numero di parametri è diverso da quello consentito.

Premere un tasto qualsiasi per cancellare il messaggio di errore. Esaminare i dati inviati dal computer e
inviare i dati corretti.

"OUT OF RANGE"

Il valore del parametro specificato non rientra nell’intervallo consentito.

Premere un tasto qualsiasi per cancellare il messaggio di errore. Esaminare i dati inviati dal computer e
inviare i dati corretti.

"ORIGINE ERRATA"

La macchina è esposta alla luce diretta del sole o a una forte illuminazione interna e non è stata in
grado di rilevare l’origine subito dopo l’accensione.

Spegnere la macchina e spostarla in un luogo non esposto alla luce diretta del sole o a luce intensa. Quin-
di, accendere l’alimentazione.

"ERRORE CROCINO"

La forma o il colore dei crocini di registro, o il colore o la lucentezza del materiale non sono adatti
alla macchina. Il problema può anche essere dovuto a un guasto meccanico

La macchina non è stata in grado di leggere i crocini di registro. Controllare la forma e il colore dei crocini
di registro, oltre al colore e alla lucentezza del materiale.

Se lo stesso errore si ripete anche dopo aver controllato la forma e il colore dei crocini di registro, oltre al
colore e alla lucentezza del materiale, contattare il proprio rivenditore autorizzato Roland DG Corpora-
tion.

"ERRORE CROCINO""TROPPO RUOTATO"

Il crocino di registro 2 o 3 è inclinato di 5 gradi o più.

Messaggi di errore
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: Crocino di registro 2

: Crocino di registro 3

Premere un tasto qualsiasi per cancellare il messaggio di errore. Ricaricare il materiale.

Messaggi di errore
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"ERRORE CROCINO""LUNGHEZZA NG"

Il crocino di registro 3 è deviato di 20 mm o più nella direzione di avanzamento del materiale.

: Crocini di registro 3

Premere un tasto qualsiasi per cancellare il messaggio di errore. Ricaricare il materiale o modificare la po-
sizione del crocino di registro.

"ERRORE CROCINO""LARGHEZZA"

Il crocino di registro 2 è deviato di 20 mm o più nella direzione del carrello di taglio.

: Crocino di registro 2

Premere un tasto qualsiasi per cancellare il messaggio di errore. Ricaricare il materiale o modificare la po-
sizione del crocino di registro 2

"OUT OF RANGE"

Questo messaggio indica che i crocini di registro o l’origine sono impostati al di fuori del materiale.

Premere un tasto qualsiasi per cancellare il messaggio di errore. Controllare che le posizioni dei crocini d
registro o l’origine non siano impostate al di fuori del materiale e riconfigurare le impostazioni.

"CARICA FOGLIO"

Si è cercato di rendere la macchina pronta senza caricare il materiale. Il materiale è stato rimosso
quando la macchina era pronta a eseguire il taglio. Il materiale è scivolato via durante il taglio.

Premere un tasto qualsiasi per annullare l’impostazione e cancellare il messaggio di errore. Caricare cor-
rettamente il materiale e prepararlo per il taglio (condizione di impostazione).

 COLLEGAMENTI CORRELATI 

・  P. 27 Posizione di carico del materiale
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"SET TO <SENSOR MODE>"

I dati dei crocini di registro sono stati inviati quando la macchina era in modalità manuale.

Premere un tasto qualsiasi per cancellare il messaggio di errore. Configurare le impostazioni della macchi-
na in modalità sensore, quindi inviare nuovamente i dati.

 COLLEGAMENTI CORRELATI 

・  P. 76 Configurare l’impostazione per eseguire l’allineamento automatico

"SET TO <TOOL MODE>"

Non è stato possibile leggere i crocini di registro in modalità sensore.

Premere un tasto qualsiasi per cancellare il messaggio di errore. Configurare le impostazioni della macchi-
na in modalità Strumento, quindi inviare nuovamente i dati. A tal fine, utilizzare quattro crocini di regi-
stro. Quando la macchina è in modalità Strumento, non è possibile tagliare utilizzando 3 crocini di regi-
stro.

Se si desidera utilizzare tre crocini, lasciare la macchina in modalità sensore e modificare la forma e il
colore dei crocini di registro o il colore e la lucentezza del materiale.

 COLLEGAMENTI CORRELATI 

・  P. 17 Crocini di registro/segni degli strumenti

・  P. 297 Non vengono rilevati i crocini di registro

"DATA OVERFLOW"

La quantità di dati memorizzati nella macchina è troppo grande e "RISTAMPA" non può essere eseguito.

Procedura

1. Eliminare i dati memorizzati nella macchina.

2. Ridurre le dimensioni dei dati inviati dal computer e inviarli nuovamente.

3. Eseguire "RISTAMPA".

 COLLEGAMENTI CORRELATI 

・  P. 230 Tagliare ripetutamente gli stessi dati

"POSIZIONE ERR."

I rulli di trazione si trovano in posizioni in cui il materiale non può essere schiacciato.

Premere un tasto qualsiasi per annullare l’impostazione e cancellare il messaggio di errore. Spostare i rulli
di trazione nelle posizioni corrette e ricaricare il materiale.

Se il messaggio viene visualizzato anche se i rulli di trazione sono stati spostati nelle posizioni corrette, è possibile che
la macchina sia esposta alla luce diretta del sole o a un’intensa illuminazione interna. Spegnere la macchina e spostarla
in un luogo non esposto alla luce diretta del sole o a un’illuminazione intensa.

MEMO

Messaggi di errore
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Una volta spostata la macchina, accenderla.

 COLLEGAMENTI CORRELATI 

・  P. 29 Caricamento di materiale piatto

・  P. 35 Caricamento di materiale bobinato

"ERRORE MOTORE"

Il motore è stato sottoposto a un carico pesante e il funzionamento si è interrotto.

Quando la macchina è sovraccarica nelle seguenti condizioni, ecc. viene visualizzato "ERRORE MOTORE".

• Il taglio è stato eseguito con un materiale spesso caricato

• Il materiale è stato estratto improvvisamente dal rotolo durante il taglio senza essere stato alimentato
in precedenza

• Il materiale si è inceppato

Spegnere la macchina, abbassare la leva di caricamento e caricare nuovamente il materiale.

Taglio di materiale bobinato

Estrarre preventivamente dal rotolo la lunghezza del materiale da tagliare. Inoltre, eseguire un avanza-
mento di prova prima del taglio.

In questo caso, impostare un valore di circa 20 cm in più rispetto alla lunghezza di taglio in "AREA" nel
menu del display.

Taglio di materiale spesso

Impostare la qualità su "PESANTE".

"EEPROM ERROR"/"SOLENOID ERROR"

Spegnere l’apparecchio e contattare il proprio rivenditore autorizzato Roland DG Corporation.

Messaggi di errore
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L’area di taglio laterale del materiale (direzione in cui si muove il carrello di taglio) è determinata dalla
posizione dei rulli di trazione. L’area di taglio si estende tra i due rulli di trazione, con una differenza di
circa 1 mm su ciascun lato.

Rullo di schiacciamento

Area di taglio

Origine delle coordinate di taglio

A Max. 584 mm

B

Tipo di materiale specificato

• "ROTOLO" / "BORDO"
Max. 25.000 mm *1

• "FOGLIO"
Max.: Lunghezza rilevata*2

C Da 10 a 25 mm

D Circa 1 mm

E 15 mm

F 50 mm o più

 

*1 La precisione è garantita fino a 1.600 mm.

*2 Se la lunghezza rilevata è pari o superiore a 1.600 mm, il materiale viene determinato come "ROTOLO" e la lunghezza dell’area
di taglio verrà impostata a circa 25.000 mm. Tuttavia, il display non mostra la lunghezza.

 

Area di taglio
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Impostazione dei margini e della distanza tra i crocini di registro. Tenere conto del margine necessario per
tagliare il materiale e impostare la posizione del crocino di registro.

Area di stampa con crocini di registro (quando si creano dati di taglio con Cut-
Studio)

Assicurarsi che l’area in cui sono posizionati i crocini di registro sia priva di illustrazioni o sporcizia oltre ai crocini di
registro.

MEMO

Lunghezza (L) tra i crocini di registro

Larghezza (W) tra i crocini di registro

Area stampabile

A 500 mm o meno

B 610 mm o meno

C Da 10 a 60 mm *1

D Da 10 a 42,5 mm

E 50 mm o più

F 20 mm

 

*1 Impostare manualmente le posizioni dei crocini di registro. Tenere presenti i seguenti punti quando si utilizza materiale in for-
mati diversi da A3, A4 o B4.

Margini e distanza tra i crocini di registro
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• Quando si utilizza un rullo di trazione all’interno della granatura più a sinistra, assicurarsi di lasciare almeno 30 mm (W)
dall’estremità sinistra della granatura al crocino di registro. Se la distanza libera è inferiore a 30 mm, non è possibile legge-
re il crocino di registro.

 

 COLLEGAMENTI CORRELATI 

・  P. 67 Impostare le condizioni di stampa

Margini e distanza tra i crocini di registro
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Area di stampa con crocini di registro (quando si creano dati di taglio con Ado-
be Illustrator/CorelDRAW)

Assicurarsi che l’area in cui sono posizionati i crocini di registro sia priva di illustrazioni o sporcizia oltre ai crocini di
registro.

MEMO

Lunghezza (L) tra i crocini di registro

Larghezza (W) tra i crocini di registro

Intervallo di taglio

A 1.500 mm o meno

B Larghezza del materiale

C 10 mm o più *1

D 10 mm o più

E 50 mm o più

F 20 mm

 

*1 Impostare manualmente le posizioni dei crocini di registro. Tenere presente i seguenti punti quando si utilizzano materiali in
formati diversi da A3, A4 o B4.

• Quando si utilizza un rullo di trazione all’interno della granatura più a sinistra, assicurarsi di lasciare almeno 30 mm (W)
dall’estremità sinistra della granatura al crocino di registro. Se la distanza libera è inferiore a 30 mm, non è possibile legge-
re il crocino di registro.
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 COLLEGAMENTI CORRELATI 

・  P. 100 Impostare le condizioni di stampa

・  P. 154 Impostare le condizioni di stampa
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Sistema di azionamento Servomotore a controllo digitale

Meccanismo di taglio Metodo di movimentazione dei supporti

Dimensione del materia-
le accettabile

Larghezza da 50 mm a 700 mm

Lunghezza Materiale bobinato: nessuna restrizione
Materiale piatto: 100 mm o più

Area di taglio massima 584 mm (larghezza) × 25.000 mm (lunghezza)

Strumenti utilizzabili • Lama serie CAMM-1 (ZEC-U5032 / U5022 / U5025 / U3017)
• Lama a letto piano (ZEC-U1715 / U3050 / U3075 / U3100)
• Lama per pellicola da finestra (ZEC-U5010)

Velocità del taglio Da 10 a 850 mm/s

Forza della lama Da 30 a 500 gf

Risoluzione meccanica 0,0125 mm/passo

Risoluzione software 0,025 mm/passo

Precisione della distanza*1 Errore inferiore a ±0,2% della distanza percorsa o 0,1 mm, a seconda di quale
dei due è maggiore

Ripetibilità*1*2 0,1 mm o meno

Precisione di allineamento per la stampa e il taglio
quando il materiale stampato viene caricato*1*3

±1 mm o meno per una distanza di movimento di 210 mm o meno nella dire-
zione di alimentazione del materiale e una distanza di movimento di 170 mm
o meno nella direzione della larghezza (non tiene conto dell’influenza della
stampante e del materiale)

Connettività • Ethernet (passaggio automatico tra 10BASE-T e 100BASE-TX)
• USB 2.0 (conforme FULL SPEED)

Memoria Replot 2 MB (dimensione del buffer: 8 MB)

Sistema di comando CAMM-GLⅢ

Alimentazione Adattatore AC dedicato
Ingresso: 100 - 240 Vac, 50/60 Hz
Uscita: 24 Vdc 2,7 A

Corrente nominale 1,0 A

Potenza assorbita Circa 24 W

Livello di rumore Durante il funzionamen-
to

70 dB (A) o meno

In standby 40 dB (A) o meno

Dimensioni esterne 860 mm (larghezza) × 319 mm (profondità) × 235 mm (altezza)

Peso 13,5 kg

Ambiente • Temperatura: Da 5 a 40°C
• Umidità: Da 20 a 80% relativa (senza condensa)

Articoli inclusi Cavo di alimentazione, adattatore AC, lama, porta lama, base per rullo, cavo
USB, strumento di allineamento, manuali

 

*1 In base al materiale e alle condizioni di taglio come specificato da Roland DG Corporation.

*2 • Esclusa l’espansione/contrazione dei supporti
• Lunghezza nella direzione di avanzamento del foglio: Entro 1.600 mm

*3 Secondo gli standard di misurazione specificati da Roland DG Corporation.

• Il software deve essere il software Roland DG Corporation incluso.
• Si presuppone l’uso di una stampante laser o a getto d’inchiostro con una risoluzione di 720 dpi o superiore.
• Sono esclusi i materiali lucidi e/o laminati.
• Esclude gli effetti della stampa deformata dovuti alla precisione della stampante o agli effetti di espansione/contrazione

del materiale.
• Potrebbe non essere letto correttamente dal sensore a seconda dell’inchiostro della stampante (nero) utilizzato.
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I nomi delle aziende e dei prodotti sono marchi o marchi registrati dei rispettivi titolari.

Nota
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